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Welcome to Toolbox Help 

 

     
DIGIDIM Toolbox Help provides a complete reference to using the DIGIDIM Toolbox application. The 
Help system is divided into seven sections: 
  

• Getting Started 
- Overview of DIGIDIM Toolbox 
- How to start the application 
- Tutorial: creating a simple Offline system. 
- Details of all of the application's windows, toolbars, and menus. 

  
• Working with System Files 

- Overview of the procedures you need to configure a DIGIDIM system. The section has three 
example workflows that cover most situations. 

  
• Using the Device Tree 

  
• Working with Devices 

- How to configure individual DIGIDIM devices 
- Toolbox device properties dialogues 
- New DIGIDIM devices 
- How to set up a Multisensor to provide a constant light control system 

  
• Working with Groups (in DIGIDIM systems) 

- How groups work 
- How to use groups 
- How to set up groups in Toolbox 

  
• Working with Scenes 

- Advanced use of Scenes within a DIGIDIM system 

• DIGIDIM Devices  
- Brief details of the devices which Toolbox can connect to 

More Information 
About DIGIDIM 
Check the Helvar DIGIDIM Website (www.helvar.com) for information about the DIGIDIM range of 
control devices and their application. 
  
About Toolbox 
If you cannot find a solution by other means, and if you have comments, suggestions or bug reports, 
please contact your local Helvar representative.  Contact details are on the Helvar website. 
  
  

http://www.helvar.com/
http://www.helvar.com/contact-us
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Getting Started 

  Getting Started 
 

     
If you are new to DIGIDIM and the DIGIDIM Toolbox, this is the place to start. This section of 
Help provides an introduction to the application, an overview of its basic functions, an 
introduction to some important DIGIDIM concepts, and instructions on how to start the 
application and use it in both Online or Offline mode. Getting Started contains six main topics: 
  

• A Guide to the Toolbox User Interface  
A brief tour of the application, with an explanation of the main parts of its user interface. 

• Tutorial - Creating an Offline System  
A demonstration of how the application can be used to create a simulated system. 

• DIGIDIM Basics  
Some useful ideas for working with advanced DIGIDIM systems. 

• Connecting your PC to the DALI network  
Instructions on how to install a PC-to-DALI network interface, which is required for Online 
Mode. 

• Starting the Application  
How to run DIGIDIM Toolbox on your computer, and how to choose the operating mode. 

• Using the History Window  
The History Window is a useful diagnostic tool that will help you keep track of activity on the 
DIGIDIM System. 
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A Guide to the User Interface 

  Guide to the Toolbox User Interface 
 

     
DIGIDIM Toolbox makes the process of configuring a DIGIDIM system simple and intuitive.  
It has a standard Windows interface with six main components, as shown here. 

 
  
Click on the image above for details of the different parts of the interface window. We will simply 
summarize them here. 

Menus & Application Toolbar. 
These provide access to standard features of the application such as disk operations, and cut 
and paste. The Menus also provide access to settings that allow you to customise the 
software and useful tools such as the History Window. The functions of a number of menu 
commands are duplicated in the Application Tooblars and Device Toolbars. 
Device Toolbars 
These duplicate the functions of the Insert menu and provide a single-click method of adding 
Virtual Devices to the current system. 
Device Tree 
This is a graphical representation of the relationships between all of the devices in the current 
system. 
In Groups Layout view (illustrated), the Device Tree shows the group membership of each 
device, and allows these to be edited using drag and drop techniques. 
In Device Layout view the devices are organized according to their system address.  
Properties: In both views, right-click a device to access to advanced device properties 
dialogues. 
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Bar graph 
The Bar graph is a graphical display of the status of the system's Load Interface Units (LIUs), 
and allows the level of individual devices to be adjusted by dragging the bar. 
Right-click a bar on the graph to set individual Scene levels. 
Status bar 
The Status bar provides brief context-sensitive help for each interface element and an 
indication of whether the application is currently Online or Offline. 

  

See also: 
  

• Installing a PC Interface 
• Starting the Application 
• Tutorial - Creating an Offline System 
• DIGIDIM Basics 
• Shortcut Keys 
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DIGIDIM Toolbox Menus 

  

DIGIDIM Toolbox Menus 

 

     
The majority of the DIGIDIM Toolbox's command and functions can be selected from the seven 
drop down menus provided at the top of the main window. The menus are context-sensitive 
and the availability of different items depends on the current operating mode. To use the 
menus simply click on the menu name, and then click on an item from the drop down list. If the 
item contains a  symbol, this indicates a submenu providing additional choices. 
  
The menu bar is shown in the image below. 
Click for a more detailed explanation of the contents of each menu. 
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The File Menu 

 

     
The File Menu contains items that relate to the opening and saving of DIGIDIM system files to 
disk, restarting and quitting the application. 
  

 
 
New (Ctrl+N) 

  
This command resets the DIGIDIM Toolbox using a blank system template. In effect, it 
restarts the application, and reverts to the Online/Offline dialogue that appears when the 
application is first started. If there are unsaved files open, a dialogue will prompt you to save it 
or cancel the operation. 

 
Merge/Restore... (Ctrl+M) 

This command opens the Restore or Merge DIGIDIM system window. 
Merge is used to merge the virtual system represented on-screen with the physical system 
connected to the computer. See Merging Systems for more details of this operation. 
Restore system is similar in function to the standard Windows open command. It opens a 
standard Open File dialogue box, which can be used to restore an archived DALI-System file. 
See Restoring Systems for more details of this operation. The DIGIDIM system file extension 
is .DAL. 

 
Backup... (Ctrl+B) 

This is similar in function to the standard Windows save command. Saves the current 
DIGIDIM system that is being modeled in the DIGIDIM Toolbox to disk. 

 
Backup As… 

This opens a standard Save File dialogue, which can be used to save the current DIGIDIM 
System under a new name. 

 
Recent Files 

This section provides fast access to recently opened files 
 
Print Scenes to File (Ctrl+P) 

Opens a save dialogue that will allow you to save the current system's scenes as comma 
separated values (.csv file). 
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Exit (Alt+F4) 

Terminates the Application 
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The Edit Menu 

 

     
The Edit menu contains commands that are used to modify the DIGIDIM system that is 
represented on screen. The menu items are context-sensitive and will change, depending on 
the object selected in the Device Tree. All of the commands can also be selected either from 
the toolbar, or from the right mouse button shortcut menus. There are also keyboard shortcuts 
for many commands, and these are shown in brackets in the listing below . 
  

 
 
Cut (Ctrl+X) 

  
(context-sensitive) Moves the selected Group or Device to the clipboard, removing it from the current 
system. 

  
Copy (Ctrl+C) 

(context-sensitive) Copies the selected Device or Scene to the clipboard. 
 
Paste (Ctrl+V) 

(context-sensitive) Pastes the Device, Group or Scene stored in the clipboard to the 
currently selected location. 

 
Delete Device (Del - when a device is selected) 

(context-sensitive) In Group Layout View, delete will remove the selected Device from the 
current group. If the device does not exist in any other groups this has the same effect as 
dragging the device to the Ungrouped Devices section of the tree view. In Device Layout 
View, delete will, if possible, remove the device from the system. Matched physical devices 
cannot be deleted in Online mode. 

 
Delete Group (Del - when a group is selected) 

(context-sensitive - Group Layout View only) removes the group assignment from all the 
devices in the selected Group. Devices that are not members of any other group will be set to 
Broadcast and moved to the Ungrouped Devices section of the tree. 

 
Ignore Scene (Del - when a scene is selected) 

(context-sensitive) Removes any Scene level setting from the selected Scene. Commands to 
recall this Scene sent to this device will be ignored. 
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Rename (F2) 

(context-sensitive) Select to rename the selected Device, Group or System. 
 
Recall Scene 

Generates a "Go to Scene" command. context-sensitive. 
 
Store As Scene 

(context-sensitive - LIUs only) Stores the current level of the selected device as a scene. A 
submenu opens, allowing you to select from any of the 15 scenes available. This item is 
duplicated in right mouse button shortcut menus in both the device tree and bar graph 
display. 

 
Store Scene Presets 

Enables Scenes 1 to 4 and sets the default levels of 100%, 75%, 50% and 25% respectively 
for the selected devices. 

 
Identify 

(Online Mode Only) Allows the selected device to be physically identified. If the selected 
device is a controller the indicator lamps will flash - if the device is a LIU the lamp will flash. 
Click on "Cancel Identification" to end the process. 

 
 
Properties 

Opens the Properties Dialogue for the selected Device or Subdevice. 
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The View Menu 

 

     
The View menu, as the name implies, contains items that control your view of the main 
application window. The function of some of these commands are duplicated by items in the 
Main Window. 
  

 
  
Tree Layout 

Allows you to select between Groups Layout and Device Layout view in the Device Tree. 
Alternatively, click on the tabs at the top of the Device Tree window. 

  

 
 
Toolbar 

Shows or hides the Main Toolbar, Load Interface and Controls palettes. 
 

 
 
Large Icons 

Shows the toolbars using large icons. 
 
Status Bar 
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Shows or hides the Status Bar. 
 
Load Interfaces 

Shows or hides the Load Interface UIDs that appear when a LIU device (or group containing a LIU) is 
selected in the tree. 

 
Control Panels 

Shows or hides the Controller UIDs that appear when a control panel device (or group containing a 
control panel) is selected in the Tree. 

 
Refresh 

Redraws the Tree/Devices layout. This duplicates the function of the  button in the Application 
Toolbar. 
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The Insert Menu 

 

     
The Insert Menu duplicates the operation of the Device Palette Toolbars. It contains three 
items with associated drop down lists that allow you to add devices to the system. To add the 
device to a specific group, select the group in the device tree before selecting the device. 

Load Interface Units 

 

Modular Panel Control 

 

Sensor 

 

Input 
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The Tools Menu 

 

     
The Tools menu contains three items. 
  

 
History 

  
Opens the DIGIDIM Toolbox History window. This displays a detailed listing of the DALI messages 
that have appeared on the system since going Online. The History window is an extremely useful 
diagnostic tool for troubleshooting the system. See Using the History Window for more details. 

 
Check Load Status 

Available only in Online mode, this sends a status inquiry to a specific Load Interface Device. The bar 
graph of any faulty LIU will turn red. This function is performed automatically each time the 
application goes online. 

 
Preferences 

Opens the DIGIDIM Toolbox Preferences window: 
  

 
  

 
User mode: 

Select either Simple Mode or Advanced Mode. Simple has the effect of simplifying some aspects of the 
user interface, including reducing the number of commands available in the subdevice command list. 

 
Lock system on closure 

This will apply a lock to the system components to prevent their configuration being modified by IR 
Remote or controller button configuration commands. 
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The Window Menu 

 

     
The Window menu contains two items that allow you to adjust the display of open UIDs. 
  

 
  
Close All 

Closes all UID windows. 
 
Cascade 

  
Arranges all open UID windows as a cascade. 
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The Help Menu 

 

     
The Help Drop-Down menu contains the standard Windows Help submenu items. 
They are used to access this Online help document, and to find information about the DIGIDIM 
Toolbox application. 
  

 
 
Help Topics (F1) 

  
Opens this Online Help document 

 
About 

Opens a window containing information about the DIGIDIM Toolbox application, including the 
version number. When online, the software version of the PC Interface is also reported. 
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The Application Toolbar 

 

     
The DIGIDIM Toolbox has three toolbars, which are located in the top section of the Main 
Application Window. The Main Toolbar provides quick, and convenient access to some of the 
frequently used DIGIDIM Toolbox commands. 
The Device Palette Toolbar provides a single-click method of adding devices to the system. 
 

  

Icon Action Keyboard 
shortcut 

 

New 
Resets the DIGIDIM Toolbox using a blank system template. If 
there are unsaved files open, a dialogue will provide a warning, 
and an opportunity to cancel the operation 

Ctrl + N 

 

Merge / Restore 
Opens the Restore or Merge DALI system window which can 
be used to select either Merge system or Restore system. Merge 
system is used to merge the virtual system represented on-
screen with the physical system connected to the computer. See 
Merging systems for more details of this operation. 
Restore system is similar in function to the standard Windows 
open command. It opens a standard Open File dialogue box, 
which can be used to restore an archived DIGIDIM system file 

Ctrl + M 

 

Backup 
Similar in function to the standard Windows save command. 
Saves the current DIGIDIM System that is being modelled in the 
DIGIDIM Toolbox to disk. 

Ctrl + B 

 

Delete 
The command is context-sensitive and can delete a Device, a 
Group or a Scene. 

Del 

 

Cut 
The command is context-sensitive and can cut (for pasting) a 
Device, a Group or a Scene. 

Ctrl + X 

 

Copy 
The command is context-sensitive and can paste a Device, a 
Group or a Scene. 

Ctrl + C 

 

Paste 
The command is context-sensitive and can copy (for pasting) a 
Device, a Group or a Scene. 

Ctrl + V 
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Refresh 
Rescans the system and redraws the Device Tree accordingly. 
Use this command if the display does not refresh automatically 
after a change has been made. 

F5 

 

History 
Opens the DIGIDIM Toolbox History window. 
This displays a detailed listing of the DALI messages that have 
appeared on the system since going Online. 
See Using the History Window for more details. 

- 

 

Check Load Status 
Available in Online mode only, this sends a status inquiry to the 
system's Load Interface Units. If any unit fails to respond, or 
responds with an error, the device's bar graphs are coloured red. 
This command is carried out automatically when the application 
goes online. 

- 
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The Device Palette Toolbars 

 

     
The device palette consist of two toolbars (one for Load Interface Units and one for Controls) 
located in the top section of the Main Application Window. 
These provide a single-click method of adding devices to the system. Select the target group 
for the device, and then click on the appropriate device icon. 
Load Interface toolbar 

Icon Action 

 

Add Ballast 

 

Add 410 1-10 Volt Convertor 

 

Add 472 1-10 Volt & DSI Convertor (DIN Rail-mounted) 

 

Add 450 800 W Transistor Dimmer 

 

Add 452 1000 W Universal Dimmer 

 

Add 455 500 W Thyristor Dimmer 

 

Add 416(S) 16 A Solo Dimmer 

 

Add 425(S) 25 A Solo Dimmer 

 

Add 494 4-Channel Relay Unit Channel 

 

Add 460 DALI-to_SDIM Convertor Channel 

 

Add 804 DIGIDIM 4 Channel Dimmer Channel 

 

Add 490 Blinds Controller Channel 

 

Add 458/DIM8 8-Dimmer Channel 

 

Add 458/DIM4 4-Dimmer Channel 

 

Add 498 8-Channel Relay Unit Channel 

 

Add 458 OPT4 Channel 
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Add 458/SW8 8-Channel Ballast Controller Channel 

 

Add 458/CTR8 8-Channel Relay Module Channel 

 

Add 474 Ballast Controller Channel 

 

Add 474 Relay Channel 

 

Add 454 4-Channel 2.2 A (500 W) DIN Rail Dimmer 

 

Add LED Driver 

 

Add Relay Unit Single Channel 

 

Add 492 16 A Power Relay  

 

Add 493 0.5 A Single Channel Relay 

 
Control Devices toolbar 
 

  

 

Add 121 Two-Button On/Off + IR Controller 

 

Add 122 Two-Button Up/Down + IR Controller 

 

Add 124 Five-Button + IR Controller 

 

Add 125 Seven-Button Up/Down + IR Controller 

 

Add 126 Eight-Button + IR Controller 

 

Add 110 Single Slider Controller 

 

Add 111 Dual Slider Controller 

 

Add 100 Rotary Panel Controller 

 

Add 170 IR Receiver 

 

Add 312 MultiSensor  
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Add 315 iDim Sense 

 

Add 311 Ceiling PIR Detector 

 

Add 313 Low-Profile Microwave Detector 

 

Add 314 Tilting Microwave Detector 

 

Add 441 Occupancy Detector Interface  

 

Add 440 Input Unit  

 

Add 444 Mini Input Unit 

 

Add 131 2-Button On/Off + IR Controller 

 

Add 132 2-Button Up/Down + IR Controller 

 

Add 134 5-Button + IR Controller 

 

Add 135 7-Button Up/Down + IR Controller  

 

Add 136 8-Button +IR Controller 

 

Add 137 4-Button +IR Controller 

 

Add 445 LED Switch Interface 

 

Add 317 High-Bay PIR Detector 

 

Add 318 Wall-Mounted PIR Detector 
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The Bar Graph Display 

 

     
The right-hand panel of DIGIDIM Toolbox's system view area shows a graphical representation 
of the system's Load Interface Units (LIUs). Each lamp is represented by a bar graph showing 
the current percentage level of the device. The bar graph functions as an active control, and 
each bar can be dragged to directly modify the lamp's output levels. 
  
The bar graph continuously displays all LIUs that are active on the system, irrespective of the mode 
chosen for the Tree View pane. The devices are listed in order according to their short address. 

 
  
Shortcut Menus 
The main use of the bar graph is to allow fine adjustments to light levels to be made prior to setting up 
LIU or Constant Light Scenes. To make this process easier, each bar is provided with a right mouse 
button shortcut menu. This will allow the current setting to be stored as any one of the 15 available 
scenes. 
  

 
  
The properties item in the shortcut menu will open the LIU configuration dialogue, which allows a 
number of advanced configuration settings to be made. For more information on the use of this 
dialogue refer to Configuring Load Interface Units. 
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The Status Bar 

 

     
The status bar, located at the bottom of the DIGIDIM Toolbox window, displays information 
about the system and the Toolbox application. 
Context-sensitive Help 
At the left hand end of the bar, brief context-sensitive help messages appear, providing you with 
information about the particular tool that you are pointing at. 

 
DALI System Connection Status 
The right-hand end of the Status bar contains a system status indicator. 
Green = Online. 
Red = Offline. 
If the system is Online, the indicator also displays the name of the communication port being used. 
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  Shortcut Keys 
 

     
The following shortcut keys are supported in DIGIDIM Toolbox: 
  

Operation Keystroke 

New. Clears any existing system in memory and restarts the 
application. If there are unsaved files open, a dialogue will provide a 
warning and an opportunity to save the file or cancel the operation. 

Ctrl+N 

Merge/Restore. Opens the Merge/Restore system window which 
can be used to select either Merge or Restore. Ctrl+M 

Backup. Saves the current DIGIDIM System to disk. Ctrl+B 

Cut. Remove the currently selected item and place a copy on the 
clipboard. Ctrl+X 

Copy. Make a copy of the currently selected item on the clipboard. Ctrl+C 

Paste. Copy the contents of the clipboard to the current location. Ctrl+V 

Delete. (context-sensitive) In Group Layout View, delete will remove 
the selected Device from the current group. In Device Layout View, 
delete will, if possible, remove the device from the system. Matched 
physical devices cannot be deleted in Online mode. 

DEL 

Help. Opens this online help document. F1 

Rename. Renames the selected Device/Group/System. F2 

Identify. (Online Mode Only) Opens a dialogue that allows the 
selected device to be physically identified. If the selected device is a 
controller the indicator lamps will flash - if the device is a LIU the 
lamp will flash. Click on "Cancel Identification" to end the process. 
  

 

F3 

Properties. Opens the Properties Dialogue for the selected Device 
or Subdevice. F4 

Refresh. Redraws the Tree/Devices layout. F5 

Groups Layout. Selects Group Layout view in the Device Tree. Ctrl+G 

Device Layout. Selects Device Layout view in the Device Tree. Ctrl+D 
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Tutorial - Creating an Offline System 

  

Tutorial - Creating an Offline System 

 

     
This tutorial shows how to create an Offline simulation of a small DIGIDIM system. This is 
typical of the sort of task that you may want to carry out using the DIGIDIM Toolbox.  The 
tutorial demonstrates most of the major features of the application. The tutorial does not 
require the use of Online mode, or any DIGIDIM equipment, so is suitable for use with the 
demonstration version of the application. It may take an hour or two to complete. 
Project Scenario 
The system that we will simulate is to be installed in a small part of an office building. It consists of 
two offices and an adjoining reception area. Each office will be fitted with two DALI fluorescent 
luminaires, and three luminaires of the same type will be installed in the reception area. 

 
The purpose of the simulation is to allow the control system to be demonstrated to the client before it 
is installed, so that they can evaluate it. Once agreed, the final configuration can then be saved to 
disk and applied to the actual system when the system components have been installed. 
  
As a starting point, we are going to add: 
  

• Dual slider controllers to provide individual control of the lamps in the two offices. 
• A seven button controller to control the lamps in the reception area. 
• A two button On/Off controller as a master controller for the entire system. This will be 

installed next to the seven button controller in the reception area and will allow the lamps in 
the system to be turned on and off from this location. 

• Individual IR Remote controllers for each office. These will work in conjunction with the IR 
receivers built into the slider controllers. 
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Configuration Method 
When installed, these controllers will be connected together using a common data cable. To create 
the various control relationships between the different devices, we will use a DIGIDIM function known 
as grouping. This will establish the following relationships between the lamps and their controllers: 
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Workflow 
The process that we will go through in creating the simulation will involve five steps, covered in the 
five topics that follow this one: 
  

• Creating a System File.  
Naming the system and its components, and creating a file on disk that we can use to save 
our work as it progresses. 

• Adding the System Devices.  
Using the Device Toolbar and Insert Menu to add the appropriate devices to the system. 

• Setting up Groups.  
Organising the devices into groups to establish the control relationships between them. 

• Setting Scene Levels.  
Setting individual levels for the Scenes that will be recalled using the Scene Recall buttons on 
the controllers. 

• System Testing.  
As a final step, we can test the configuration to ensure that it works as expected. 

Next: 
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Creating a System File 
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Tutorial - Creating a System File 

 

     
The first step of the procedure is to name the system and to create a file on disk that we can 
use to save our work. At the same time we can give names to the groups that we will be using. 
This is optional, but it will help us to keep track of things as the project becomes more 
complex. Before doing any of this, we will make a couple of simple changes to the 
application's user interface, which will make the application a little easier to use. 
Getting Started 

1. Start the application and, when prompted, select Offline Mode. 
 

  
2. The applications will start with an empty and unnamed system. 
3. Adjust the size of the application window so that you are comfortable with it, and preferably so 

that you can see all of the contents of the Device Tree window without having to scroll. 
4. Select the View menu. 
5. Ensure that both the "Load Interfaces" and "Control Panels" items are unchecked. 

 
 
  
This last step will turn off the onscreen User Interface Device (UID) representations of the controllers 
and LIUs. These are not necessary at this stage, and can be distracting. We will be making use of the 
controller UIDs later in the tutorial when we test the system, and we will explain their use there. If you 
would like a preview of what you have achieved at any point, please feel free to turn them on again. 
Naming the System 

1. Ensure that Groups Layout view is selected. If necessary, click on the tab at the top of the 
Device Tree window. 
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2. Right-click on the system name at the top of the device tree ("Untitled Network"). 
 
 

 
3. Select Rename Network from the dropdown menu. 
4. Type "Tutorial1" and press Enter. 

 
 
We have now provided the system with a name, and "Tutorial1" will become the default file name 
when we save the file later in this section. 
Naming the Groups 
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We will be using a total of seven groups during the later stages of this tutorial. Each office will require 
three groups, and the controller in the reception area will require its own group. To keep track of the 
purpose of each group, it is helpful to provide each with a meaningful name. The procedure for doing 
this is as simple as that for naming the system, but we will show you a couple of variations to keep 
things interesting: 
  

1. Right-click on Group #1 near the top of the device tree. 
2. Select Rename Group from the dropdown menu. 

 

 
3. Type "Room1 - Slider1" and press Enter. 
4. Select Group #2 by clicking with the left mouse button. 
5. From the Edit menu, select Rename Group.  

 

 
6. Type "Room1 - Slider2" and press Enter. 
7. Select Group #3 by clicking with the left mouse button. 
8. Press F2. 

 

 

9. Type "Room1 - IR Remote" and press Enter. 
10. Repeat this procedure using appropriately modified names (Room2 - Slider 1, etc.) to set up 

groups 4 to 6 as controller groups for Room 2. 
11. Change the name of group 7 to "Reception". 
12. The finished result should look like this: 
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In addition to showing how to change group names, the above procedure has demonstrated an 
important aspect of the DIGIDIM Toolbox. That is that there are usually several different ways 
provided to achieve the same result. The Rename function works identically, whether you choose to 
invoke it using the right mouse button context menu, the Edit menu, or the F2 function key. This is 
true of many aspects of the application, and we encourage you to experiment to find the methods that 
suit you best. 
Saving the System File 
We have now set the stage for the work that is to follow, and we are ready to save the file to disk. We 
will do that, using the Backup As command from the file menu: 
  

1. From the File menu, select Backup. 
 

 
2. The Backup dialogue will appear and, if you have changed the system name correctly, 

"Tutorial1" should appear in the File Name box. If necessary, use the dialogue to navigate to 
the correct folder, and then click on "Save". 

Next: 

Adding the System Devices 
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Tutorial - Adding the System Devices 

 

     
For the next step of our tutorial, we will add the system devices to our simulation. These will 
include the seven DALI ballasts fitted to the luminaires and the DIGIDIM controllers that are to 
be installed in each room. Before we begin, ensure that the file we created (Tutorial1.dal) in the 
previous stage is open. If not, open it now using either the Merge/Restore command, or the 
Recent files list in the File menu. 
Adding an Ungrouped Controller 
The two button On/Off controller to be installed in the reception area is intended as a master controller 
for the system. The DALI commands that it generates are to be broadcast to the entire system, and to 
do this it must not be assigned to any group. In other words, it must be an Ungrouped device and we 
must place it into the Ungrouped section of the Device Tree: 
  

1. Ensure that no group is selected in the device tree. If one is selected, click on either the 
system icon at the top of the tree, or the Ungrouped icon at the bottom. 

2. Click on the icon for a 121 - 2-Button On/Off controller in the Device Toolbar.  

 

 

 

3. A corresponding entry will appear in the tree under the Ungrouped icon. Note that it is 
automatically assigned the label "Button 121 @1 [PHYSICAL]". "Button 121" is an identifying 
name that can be edited. "@1" indicates the system address of the device and "[PHYSICAL]" 
indicates the status of the device. The system expects this entry to represent an actual device 
as if it were in Online mode and connected to an actual system. 

4. Rename the device as "Master". 
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Adding Controllers to Specific Groups 
It is possible to add all of the devices to the Ungrouped section of the Device Tree, and then drag 
them to the appropriate groups. However, it is probably faster and more convenient to add them to 
their target groups. To do this, select the appropriate group before you add the device: 
  

1. Select the group named "Room1 - Slider1" in the Device Tree. 
2. Click once on the icon for a 111 - Double Slider controller in the Device Toolbar. The new 

device will appear under the icon for the group. 
 

 
3. Rename the Device "Room1 Slider". 
4. Select the group named "Room2 - Slider1" in the Device Tree. 
5. Click once on the icon for a 111 - Double Slider controller in the Device Toolbar. 
6. Rename the Device "Room2 Slider". 
7. Select the group named "Reception" in the Device Tree. 
8. Click once on the icon for a 125 - Seven Button Up/Down controller in the Device Toolbar.  

 
9. Rename the Device "Reception". 

The Device Tree should now look like this: 
  

 
Adding LIUs 
The procedure for adding Load Interface Units is identical to that for controllers. We can now add the 
system's ballasts to the appropriate groups as follows: 

1. Select the group named "Room1 - Slider1" in the Device Tree. 
2. Click once on the icon for a Ballast in the Device Toolbar.  
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3. Select the group named "Room1 - Slider2" in the Device Tree. 
4. Click once on the icon for a Ballast in the Device Toolbar. The new device will appear under 

the icon for the group. 
5. Select the group named "Room2 - Slider1" in the Device Tree. 
6. Click once on the icon for a Ballast in the Device Toolbar. 
7. Select the group named "Room2 - Slider2" in the Device Tree. 
8. Click once on the icon for a Ballast in the Device Toolbar. 
9. Select the group named "Reception" in the Device Tree. 
10. Click three times on the icon for a Ballast in the Device Toolbar. 

The Device Tree should now look like this: 
  

 
  
Our simulation is now nearly complete. All of the required devices are added, and we have set up 
some of the control relationships between them by adding them to the appropriate groups. However, 
this needs a little more refinement, and we will be fine-tuning the group assignments for the two 
offices in the next step of the tutorial. 

Next: 
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Setting Up Groups 
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Tutorial - Setting Up Groups 

 

     
In this stage of the tutorial we need to adjust the group memberships for the devices in office 
rooms 1 and 2. The reception area controllers, with one exception, are now set up exactly as 
we need them and need no further adjustment. The one exception is that the IR Receiver for 
the master controller must be disabled to allow an IR Remote to be used in the reception area. 
This is a simple operation and we will explain how to do this at the end of this section.  
The adjustment of the group membership of the office devices is the most complex aspect of 
this tutorial, and before we explain how to do it, we need to provide you with a little 
background information. 
Manipulating Controller Subdevices 
In step 1 of this tutorial we assigned three groups to each of the office areas. The three groups are 
required because we have three different control requirements for each office: 
  

• Slider 1 should control Lamp 1. 
• Slider 2 should control Lamp 2. 
• The IR Remote (via the slider controller's IR Receiver) should control both lamps 1 and 2. 

To achieve this, we need to divide each slider into three different parts, and assign each of these to a 
separate group. To do this, we must delve deeper into the DIGIDIM Toolbox than we have up to now 
and manipulate one of the most powerful aspects of the DIGIDIM system. That is the fact that every 
DIGIDIM controller is made up of a number of subdevices, and that each of these subdevices can be 
configured independently. 
  
The subdevices for the Twin Slider controllers can be examined by expanding the device. Do this by 
clicking on the "+" sign next to the device's entry in the Device Tree. 
  

 
  
The Slider contains a total of nine subdevices, one for each of the slider controls and one 
corresponding to each button on the IR Remote control unit. To configure Room 1 correctly, we need 
to move the Slider 2 subdevice to the group called "Room1 - Slider2", and move all of the IR 
subdevices to the group called "Room1 - IR Remote". We also need to carry out a similar procedure 
for Room 2: 
  

1. Expand the Slider in the group called "Room1 - Slider1" by clicking on the + sign next to its 
name. 

2. Click on the Slider 2 subdevice and drag it to the group called "Room1 - Slider2". Release the 
mouse button. 

3. Return to the Group "Room1 - Slider1" and select the topmost IR subdevice (IR Selection 1). 
4. Hold down the Shift key and select the bottommost IR subdevice (IR Down). 
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5. All seven IR subdevices should now be selected. Drag them down to the group called 
"Room1 - IR Remote". Release the mouse button. 

6. Repeat this procedure for the Room 2 groups. 

The Device Tree for Room 1 should now look like this: 
  

 
 
Room 2 should follow a similar pattern. 
Copying LIUs to Groups 
We now have a situation where the sliders in each room are controlling the correct lamps, but the IR 
Remote subdevices (in "Room1 - IR Remote" and "Room2 - IR Remote") sit alone in their groups and 
have no control over anything. To remedy this, we are going to introduce you to another powerful 
feature of DIGIDIM. This is that a single LIU can exist in more than one group. 
  
To get the IR remote to control both lamps in the room, we simply copy the ballasts to the group that 
contains the IR Subdevices: 
  

1. Use the right mouse button to drag the ballast in "Room1 - Slider1" to the group "Room1 - IR 
Remote". 

2. After releasing the button, select "Copy Here" from the pop up menu.  
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3. Repeat this procedure for the ballast in "Room1 - Slider2", dragging and copying it to "Room1 
- IR Remote". 

4. Repeat the procedure for the ballasts in room 2, dragging and copying them to "Room2 - IR 
Remote" 

The configuration for Room 1 should now look like this: 
  

 
Disabling the Master Controller's IR Receiver 
An IR Remote control unit is not required in the reception area, but it is possible that one of the units 
provided for the offices may be brought into the reception room. Since the seven button controller for 
the room and the master controller are located next to each other, any IR signals aimed at the devices 
will be picked up by the Master controller and broadcast to the entire system. This means that the IR 
remote will act as a master controller, and that could be a nuisance to anyone occupying the office 
spaces. The simplest way of avoiding this is to disable the master controller's IR Receiver as follows: 
  

1. In the Device Tree, Right-click on the master controller and select "Properties" from the drop 
down menu. A configuration dialogue will open.  
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2. Locate the Disable IR checkbox, and ensure that it is checked. Click on "OK" 
3. The expanded Master controller should no longer contain any IR subdevices.  

 

 

Next: 

Setting Scene Levels. 
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Tutorial - Setting Scene Levels 

 

     
We are almost finished. The final step in producing our simulation is to set individual levels for 
the Scenes that will be recalled using the Scene Recall buttons on the controllers. We will do 
this in two stages. First we will set up the default levels for all of the LIUs. Then we will adjust 
the levels in the reception area to some custom values. 
Storing Scene Presets 
If you have had some experience of using DIGIDIM button controllers or the IR Remote as system 
configuration tools, you may remember that both methods provide a simple procedure for storing 
default Scenes. By pressing the 3 and 4 buttons and holding them down, Scenes 1 to 4 are set to 
100%, 75%, 50%, and 25% respectively. These are useful values, and in many cases this is all that is 
required to complete the configuration. 
 
DIGIDIM Toolbox has its own variant of this process, known as the Store Scene Presets command. 
It is very similar in function, but is more powerful in that it can easily be applied to the entire system, 
all LIUs in a group, or an individual LIU depending on what is selected in the Device Tree. 
  
In the case of our tutorial system, we will set default levels for all of the LIUs in the system: 
  

1. Right-click on the system icon (Tutorial1) at the top of the Device Tree. 
2. Select "Store Scene Presets" from the drop down menu.  

 

 

  

3. A warning dialogue will appear. Click on "OK" to continue. 
4. Confirm that the command has worked by expanding one of the ballasts on the Device Tree 

(click on the "+" sign). Scenes 1 to 4 should be configured with the following values: 
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Setting Custom Scene Levels 
DIGIDIM Toolbox provides a number of methods of setting custom Scene levels. There is a Store as 
Scene command available in the Edit menu, and in both the context menus that appear when you 
right click in the Device Tree or the bar graph. If you expand an LIU in the Device Tree and Right-click 
on a Scene, selecting "Properties" from the drop down menu will open a dialogue that will allow you to 
enter precise numerical values. 
  
In our example we will use the bar graph "Store as Scene" command to modify the values for the 
three lamps in the reception area: 
  

1. Identify the three Reception area lamps in the bar graph display (devices 9,10 and 11). 
2. Click on the bar for the first lamp (9), and drag it to the 90% level. 
3. Right-click on the bar, and select "Store as Scene" from the drop down menu.  

 

 

4. Select Scene 1 from the drop down list by clicking with the left button. 
5. Repeat this for Scenes 2 to 4, storing values of 70%, 30% and 10% respectively. 
6. Repeat for the next lamp (10), storing values of 80%, 60%, 25% and 15% in scenes 1-4 

respectively. 
7. Repeat for the next lamp (11), storing values of 60%, 40%, 55% and 35% in scenes 1-4 

respectively. 
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Note that the application provides a number of scene storing methods. These include the 
ability to store scenes for the entire network, or for all LIUs located in in a group. For more 
details to these methods see the help topic entitled "Scene Setting Methods" 
  
We will use these custom Scene levels as part of our system test procedure explained in the final part 
of this tutorial. 

Next: 

System Testing 
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Tutorial - System Testing 

 

     
As a final step, we need to test the new system to ensure that it works as expected. To do this 
we will make use of the onscreen controller UIDs that were disabled at the beginning of the 
tutorial. We can use these to test the operation of all aspects of the system apart from some 
aspect of the behavior of the IR Receivers in the office areas. However, if that should become 
necessary, we provide a workaround solution at the end of this section. 
Using the UIDs 
The UIDs (User Interface Devices) are onscreen simulations of DIGIDIM system devices that provide 
almost the same functionality as an actual device. There are two types of UID: those that represent 
Load Interface Units and those that represent controllers. 
  

 
  
For the purposes of testing our new system, the second type are of most interest to us. The controller 
UIDs will allow us to operate the system in exactly the same way as we would if we were dealing with 
an actual installation. The control buttons, sliders and knobs are operated by clicking and dragging 
with the mouse. 
  
Activating the UIDs is a reverse of the procedure we used to disable them: 
  

1. From the View menu, select Control Panels. Open the View menu again and ensure that it is 
checked. 

2. To make a UID appear on screen, click on the icon for the particular device in the Device 
Tree. 

3. Repeat this for each device in the tree, until all four controllers are displayed. 
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Test the operation of the controllers in the following way: 
  

1. Operate the sliders (by clicking and dragging with the mouse) and ensure that they effect only 
the appropriate lamps in Room 1 and Room 2. 

2. Operate the Up/Down buttons on the seven button controller in the Reception, and ensure 
that they effect only the three lamps in the Reception area. Ensure that the Off button works 
correctly. 

3. Operate the four Scene recall buttons and check that the Reception lamps go to the 
appropriate levels. 

4. Operate the Master control, and ensure that all lamps switch on and off as required. 

Testing the Office IR Receivers 
If this has all worked satisfactorily, the only remaining feature to test is the operation of the IR 
receivers in the office areas. It is possible to test that the Scene settings are correct by using the 
Recall Scene command as follows: 
  

1. Select the "Room1 - IR Remote" group in the Device Tree. 
2. From the Edit menu, locate Recall Scene, and select Scene 1 from the drop down list. 
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3. Check that the Room 1 lamps have gone to the appropriate levels (100%). 
4. Repeat this procedure for Scenes 2 (75%), 3 (50%) and 4 (25%). 
5. Repeat the above for the "Room2 - IR Remote" group. 

If this works correctly, you can be confident that the IR receivers will work correctly on the actual 
system. However, part of the purpose of this simulation is to be able to demonstrate the system to a 
customer, and it is possible that they may want to try out the IR Remote operation. However, the 
current version of the application does not provide a UID for the DIGIDIM IR Remote control. 
  
A possible solution to this is to simulate an IR Remote by adding a virtual seven button controller to 
the group and labeling it as an IR remote. Seven button controllers have exactly the same default 
behavior as an IR remote, and setting the device's status to Virtual will prevent the application from 
flagging an error when the configuration is Merged with an actual system. To do this, proceed as 
follows: 
  

1. Select the "Room1 - IR Remote" group in the Device Tree. 
2. Click once on the 125 - 7 button Up/Down icon in the Device Toolbar. The new controller will 

appear in the Device Tree. 
3. Rename it as "IR Remote 1". 
4. Right-click on the device and select Properties from the drop down menu.  
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5. Locate the Status section of the dialogue that appears, and click on the Virtual button. 
6. Ensure that it is checked and then click on OK. 
7. Repeat this procedure for the "Room2 - IR Remote", but label the new device "IR Remote 2".  

 

 

Now, by asking your customer to exercise some imagination, you will be able to demonstrate exactly 
how the IR Remote will function in the new system. 
Congratulations! 
This tutorial is now complete, and if you have stayed with it this far, you are well on the way to 
becoming a DIGIDIM configuration expert. Although we have demonstrated a fairly simple system, 
you have made use of almost all of the major features of the DIGIDIM Toolbox. If you would like to 
know more, you can find detailed explanations of all the functions we have used and more in the 
remainder of this Help file. However, before doing that, we recommend that you complete the 
remainder of this Getting Started section. It contains important background information that will help 
you to make the most of the DIGIDIM Toolbox. 

Next: 

DIGIDIM Basics 
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DIGIDIM Basics 

  

DIGIDIM Basics 

 

     
Detailed technical knowledge of DIGIDIM is not needed in order to configure DIGIDIM systems.  
However, there are some concepts which will help you considerably when you configure some 
of the advanced DIGIDIM features. 
These relate to the operation of the system and the application. In particular, you should ensure you 
clearly understand: 
  

1. Online and Offline Modes.  
DIGIDIM Toolbox can be used both as an Online programmer, connected directly to the 
system; and as an Offline programmer, with no system connection. 

 

2. How System Messages are Addressed. 
DIGIDIM provides three methods of addressing commands to specific devices:  
- Broadcast addressing 
- Short addressing 
- Group addressing 

 

3. Virtual, Physical and User Interface Devices. 
Devices are represented in different ways within DIGIDIM Toolbox. Find out why this is, and 
how the different representations are used. 
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How System Messages are Addressed 

 

     
Since all the devices on a DIGIDIM system are connected by the same cable, any message sent 
is available to all system devices. However, to achieve precise control, it is important that only 
the intended devices respond to a particular command. To ensure that only the correct 
devices respond to a particular message, the DIGIDIM system uses three levels of addressing. 
Broadcast Addressing 
When a new DIGIDIM controller is first installed, it is set up to send Broadcast messages by default. 
This means that all of the LIUs connected to the system will respond to any message that it sends. 
For instance, a 50% direct level command sent from a push button controller will cause all of the Load 
interface units connected to the system to go to 50%. 
  
Broadcast addressing is useful in two ways. First, it means that simple systems can be operational 
immediately after installation without any configuration. Second, it provides the option of installing a 
master controller for all loads in the system. 
Short Addressing 
All DIGIDIM system devices are provided with what is known as a Long Address which provides a 
unique identifier that for the device. However, each device is also assigned a second address which is 
known as the Short Address. Short Addresses are automatically assigned during the configuration 
process and consist of a number in the range between 1 to 63. It is the Short address that appears in 
the device tree within DIGIDIM Toolbox, and is used as an identifier for the particular device on the 
system. 
  
Short Addresses are assigned to both Controllers and LIUs, but are particularly important for Load 
Interfaces because they make it possible for a specific command to be directed to a specific device. 
To achieve this, individual subdevices within the Controller can be set up to send their commands to 
specific Short Addresses. 
  

 
In this example, a twin slider (Short Address 3) was added to the system as a broadcast device. 
However, the configuration of each slider has been modified so that they send commands directly to 
the LIUs on Short Address 1 and 2 respectively. 
  
The destination of the IR subdevices is unchanged. In operation, any commands received from an IR 
Remote will be broadcast to the entire system, but each slider subdevice will send commands that will 
control only the lamps at Addresses 1 and 2. 

Note: 
In the DIGIDIM Toolbox, devices that are set either to Broadcast their messages or to send 
them to Short Addresses, are located in the "Ungrouped" section of the Device Tree (Group 
Layout view). 
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Group Addressing 
Both Broadcast and Short addressing provide a direct means of controlling LIUs, but the DIGIDIM 
system is capable of providing much more complex interrelationships between controllers and LIUs. 
Group Addressing provides a method of synchronizing the operation of a number of different lamps 
so that they can be controlled from a single point. 
  
Up to sixteen groups can be defined within a DIGIDIM system. Both Controllers and LIUs can be 
assigned to groups. However, because of their different function within the system the rules for group 
assignment are different for each type of device: 

Using LIUs in Groups 

• An individual LIU can be a member of none, any, or all of the groups within the system. 
• Group membership does not prevent a LIU from responding to broadcast messages or 

individually addressed messages. 

Using Controllers in Groups 

• A Controller (or individual subdevice within a controller) can be assigned to only one group. 
• A Controller or subdevice assigned to a group can only transmit messages to that group. Only 

LIUs that have been assigned to the group will respond to these messages 

For more information on using Groups see: "How Groups Work". 
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Online and Offline Modes 

 

     
When the DIGIDIM Toolbox is first started a dialogue will open, asking you to choose between 
Online and Offline operating modes. 
  
The principle differences between the two operating modes are as follows: 
In Online mode the computer running the application is connected to a physical system of DIGIDIM 
devices via the PC Interface (either a 510 USB-DALI Interface Module or a 505 Serial Interface with 
180 Programming Point). The devices shown on screen will represent either actual devices that are 
present on the system (flagged as Physical devices), or Virtual devices that exist only within the 
application. Any changes made to the configuration of the Physical devices in the software are 
immediately transferred to the actual devices in the system. 
  
In Offline mode the computer is running a simulation of the system where all of the system devices 
are represented by simulations modelled within the computer. As in Online mode, these devices may 
represent actual devices, but changes to their configuration cannot be immediately transferred to the 
system. However, the configuration can be saved to disk and then transferred to the system later in 
Online mode using a process called Merging. 
Using Offline Mode 
The purpose of Offline mode is to allow DIGIDIM systems to be modelled and configured in advance, 
away from the site, possibly in the early planning stages of a project. The configuration that is 
developed in Offline mode can then be quickly transferred to a physical system at a later stage. 
There are a number of advantages to using Offline mode in this way: 
  

• System configuration can be carried out in the comfort of a remote office, away from the 
sometimes unsuitable environment and pressures of a client's site. 

• New configurations can be developed, modified and fine-tuned at will, and without 
inconveniencing anybody. 

• The configuration, as modeled within the computer, can be fully tested in advance, so that 
you can ensure that it will work as intended when the system is commissioned. This means 
that time spent on-site can be kept to an absolute minimum. 

Using Online Mode 
To access Online mode the computer must be connected to a DIGIDIM system using a PC Interface 
(USB or Serial). When Online mode is invoked, the system is scanned for the existence of DALI 
devices. The application will then create an internal model of the system using the details of the 
devices it finds, and this will be represented on the computer's screen. 
  
The internal model of an Online system functions in a similar way to the Offline simulation of a 
system. Each device, whether it is a Load Interface Unit (LIU) or controller, is represented on screen 
and its settings can be adjusted using the same tools as in Offline mode. Each controller in the 
system can be represented by on-screen UIDs (User Interface Devices), which in most cases provide 
a fully functioning simulation of the actual device. The UIDs open in separate windows and provide a 
graphical representation of the particular device. The buttons, sliders and rotary controls displayed 
are active, and allow the controller to be used on-screen as if it was the actual device. 
  
In Online mode, any changes made to settings of the on screen devices are immediately transferred 
to the physical devices on the system. The application acts as a direct configuration tool for the 
system. 

See also: 
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• How DIGIDIM Devices Work 
• Virtual, Physical and User Interface Devices 
• How system Messages are Addressed 
• Starting in Offline Mode 
• Starting in Online Mode 
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Virtual, Physical and User Interface Devices 

 

     
At various points in the DIGIDIM Toolbox documentation you will see references to Virtual, 
Physical, and User Interface (UID) devices. To understand the operation of the software and 
how it works in conjunction with the system, it is important to understand the meaning of 
these terms. 
 
Virtual Device 

A virtual device is a software-based simulation of a system device (maintained internally by the 
DIGIDIM Toolbox) that does not correspond to an actual device on the system. Virtual devices can 
exist in both Online and Offline modes, and in Online mode they do not have to be associated with an 
actual device. 
Virtual devices are an extremely useful feature of the application, particularly during system design and 
configuration. The use of Virtual devices allows you to temporarily add any of the DIGIDIM devices to 
a system, either to simulate how the system would operate if such a device were fitted, or to use the 
DIGIDIM Toolbox as a real-time remote controller for the system. 
Virtual devices operate and are configured in exactly the same way as physical devices, and generate 
the same DALI messages on the system. As far as the DIGIDIM Toolbox is concerned the only real 
difference is that no error will be generated if a matching device is not found on the system. 

 
Physical Device 

A physical device is a software-based simulation of a system device (maintained internally by the 
DIGIDIM Toolbox) that must correspond to an actual device on the system. Physical devices can exist 
in both Online and Offline modes, but in Offline mode any changes to their settings within DIGIDIM 
Toolbox will not be reflected in the actual device until the Offline representation of the system is 
merged in Online mode. 

Device Status Mismatches 

The distinction between a device that has been configured as Virtual or Physical only becomes 
apparent when the application goes Online. At that time DIGIDIM Toolbox will expect to match each 
physical device that has been defined with an actual device on the system. If no such device is found, 
an error is generated, and you will have the opportunity to remove the device, convert it's status to 
Virtual, or leave it as it is with an error flag. 
User Interface Devices (UIDs) 
The term UID is an acronym for User Interface Device. In the context of the DIGIDIM Toolbox, a User 
Interface Device is the on-screen simulation of a DIGIDIM device that will open in its own window if 
the device name is selected. UIDs can represent both Controllers and Load Interface Units. 
  

 
  
UIDs representing Controllers are more than just simple representations of a device. They provide an 
accurate simulation of the device, and all of the buttons and other controls are active. When a button 
is pressed on a controller UID, it will generate a system message that exactly mirrors the message 
that would be generated if the actual button on the physical device were pressed. 
  



Getting Started 

55 

In Online mode using virtual devices, this will allow DIGIDIM Toolbox to act as a real-time controller 
for a DIGIDIM system. In Offline mode, UIDs allow you to simulate the operation of a system so that 
you can configure and test the system settings before they are applied to an actual system. 
See also: 

• Online and Offline Modes 
• How DIGIDIM Devices Work 
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Long Addresses and Serial Numbers 

 

     
Each DIGIDIM device connected to a system must be provided with a unique number, known as the 
long address. This Long Address is permanently associated with the device and is used by DIGIDIM 
Toolbox during Online start-up, and merge and restore operations. 
  
The DIGIDIM Toolbox Software treats Controller and Load Interface Unit's long addresses equally, 
but they originate in two different ways: 
  

1. DIGIDIM Controllers are provided with a built in serial number. This number is printed on a 
label attached to the device, and is also permanently encoded on a chip within the device. 

2. Load Interface Units are not provided with serial numbers in the same way. Instead, the long 
address is generated automatically when Toolbox first detects the device Online. 

Note that both the process of reading a Controller's serial number and generating a long address for a 
LIU are automatic and do not require your intervention. 
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Load Interface Units - A note on Terminology 

 

     
The DALI specification is specifically concerned with the control of electronic ballasts - that is 
to say electronic devices that control fluorescent lamps. However, the control protocol is 
equally applicable to many other types of lighting technology and, particularly in the case of 
DIGIDIM systems, is used to provide control messages to several different types of electronic 
controller. 
  
To make this clear, this document uses the general term "Load Interface Unit" (or its abbreviation 
"LIU") to mean any DALI compliant electronic load controller. 
A Load Interface Unit can be a fluorescent ballast, a transistor dimmer for incandescent lamps, or 
any of a range of special purpose units. 
  
If the term "ballast" is used, this specifically means a device that is used to control a fluorescent lamp. 
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Starting the Application 

  

Starting the Application 

 

     
DIGIDIM Toolbox can be started in the same way as any other Windows application.  
The application has two operating modes; Online and Offline Modes, and you must choose the 
appropriate mode as the application starts up. 
  

1. Start the DIGIDIM Toolbox application in Offline mode. 
2. Start the DIGIDIM Toolbox application in Online mode. 

  
Note: Online mode is available only when the DIGIDIM Toolbox computer is connected to a 
DIGIDIM system via the PC Interface (USB or Serial). 
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  Starting in Offline Mode 
 

     
Start the application in Offline mode when you have no need to connect to an actual DIGIDIM 
system. 
To start the DIGIDIM Toolbox application in Offline mode: 

1. From the Windows Start Menu select Programs/DIGIDIM Toolbox/DIGIDIM Toolbox, or 
double click the DIGIDIM Toolbox shortcut icon on your Desktop. 

2. The DIGIDIM Toolbox main Window will open and a dialogue box will be displayed. If no 
DIGIDIM system is detected, the dialogue will default to Offline mode 
 

 
3. Click on Continue to start the application. 
4. If the presence of a DIGIDIM system is detected, the dialogue will default to Online mode: 

 

  
5. Select Use Offline, and then click on Continue to start the application. 

See also: 

• Starting in Online Mode 
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Starting in Online Mode 

 

     
Start the application in Online mode when you want to connect to and modify an actual 
DIGIDIM system. 

To start the DIGIDIM Toolbox application in Online mode: 

1. From the Windows Start Menu select Programs/DIGIDIM Toolbox/DIGIDIM Toolbox, or 

double click the DIGIDIM Toolbox shortcut icon ( )on your Desktop. 
2. The DIGIDIM Toolbox main Window will open and a dialogue box will be displayed.  

If the presence of DIGIDIM system is detected, the dialogue will default to Online mode and 
the USB / COM port option selector will be set to the appropriate option: 
- 510 Digidim Interface for the 510 USB-DALI Interface  
- COM port for the 505 Serial Interface (connected to the 180 Programming Point) 
 

 
3. Click on Continue to start the application. 
4. If no system is auto detected, the dialogue will default to Offline mode: 

 
5. If you are sure that the PC Interface (USB or Serial) is present, select Use Online, and then 

use the USB / COM port option selector to choose the appropriate option. 
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Note: It is possible to add any COM Port you wish by simply typing your intended COM 
Port destination over COM1 or COM2 in the above screen. 
 
For COM Ports beyond COM 9 you need to prefix the name with “\\.\”. So, COM 10 
would be typed " \\.\COM10" 

6. Click on Continue to start the application. A progress bar will appear and DIGIDIM Toolbox 
will begin to interrogate the system to identify the devices that are connected. 
 
Once all devices are identified it will check each device's configuration and resolve any 
address conflicts that may exist. 
 

 
 
Toolbox will then retrieve device configuration data. 
 

 

7. Finally, it will display all of the devices in the Device Tree. 
 
Note. On a large system this process can take some time to complete. 

If DIGIDIM Toolbox is unable to connect to a DIGIDIM system on the specified port, or if there 
is some other problem, it will return an error message. This may be due to a problem with the 
PC Interface (USB or Serial), the programming point), or the DIGIDIM system itself. Click on 
Cancel, close the application and check that the PC Interface has been installed correctly. 

Related Topic: 

• Starting in Offline Mode 
• Online and Offline Modes 
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Connecting your PC to the DALI 
network  

     
For the DIGIDIM Toolbox to operate in Online mode, the computer that you are using must be 
connected to the system using a PC Interface. To do this, follow the instructions below. 

PC Interfaces: USB connection, or Serial port connection 
Use either: 
- the USB-DALI Interface Module (510), or 
- the Serial Interface (505) and Programming Point Module (180) .    

 

     

USB-DALI Interface 
Module (510) 

Serial Interface (505) and Programming 
Point Module (180) 

Installation of PC Interface 
Either module (510 or 180) can be installed at any convenient location on the system, and must be 
installed correctly according to the instructions provided with the unit. 
Installation instructions are included with the 510 and 180. 
Their installation guides are available for download from http://www.helvar.com/downloads/product-
documentation 

After Installation: USB-DALI Interface (510).  
1. Once the 510 module is installed, connect it to your PC with a USB cable. 
  
2. Windows should display a message confirming that the device (the 510) has been successfully 
installed. The example below is from a Windows 7 PC. 

 

Windows 7 message when 510 USB-DALI Interface Module is 
first connected 

  
3. Start the DIGIDIM Toolbox application 
  

http://www.helvar.com/downloads/product-documentation
http://www.helvar.com/downloads/product-documentation
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After Installation: Serial Programming Point Module (180) 
1. Once the Serial Programming Point Module (180) is installed, connect it to your PC using the PC-

to-DALI Interface (505). 
  
2. Restart the PC. 
  
3. Start the DIGIDIM Toolbox application 
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  Using the History Window 
 

     
The History window displays a scrolling list of DIGIDIM system activity. The list is updated in 
real-time and provides a useful diagnostic tool during troubleshooting.  
Its main use is to confirm that the system's controllers are operating correctly and are issuing 
the correct commands. Using it can provide an insight into the overall operation of a DIGIDIM 
system. The contents of the history list can be saved to disk for subsequent analysis.   
To open the History window: 

1. From the Tools menu, select History. 
2. Alternatively, click on the History Window icon on the Toolbar.  

 

 

When the window opens, it will contain a list of all the messages that have occurred on the system since the 
DIGIDIM Toolbox application was started. This includes all commands issued by the controllers, and any 
responses to queries that are generated by the receiving devices. 

 
 
The History window is divided into 6 columns as follows: 

 
No. 

From the beginning of each History session each command is provided with a sequential number. 
These are not part of the DALI message, but are provided simply to make the message list easier to 
analyse. A count of the total number of messages in the history list is displayed at the bottom of the 
screen. 

Destination 
The address to which the command has been issued. These depend on the sending device's settings and 
messages can be addressed to: Broadcast, a specific short address, or a specific group number. 
Repeated commands to the same address, with the same content and issued within the same second are 
shown with a multiplier (see x2 in message 34). 

Command 
The details of the command issued in the form: Command/value. 

Query Reply 
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Most DALI commands will not result in, or require, a response from the receiving device. However 
Status Query commands do require a response, and the result will be displayed in this column. If no 
response is received (for instance if the device is not present) the column will display "No Reply". 

Time & Date 
The time and date that a command was issued. 

HEX 
The hexadecimal code for the command message content. 

The History Window Shortcut Menu 
right-clicking in the History window will open a shortcut menu containing three commands: 
  

 
  
Copy 

Invoking this will place a copy of the contents of the history window on the Windows clipboard, ready 
to be pasted into a text editor, database or similar application. The information is in the form of an 
ASCII text table, with comma separated values. 

Clear History 
This, as the name implies, will delete the contents of the History window. A confirmation dialogue will 
appear: 

  

 
 
Save History 

This will open a file dialogue, allowing you to save the contents of the history window as a .CSV 
(comma separated value) database file. 

Examples of History Window diagnostics 
Example 1: Direct Level 
When setting the Direct Level command for a slider (the example below is a 110 single slider control), 
the Value required is a DALI number from 0-254.  To find the equivalent DALI number for a dimming 
percentage, view the History Window. In the example below, DALI Value 230 is 51.9%.     

 
Example 2: Hexadecimal command strings 
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The History Window can be used to find hexadecimal DALI command strings for actions. In the 
screenshot above, the hexadecimal numbers are listed on the right. 
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Working with System Files 

  Working with System Files 
 

     
One of the major advantages of the DIGIDIM Toolbox is that it allows you to Backup a system's 
configuration settings to disk and Restore them at a later time. You can use this capability with 
both actual and virtual systems, and this provides a number of options as to how you 
approach the configuration process. This section of Help is dedicated to explaining how to use 
the system file commands. It is divided into two sections: 
  
Configuration Workflows. This provides three general strategies for working with DIGIDIM systems 
that should cover most circumstances. 
  
The File Management Commands. This explains how to use the Backup, Merge and Restore, and 
Rename System commands. 
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Configuration Workflows 

 

     
The steps that you take to configure a DIGIDIM system are likely to fall into one of three basic 
workflows. The one that you choose will depend on both the circumstances and the task that 
you are trying to complete. 
  

1. Offline Configuration - No System Available.  
It is possible to use the DIGIDIM Toolbox to create, configure and test a system in the early 
planning stages of an installation, long before the physical installation takes place. The 
configuration can then be backed up to disk and then merged when the installation is 
complete. This method is also useful for prototyping, and will allow you to experiment with 
different configurations before finalising the lighting system design. 

2. Offline Configuration - System Available.  
Where a physical system already exists, the DIGIDIM Toolbox can be used to make a disk 
image of the system devices, so that configuration and initial testing can be carried out 
Offline. This can save a lot of time, and can be useful where it is inconvenient or impossible to 
physically connect the DIGIDIM Toolbox to the system while configuration takes place. The 
resulting disk file can then be merged with the system at a later time. 

3. Online Configuration.  
If the system is fully installed, and there are no constraints on the time that you have available 
on site, the DIGIDIM Toolbox can be used to configure the system in real time. This method is 
also suitable for use with smaller systems, where Online configuration is unlikely to cause 
inconvenience to the building's occupants. 
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Offline Configuration - No System Available 

 

     
It is often the case that a new lighting system is planned long before installation takes place, 
or even before the building that it is to be installed in is constructed. Offline configuration will 
allow you to use the DIGIDIM Toolbox to create and test a virtual system, save the 
configuration settings and then apply these to an actual system when it has been installed. 
The advantages of this method of working are that it provides plenty of room for 
experimentation, and allows the DIGIDIM Toolbox to be used as a lighting system design tool. 
Workflow 
The diagram below shows the general workflow that you will follow to carry out Offline configuration 
when no system is available. It is a two-stage process, and each stage is explained in more detail in 
the procedures that follow: 
  

 
Stage 1: Configuration 

1. Start the DIGIDIM Toolbox in Offline mode (or select New from the file menu). If no 
system is available, DIGIDIM Toolbox will default to Offline mode - simply click "Continue" 
to begin. 

2. Add Devices. Use the Edit/ Add Device menu or the Palette Toolbar buttons to add the 
required devices to the new system. 

3. Name the System. Use the Edit/Rename Network menu item to create a name for the new 
system. 

4. Configure Groups. Use the Group View pane to drag devices between groups until the 
correct control relationships have been established. 

5. Configure Devices. Use the Device Properties Dialogue to set up the controller settings 
and commands. Also, use the Tree View pane to provide each device with a unique name. 

6. Set up Scenes. Use the Device Properties Dialogue (or the bar graph Display and the 
Edit/Store as Scene menu item) to set up the levels for LIU Scenes. 
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7. Test the New System. Use the onscreen UIDs to test the operation of the system to ensure 
that it operates as intended. 

8. Backup the Project System to Disk. Select the File/Backup menu item. Use the resulting 
dialogue to select a location and enter an appropriate name for the file. 

Stage 2: Applying the New Configuration 
After the system configuration is completed, you can return to the site, connect your computer to the 
system, and start DIGIDIM Toolbox in Online mode, and apply the configuration to the system in the 
following way: 

1. Start DIGIDIM Toolbox in Online mode. If the computer is connected to the system, 
DIGIDIM Toolbox will default to Online Mode - simply click "Continue" to begin. 

2. Merge the System using the Project Disk File. The Unmatched Device Dialogue will open 
and prompt you to associate each file device with a system device. 

3. Test the Operation of the System. Carry out a full test using the actual system controllers to 
ensure that the system functions as intended. Make adjustments as necessary. 
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Offline Configuration - System Available 

 

     
Even if a system has been installed and is available, there can still be considerable advantages 
to carrying out the system's configuration Offline. It may be that the time that you have 
available to spend on-site is limited. If the premises are occupied, the constant changing of 
light levels during configuration could cause a considerable nuisance and interruption to the 
normal activities of the residents. Alternatively, you may simply want the opportunity to 
experiment, without the pressure of an audience. 
  
Whatever the reason, if you choose to configure the system Offline, the availability of the system can 
be used to speed up the process considerably. This is because you can go Online and make a disk 
image of the system, avoiding the need to add all of the system devices manually. 
  
A similar procedure can be used when it is necessary to modify or extend an existing system. In this 
case, a system image is created before any modifications are made. The configuration can then be 
edited Offline, and then applied immediately when the work on the system components is completed. 
The only significant difference is that Merge would be used to apply the changes rather than Restore 
(step 2, stage 3). 
Workflow 
The diagram below shows the general workflow you follow to carry out Offline configuration in this 
way. There are three stages, and each of these is described in more detail in the procedures that 
follow: 
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Stage 1: System Imaging 
In the first stage, connect to the DIGIDIM system and make a disk image of the system's 
configuration. That is to say, use Online Mode to "discover" the details of the system devices and 
save this information to a DIGIDIM Toolbox Project file. 
  

1. Start DIGIDIM Toolbox in Online mode. Connect your computer to the system via a PC 
Interface (USB or Serial), and start DIGIDIM Toolbox in Online mode. DIGIDIM Toolbox will 
interrogate the system and, at the end of the process, will populate the device tree with the 
system's devices. 

2. Name the System. Use the Edit/Rename Network menu item to create a name for the new 
system. 

3. Identify and Name Individual Devices. Determine which short addresses have been 
assigned to which devices. Use DIGIDIM Toolbox's bar graph to identify LIUs, and use the 
History window to identify controllers. Once you have identified a device, name it so that you 
will recognize it when the file is restored in Offline mode. 

4. Backup the Project System to Disk. Select the File/Backup As menu item. Use the 
resulting dialogue to select a location and enter an appropriate name for the file. 

Stage 2:Configuration 
Once the details of the system are stored on disk, they can be restored in Offline mode 
  

1. Start DIGIDIM Toolbox in Offline Mode. 
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2. Restore the Project File. The device list will be populated with the details of the system 
devices. 

3. Move the Devices (and Subdevices) to the required Groups. Use the Group View pane to 
drag devices between groups until the correct control relationships have been established. 

4. Configure Individual Devices. Use the Device Properties Dialogue to set up the controller 
settings and commands. 

5. Set up Scenes. Use the Device Properties Dialogue (or the bar graph Display and the 
Edit/Store as Scene menu item) to set up the levels for LIU Scenes. 

6. Test the New System. Use the onscreen UIDs to test the operation of the system to ensure 
that it operates as intended. 

7. Backup the Project System to Disk. Select the File/Backup As menu item. 

Stage 3: Applying the New Configuration 
Once the system configuration is saved to disk, you can return to the site, connect your computer to 
the system, and start DIGIDIM Toolbox in Online mode, and apply the configuration to the system in 
the following way: 
  

1. Start DIGIDIM Toolbox in Online mode. If the computer is connected to the system, 
DIGIDIM Toolbox will default to Online Mode - simply click "Continue" to begin. 

2. Restore the System using the Project Disk File. Select the Merge/Restore item in the File 
menu. Use the resulting dialogue to navigate to the correct location and select the file. Since 
the correct details for the system were entered when the disk image was created, the Restore 
should complete without invoking the Match Device dialogue. 

3. Test the Operation of the System. Carry out a full test using the actual system controllers to 
ensure that the system functions as intended. Make adjustments as necessary. 
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Online Configuration 

 

     
Where an actual system exists, and there is nothing to prevent you from working on-site, 
Online configuration is the simplest, fastest and most reliable method of setting up a DIGIDIM 
system. Using the DIGIDIM Toolbox in Online mode allows control over all aspects of the 
DIGIDIM system in real time and, as a result, actual lighting levels can be viewed and adjusted 
as required. 
Workflow 
The diagram below shows the general workflow that you will follow to carry out Online Configuration. 
The process involves only a single stage, and each point is explained in detail in the procedure below: 
  

 
  

1. Start the DIGIDIM Toolbox in Online mode. Use a PC Interface to connect the PC to the 
DALI network. If the system is detected, the application will default to Online mode - click 
"Continue" to begin. 

2. Name the System. Use the Edit/Rename Network menu item to create a name for the new 
system. 

3. Identify the System Devices. Use the onscreen UIDs to determine which devices in the 
device list correspond to each actual device on the system. Once they are identified, use 
Edit/Rename Device to provide each device with a unique name to help with future 
identification. 

4. Move the Devices (and Subdevices) to the required Groups. Use the Group View pane to 
drag devices between groups until the correct control relationships have been established. 

5. Configure Devices. Use the Device Properties Dialogue to set up the controller settings 
and commands. 

6. Set up Scenes. Use the Device Properties Dialogue (or the bar graph Display and the 
Edit/Store as Scene menu item) to set up the levels for LIU Scenes. 

7. Test the New System. Use the onscreen UIDs, and actual system controllers to fully test the 
operation of the system to ensure that it operates as intended (if required, you can add 
Virtual Devices to simplify this process). Make adjustments as required. 

8. Backup the Project System to Disk. Select the File/Backup As menu item. Use the 
resulting dialogue to select a location and enter an appropriate name for the file. 
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The File Management Commands 

  

The File Management Commands 

 

     
The software provide five basic file management commands: "New", "Backup", "Backup As", 
"Merge/Restore" and "Rename Network" The following four topics explain the use of each 
command in detail. 
  
Creating a New System File. "New" removes any existing configuration the DIGIDIM Toolbox and 
provides you with the opportunity to restart in Online or Offline mode. 
  
Using Backup and Backup As. "Backup" and "Backup As" allow the system's configuration to be 
saved to disk, and are comparable to the standard Windows "Save" and "Save As" commands. 
  
Using Merge and Restore. The "Merge/Restore" command is similar to the Windows "Open" 
command, but has special features that allow the configuration of a virtual system to be applied to an 
actual system in Online mode. 
  
Renaming the System. Provide your system with a name to help with identification. 
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Creating a New System File 

 

     
The New command is available in Offline and Online modes. It restarts the application and 
clear the computer's memory so that a new system can be created. Once created, the new 
system can be saved to disk using the Backup As command. 
Online or Offline? 
If you choose to restart the application in Offline mode, the New command will provide you with a 
completely empty system. This provides a starting point for the creation of a new Virtual system. 
  
If you choose to restart in Online mode, the DIGIDIM Toolbox will query the system and populate the 
device tree with the devices that it finds. This provides a fast way of removing Virtual devices from a 
system that has recently been restored. However, it also provides a method of making an image of 
the existing system, complete with its existing configuration settings. This can save some time in the 
Offline Configuration process. For more details see "Offline Configuration - System Available". 
  
Note that the new system must contain at least one device before the Backup As command 
will become available. 

To create a new system file: 

1. From the File menu, select New. If the system contains any unsaved modifications, a warning 
dialogue will appear:  

 

2. Select Yes, or No. If you select Yes, a file dialogue will appear. 
3. The application will restart, and any existing devices will be flushed from memory. 
4. The DIGIDIM Toolbox start-up dialogue will open:  

 

5. Use the dialogue to choose whether to work Online or Offline, and then click on Continue to 
restart the application. 
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  Using Backup and Backup As 
 

     
The DIGIDIM Toolbox provides two commands that will allow the current system to be saved to 
disk. "Backup" and "Backup As" roughly correspond to the standard Windows Save and Save 
As commands. Backup will simply save the current system to disk using the existing file 
name. Backup As provides the opportunity to save the file under a different file name. 
  
The Backup and Backup As commands are both available in the File menu, but only Backup is 
available in the Application toolbar . 
  
Backup will save to disk the configuration details of the DIGIDIM system held in memory. If you are 
working with a system that has been Restored or Merged from an existing disk file, the file will be 
overwritten. If no file is open, a file dialogue will appear that will allow you to enter a new file name, or 
select an existing file to overwrite. 
  
Backup As is used to save an opened file under a new file name.The file name used can be any that 
fits within the Windows standard for file names. The file extension ".dal" is added automatically by the 
file dialogue as the file is saved. 
  
The file on disk contains a complete description of the configuration of the system. This includes 
details of the system devices, their short addresses, group memberships and configuration settings. It 
also includes the names that have been assigned to the system, groups, and devices using DIGIDIM 
Toolbox. 
  
Backup and Backup As can be used in both Online and Offline mode. 
Notes: 

1. The system, group and device names stored in the file are not part of the actual system's 
configuration, and only exist within DIGIDIM Toolbox and the disk file. 

2. The file does not contain a record of the output levels of the system's lamps at the time the 
file was saved. 

To backup a system to disk: 

1. From the File menu select Backup. If the system has been Restored from an existing disk 
file, this file will be overwritten with the new system details. 

2. If there is no existing file, a file dialogue will open on screen. 
3. Use the dialogue to navigate to the required location, and then enter a suitable file name. 
4. Click OK. The system details will be saved to disk. 

To backup an existing system using a different file name (Backup As): 

1. From the File menu select Backup As. A file dialogue will open on screen. 
2. Use the dialogue to navigate to the required location, and then enter a suitable file name. 
3. Click OK. The system details will be saved to disk under the new file name. 
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Using Merge and Restore 

  

Using Merge and Restore 

 

     
The Merge and Restore commands both combine the configuration of devices stored on a disk 
file with that of any devices held in the computer's memory. But the difference between them 
is in the way that they do it. Restore will give priority to the devices stored on the disk and will 
overwrite the configuration of any devices that it can find a match for. Merge will allow you to 
choose which device configurations are used on a case-by-case basis. 
  
Both Merge and Restore are invoked from the Merge/Restore item that appears in the File Menu, 
and this item is also duplicated in the Application Toolbar . When Merge/Restore is selected a 
dialogue will open, which will allow you to choose between merging a file or restoring it. 
  
The choice of which command to use depends on the circumstances. This will become clear as we 
explain the differences between them below. 

Using Merge 

The Merge command is used to ensure that there is a definite match between the devices that are 
represented on-screen, and the actual devices that form the physical system. When the file is opened, 
details of the devices it contains are passed to a Match Device dialogue , and this is presented 
alongside a list of the devices that exist in the system held in memory. The Match Device dialogue 
will allow you to either match the file device with a corresponding system device, ignore it, change its 
status to Virtual, or add it to the system with an error flag indicating that it is not matched to any 
existing system device. The dialogue also provides a number of tools that will help you to identify 
devices on the system. 
  
Use Merge when you need to be sure that the configuration changes that you have made will be 
applied to the correct device. This will usually be the first time that a file configuration is applied to an 
actual system, but Merge can also be used to combine two disk-based systems. This provides two 
different strategies that can be followed when merging systems: 
  
Online Merging 

This is, perhaps, the most obvious and commonly used use of the Merge/Restore command. Online 
merging means to merge the details of a physical system acquired via the PC Interface (USB or Serial), 
with the details of a virtual system stored on disk. This procedure provides the fastest set-up method 
available for an unconfigured system, and assumes that all of the configuration has been carried out 
using a virtual image of the physical system. 

Offline Merging 
In Offline mode the Merge command can be used to merge two systems that have been backed up to 
disk. This an be useful when two separate physical systems are to be interlinked. By making a disk 
image of both systems (see below), any addressing conflicts or other problems can be resolved before 
the physical connection takes place. 
Merge is used when you need precise control of how the devices stored in the disk file are 
applied. Rather than attempting to automate the device matching process, DIGIDIM Toolbox 
will simply pass all of the file devices to the Device Match dialogue , which will open on 
screen. This will allow you to choose which of the devices are given priority on a case-by-
case basis. 

To merge a system: 

1. From the File menu select Merge/Restore. 
2. From the dialogue, select Merge from the list. 
3. Click on the Merge button. 
4. Use the file dialogue to select the required project file and then click Open. 
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See "Using the Device Match Dialogue" for more details. 

Using Restore 

The operation of Restore is similar to that of the standard Windows Open command. The selected file 
is opened and the device list will be populated with the devices described in the file. Choosing 
Restore will give priority to the devices stored on disk, and this means that the configuration of the file 
devices will be used to overwrite the configuration of corresponding system devices. Restore can be 
used to open a new file in Offline mode, or to update a system when you are confident that there is a 
good match between the file and system devices. If the system is in Online mode any configuration 
changes will be copied to the system devices. 

To restore a system: 

1. From the File menu, select Merge/Restore. 
2. From the dialogue, select Restore from the list, and click the Restore button. 
3. Use the file dialogue to select the required project file and click Open. 

Using Restore is usually a much faster method of opening a file than Merge, but during the operation 
the system does check to ensure that the devices are matched correctly. If any mismatches between 
the system and file devices are detected these will be passed to the same Match Devices dialogue 
that is used by the Merge command. 

System Imaging 

To allow Offline configuration to take place, the application must be provided with a virtual image of 
the system - with each device in the physical system represented by a virtual device in the computer's 
memory. This virtual image can be created manually by adding devices one at a time or, if the 
physical system exists, it can be created by connecting to the system in Online mode and then using 
the Backup command to save an image of the system. 
  
The resulting virtual image can be modified and tested Offline, before any changes are applied using 
the Restore command in Online mode. 
  
See "Offline Configuration - System Available" for step-by-step instructions on making an image file. 
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Using the Device Match Dialogue 

 

     
The Device Match Dialogue appears when a project file is opened using Merge, or if device 
mismatches occur when a project file is opened using Restore. The dialogue allows you to 
intervene manually in the merge process, to determine how each project file device is treated. 
Perhaps most importantly, it allows you to directly match project file devices with specific 
devices on the system. 
  

 
  
The dialogue contains two main panes. The left hand pane contains a list of unmatched project file 
devices of a particular type, and the right hand pane a list of unmatched system devices of the same 
type. On the right hand side of the dialogue is a row of buttons, which are used to perform operations 
on the devices that are selected from the lists: 
  
Match/Insert 

This button is context-sensitive. If a single device from the Unmatched Project list is selected, the 
button will Insert the device into the system using an unused short address (with an error flag if in 
Online mode). If both a Unmatched Project device and a Unmatched System device are selected, the 
button will Match the two devices. Matching means that the project file device's configuration will 
overwrite the system device's configuration. 

Physical Selection 
This command is only available Online when a file device is selected, and there are unmatched 
physical devices available in the system list. When pressed, the file device will be matched to the next 
device to be physically selected (see "More on Physical Selection" below). 

Flash Load 
This command is only available Online when a file device is selected, and there are unmatched 
physical LIU devices available in the system list. It allows you to positively identify the LIU so that 
you can determine which file device to match it to. When pressed, the selected system LIU will flash 
on and off for the number of times entered in the "Flashes" text box. Note that this process cannot be 
interrupted, so it is not advisable to enter a large number in this box. 

Make Virtual 
As the name suggests, this will change the status of the selected file device to "Virtual". It will then be 
added to the system using the next available address. 

Ignore Device 
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When pressed, this will cause the selected file device to be removed from the Merge/Restore 
procedure. It will not be added to the current system, but will remain available in the disk file until the 
file is overwritten. 

Device Types 
The device lists are arranged according to device type. This list box allows you to select the device 
types that you are currently working with. 

 

 
  
Finish 

This completes the Merge/Restore procedure at any point. All matches that have been made will 
remain, but any devices that have not been processed will be ignored. 

Cancel 
This aborts the Merge/Restore procedure and returns the system to it original state. 

More on Physical Selection 

"Physical Selection" means triggering the device in some way to identify the device on the system. It 
can be useful if you are unsure which device in the system is represented by the devices in the 
system list. 
  
The process used for physically selecting a device depends on the particular device type. For 
ballasts, the lamp (which must be operating) is temporarily removed from the circuit, usually by 
twisting the tube. Modular controllers simply need to be operated. Other devices, such as dimmers 
and converters may be provided with a physical selection switch, or (as is the case with Multisensors) 
the remote switch may be used. Whichever way it is achieved, the result is that a system message is 
sent, allowing DIGIDIM Toolbox to identify the specific device that is intended. 
  
See Also: 

• The File Management Commands 
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Renaming the System 

 

     
The default name for a system created in DIGIDIM Toolbox is 'Untitled Network'. To change the 
system name: 
  

1. In the Group View List, select and highlight the system name at the very top of the tree. 
2. From the Edit menu (or right mouse button shortcut menu) select: Rename Network. 
3. Type the new name for the system and press Enter. 

Notes: 
  

1. When a network name is given to an unsaved system, the new name will be offered as a file 
name when the system is saved. Beyond that, changing the system name has no effect on 
the file name that the system is saved under. To change the file name, use the File/Backup 
As menu item. 

2. Names are stored only as a part of the Project file on disk, and not on the DIGIDIM system. 
To make names available when configuring a system Online, you must first restore or merge 
the system with the appropriate project file. 
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Using the Device Tree 

  Using the Device Tree 
 

     
The left hand side of the system view area consists of a listing of all the devices that form the 
current DIGIDIM system. This part of the screen is known as the Device Tree, and it is perhaps 
the most important part of the DIGIDIM Toolbox interface. It provides both a visual 
representation of the system's configuration and a method of modifying it. 
  

 
  
The tree is provided with two tabs, which allow you to choose between viewing the devices according 
to the groups (Groups Layout) that they are associated with, or according to their address (Device 
Layout). The listing is the primary means of configuring the address relationships between the 
different devices on the system, and also provides access to the device properties dialogues, which 
are used to make detailed changes to individual device configurations. 
  
This section of help contains three topics that explain how to make use of the device tree: 
  

• Group Layout View 
• Device Layout View 
• Expanding Devices 
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  Using Group Layout View 
 

     
When the groups layout tab is selected, the tree view shows the devices arranged according to 
the groups that they are assigned to. Group view provides an intuitive, visual method of 
configuring the group assignments of the system devices, and also provides easy access to 
the individual device property dialogues. 
  

 
  
In Group View, move a device (or subdevice) from one group to another by dragging and dropping it. 
The copy command (or CTRL drag) can also be used to copy LIUs to other groups. See "Working 
with Groups" for a detailed explanation of the use of grouping commands. 
  
Each group can be expanded (click on the + symbol) to reveal the devices that are contained within it. 
Once revealed, the devices themselves can be expanded to reveal the details of their configuration. 
  
Devices and subdevices that are not assigned to any group are displayed in the Ungrouped section of 
the tree. An LIU in the Ungrouped section will respond to both broadcast and short addressed 
messages. Controllers in the ungrouped section may be set to either broadcast or short addressing. 

  
  



Using the Device Tree 

89 

  

  Using Device Layout View 
 

     
The Device Layout View shows the devices in the form of a list, arranged according to their 
short addresses. It provides an alternative perspective on the system, and can make some 
operations simpler to perform. 
  

 
 
Device Layout View allows the devices to be manipulated in much the same way that Group Layout 
view allows. The devices can be expanded and configured in the same way, but deleting a device 
from the Device Layout view will remove it (and its settings) from the system. 
  
Note that in Online mode it is not possible to delete an actual device from the system. If you 
delete its Physical representation in Offline mode, it will be restored (minus any name settings) 
when you go back Online. 
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  Expanding Devices 
 

     
The devices that are shown within the device tree can be expanded in the same way as groups 
(click on the +symbol next to the device listing). For Controllers, this provides a view of the 
device's basic configuration and the opportunity to manipulate controller's individual 
subdevices. For LIUs, the expanded device shows its Scene settings, and provides a method 
of changing them. 

Expanding Controllers 
In the case of a controller, expanding the device will reveal the configuration of the various 
subdevices that it is made up of: 
  

 
 
In the example above, an expanded slider in Group Layout view is shown. This contains, as expected, 
details of the command issued by the slide control, but it also contains seven subdevices that 
correspond to the buttons on the DIGIDIM IR remote. 
  
All DIGIDIM controllers contain a subdevice corresponding to each physical control they contain, plus 
these seven IR subdevices (if they are fitted with an IR receiver). Each subdevice behaves as if it 
were a separate device and can be configured individually. 
  
A good example of this is group assignment. For many applications, all of the subdevices of a 
particular controller will exist in the same group. However, for some devices and some configurations, 
it may be necessary for some devices to exist in different groups. For example, the slider subdevices 
in a twin slider controller will usually be assigned to different groups.  You may also want IR 
commands to be sent to a different group or to be broadcast to the entire system. This kind of 
configuration is shown in the illustration below. 
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The device tree allows the group assignment of the subdevice to be manipulated using drag and drop 
techniques. See "Working with Groups" for more on this. 
  
You can also use the copy and paste commands to copy the configuration of one subdevice to 
another of the same type. For more advanced settings, the "Properties" command will open a 
dialogue which will allow you to change a number of device and subdevice settings. For more 
information on all of this, see the section of help entitled "Working with Devices". 

Expanding Load Interface Units 
Load Interface Units can be expanded in the same way as controllers, but they do not contain 
subdevices. Instead, an expanded LIU displays a list of the levels associated with Scenes that are 
stored within it. 
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In the example shown, these are all set to IGNORE, which means that the device will not respond to 
any "Recall Scene" message that it receives. However, Scenes are easy to set up simply by adjusting 
the lamp to the required level, and then invoking the "Store as Scene" that appears in the right mouse 
button shortcut menu. It is also possible to configure the first four scenes automatically using the 
Edit/Store Scene Preset menu command. For more on this see the help topic entitled "Working with 
Scenes". 
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Working with DIGIDIM Devices 

 

     
Much of the configuration work that you carry out with DIGIDIM Toolbox software can be done by 
manipulating devices in the Device Tree. 
However, there will be times when you need to go a little deeper and change specific individual 
settings within the devices. This section of help explains how DIGIDIM Toolbox's various device-
related operations are carried out. 
  
Before you begin to work through this section, it may be useful to read through the "Getting Started" 
section, particularly the Tutorials and the "DIGIDIM Basics" section. This provides some important 
background information that may help you here. 
  

We recommend you read these topics:  

• How DIGIDIM Devices Work 
• Inserting a New Device. 
• Removing Devices 
• Renaming a Device 
• Configuring Devices 
• DIGIDIM Devices 

  



Toolbox Help 

94 

  

  How DIGIDIM Devices Work 
 

     
DIGIDIM systems are collections of devices such as Panel controllers, Load Interface Units 
and Sensor Modules connected by a common data cable. Each device is intelligent and 
contains a microprocessor and a small amount of memory which is used to store the settings 
of the individual device. 
  
When we speak of the system's configuration we are talking about the collective effect of the 
settings stored within each of these individual system devices. The process of system 
configuration consists of adjusting the settings of individual devices until the system 
performs in the way that we want it to. The key to becoming an expert in DIGIDIM configuration 
is to gain an understanding of how the devices work together and of the options available 
during configuration. 

Device Types: Controllers and Load Interface Units (LIUs) 
DIGIDIM systems are made up of two types of device: Controllers and Load Interface Units (LIUs). In 
simple terms Controllers are the generators of control messages. LIUs are the receivers, interpreting 
control messages to provide direct control of the load that they are connected to. There are important 
differences in the way that either type of device operates, and it is important for you to have a grasp of 
these differences when you are configuring the system. 

How LIUs Work 
Load Interface Unit is a generic term, used to describe a range of DALI devices, used to control 
different types of load. These include lamp controllers such as ballasts, dimmers, and converters 
(such as the DIGIDIM 1-10V converter), but can also include other types of device controlling almost 
any type of load. As you are probably aware, there are a number of DIGIDIM LIUs available, but the 
system is also designed to operate with any DALI compatible LIU, from any manufacturer. 
  
LIUs are not simply passive receivers of commands. They can generate their own system traffic in 
response to a query from a controller. 
  
However, from a system configuration perspective, it is convenient to think of LIUs as the recipients of 
commands issued by a controller. These commands can be of two types: 
  

1. Direct Level Commands. These (including On and Off) simply instruct the controller to bring 
the load to a certain output level, or to raise or lower the existing level by a certain amount. 

2. Scene Commands. These instruct the LIU to change the load level to a predefined Scene 
level. Many LIUs are capable of storing Scenes. These can usually be set in the range 
between 1 and 100% of the available output level. On receiving a Scene command, the LIU 
will adjust the load output to the level that it has stored for that particular Scene (see How 
Scenes Work for more details on the use of Scenes). 

Note that the system traffic can also include configuration commands, but these are generated 
automatically by DIGIDIM Toolbox and the controllers in response to the changes that you 
make. 

LIU Configuration Settings 
LIUs store a number of settings which can be adjusted using DIGIDIM Toolbox. These include details 
of group membership and specific settings (such as Maximum, Minimum and Scene levels) that relate 
to the type of load that they control. For information on the different types of setting and how to adjust 
them, see the topic entitled "Configuring Load Interface Units". 
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How Controllers Work 
In a DIGIDIM system, Controllers are devices that generate control messages that are passed along 
the system data cable to the LIUs. These include button, slider, rotary, and IR remote controllers, 
which provide the user with manual control of the system, and also the DIGIDIM MultiSensor, which 
can provide automatic control of the system. 

Controller Configuration Settings 
DIGIDIM Controllers are highly configurable, and DIGIDIM Toolbox can be used to adjust all aspects 
of their operation. This is possible because although, like the LIUs, each DIGIDIM Controller 
represents a single node on the system, they are each composed of a series of subdevices 
corresponding to each control input device. Each of these subdevices can be configured 
independently of the others. 
  
The number of subdevices (and the configuration settings available) for a particular Controller 
depends on its particular function. However, all controllers fitted with an IR Receiver provide a full set 
of subdevices that correspond to the buttons on the DIGIDIM IR Remote control unit. For instance, 
the DIGIDIM Toolbox screen shot shown below shows the subdevices provided with a 8 button 
modular controller. These include one subdevice for each button, and one for each IR Remote button. 
  

 
 
Note that each subdevice is associated with a particular command. For instance, in this configuration, 
buttons 1-7 will send corresponding Scene Recall commands when pressed. If button 0 is pressed, an 
Off command will be generated. In DIGIDIM Toolbox, each of the subdevices can be configured so 
that it will send any of the full range of DIGIDIM commands. 
 
In addition, the commands sent from each subdevice can use any of three different addressing 
methods: 
  

1. Broadcasting to the entire system. 
2. Specifying a particular device address. 
3. Sending the command to a Group of devices. 

The ability to choose from a wide range of different commands, combined with the ability to address 
them specifically, allows DIGIDIM systems to be configured in many different ways. 

See also: 

• Online and Offline Modes 
• How System Messages are Addressed 
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• Virtual, Physical and User Interface Devices 
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  Inserting a New Device 
 

     
Devices can be inserted at any time using the device toolbars (or Insert menu). The Insert 
commands work in both Online and Offline modes, but there are differences in the way that 
their system status is set as they are created. 

Online or Offline? 
In Offline mode, the ability to add devices will allow you to build a simulation of the system that is to 
be configured, without any need for access to the actual hardware. You can add any kind of DIGIDIM 
device, and experiment with their configurations until the simulated system is working exactly as 
required. This simulated system can then be saved to disk, and later merged with the actual system, 
when all the simulated settings will be transferred to the actual system. 
  
In Online mode, adding devices will allow you to introduce virtual devices to the system. Virtual 
devices can be used to try out the effect of adding an additional device, for remote control purposes, 
or to help you diagnose system problems during the configuration process. 

Virtual or Physical? 
When a device is added to a system its status is automatically set as either Virtual or Physical, 
depending on the operating mode. In Offline mode, all devices added are set as Physical. In Online 
mode, all devices that are added are set as Virtual. 
  
If, at a later stage, you wish to change the device's status, this can be done within the Device 
Configuration Dialogue. 
  
Note that the status of matched Physical devices cannot be changed in Online mode. 
For more on the differences between Virtual and Physical devices see "Virtual, Physical and User 
Interface Devices". 

Inserting Devices 
DIGIDIM Toolbox provides two methods that can be used to insert a device. You can simply click on 
the appropriate device icon in the Device Toolbars, or select a new device from the Insert menus. In 
either case, the procedure is similar. The explanation here is limited to the Toolbar option, because 
this is the most direct method to use. 
To add a new Device to the system: 

1. To add the device to a specific group, select the appropriate group in the Groups Layout 
window (if no group is selected, the device will be added to the Ungrouped Devices section). 

2. In the device palette toolbar, click on the icon for the type of device you wish to add. 
 

 
 

 

3. The new device will appear in the Groups Layout window, nested in the appropriate group. 
 
The new device will be assigned the next available short address and is provided with a 
default name. Its status will be set according to the current operating mode (see above). 
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See also: 

• Removing Devices 
• Renaming Device 
• Configuring Devices 
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Removing Devices 

 

     
There are three methods of removing devices from a DIGIDIM Toolbox project, using either the 
Edit menu, the Toolbar or the keyboard. 
The edit menu contains a "Delete Device" item, and the function of this duplicated in the 
Toolbar and also by using the Del key on the keyboard. 
"Delete Device" is context-sensitive, and works differently, depending on whether you are 
using the Groups Layout or Devices Layout panes, and on whether the system is Online or 
Offline. The following are notes on removing Toolbox devices:  
  

• Selecting "Delete Device" while in the Devices Layout provides the only means of removing a 
device from the project completely. 

• Selecting "Delete Device" while in the Groups Layout will remove the device from the group. If 
it does not belong to any other group it will be moved to the Ungrouped Devices section. 

• It is not possible to delete an actual system device from the configuration in Online mode. If 
the device is physically present then it remains part of the system. To remove it in Online 
mode you will need to disconnect it from the DALI cable. 

• If a physical device that represents an actual system device is removed from the project in 
Offline mode, it will be restored as soon as the system detects it in Online mode. 

To remove a Device from a Group: 

1. Select Group Layout by clicking on the appropriate tab in the Device List pane. 
2. Select and highlight the group from which the device is to be removed. 
3. Click on the plus (+) sign to expand the group. 
4. Select and highlight the device to be removed. 
5. Either select Edit/Delete Device, press the Del key, or click on the   icon in the toolbar. 
6. The device will be removed from the group. 

 To remove a Device from the Project: 

1. Select Devices Layout by clicking on the appropriate tab in the Device List pane. 
2. Select and highlight the device to be removed. 
3. Either select Edit/Delete Device, press the Del key, or click on the  icon in the toolbar. 
4. The device will be removed from the project. 

  



Toolbox Help 

100 

  

  

Renaming Devices 

 

     
System Devices can be named at the time they are added.  It is also possible to rename them at any 
time using the following procedure. 
  

To rename a Device: 

1. Select the Device to be renamed in either the Groups Layout pane or Device Layout pane. 
2. Either select Edit/Rename Device or click on the device name in the tree view a second time. 

The name will be highlighted and a text cursor will appear.  

 

 

3. Type the new name for the Device and press Enter 

Names are stored only as a part of the Project file on disk, and are not stored on the DIGIDIM system. 
To make the names available when configuring a system Online, you must first restore or merge the 
system with the appropriate project file. 
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Device Configuration 

  

Device Configuration 

 

     
All DIGIDIM devices are factory supplied with a set of default settings, which provide an operational 
system as soon as the power is applied. However, there are many situations where you may need to 
make changes to these defaults. Some settings, such as group assignments, can be changed by 
manipulating the devices in the device tree. Other, more advanced, settings need to be changed by 
manipulating the device property dialogues that can be accessed from the device tree. 
  
This section of help is dedicated to explaining the use of the device property dialogues, and what can 
be done with them. 
What settings can be changed? 
The Device Configuration dialogs are context-sensitive, and make different settings available, 
depending on the type of device concerned. For controllers, the settings available include the device's 
status, the command messages that controller subdevices send, destination addresses, and the 
response of controller indicator LEDs to messages sent by other controllers. For LIUs, they include 
such things as the Fade Time and Fade Rate setting, various default levels for the lamps, and the 
levels for each of the 15 Scenes that can be set. 
Alternatives for Group and Scene Configuration 
The device property dialogues will allow you to set up both group assignments for the device and, in 
the case of LIUs, the various light levels that a lamp will produce when a particular Scene is called. 
However, there are other methods of setting these using the device tree in the main window. You may 
find these to be both more direct and more intuitive. For an explanation of how to configure Groups 
and Scenes using these methods refer to "Working with Groups" and "Working with Scenes". 
  
Topics in this section include: 

• Opening the Device Properties Dialogues 
• Configuring Load Interface Units 
• Configuring Special Purpose Load Interface Units 
• Configuring Panel Controllers 
• Configuring MultiSensors 
• DIGIDIM Input Units 
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Opening the Device Properties Dialogues 

 

     
The device property dialogs provide access to a number of advanced device settings that are 
not directly available from the menus or other interface elements. This section provides an 
overview and instructions on how to access them. For details of the effects of the specific 
settings they contain, refer to "Configuring Load Interfaces", "Configuring Panel Controllers" 
or "Configuring MultiSensors". 
Device Property Dialogue Types 
There are four different types of dialogue available, and the contents of these may vary, depending on 
the type of device they represent. 
Both LIUs and Controllers have a Properties dialogue (right-click the item in the Device Tree), which 
allows you to change setting that have an effect on the entire device: 
  

  

The Properties dialogue for a LIU (fluorescent ballast). 

  

The Properties dialogue for a controller (125 Button Panel). 
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In addition, LIUs are provided with a Scene control dialogue, which will allow you to activate individual 
Scenes and set them to precise numeric values: 
  

  

The Scene control dialogue for a LIU (ballast). 

Controllers are provided with a configuration dialogue for each of the subdevices they contain. These 
allow you to configure each subdevice individually: 
  

  

The subdevices Properties dialogue for button 1 of a 125 Button Panel. 

Accessing the Properties Dialogues 
DIGIDIM Toolbox provides a number of methods of opening the dialogues. We will cover two here: 

To access general device properties dialogues from the device Tree: 

1. In Devices Layout or Groups Layout view, right-click the device to be edited.  
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2. Select Properties from the shortcut menu. The Device Configuration dialogue will open. 

Note that you can also choose "Properties" from the Edit menu or press F4. 

To access the subdevice properties or Scene control dialogues from the Device Tree: 

1. Expand the device in the device tree by clicking on the + symbol next to its icon.  

 

 

2. Right-click on a subdevice icon (or, for an LIU, a Scene Icon). 
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3. Select Properties from the shortcut menu. The appropriate dialogue will appear. 

Note that, if the general properties dialogue is already open, you can switch to the subdevice 
or Scene control dialogue simply by clicking on a subdevice or scene in the device tree. 

Accessing the controller subdevice properties dialogue from the UIDs: 

1. In either Devices Layout or Groups Layout click the device to be edited (or the device's 
group) using the left mouse button. The UID for the device will open.  

 

 

 

2. Right-click on the UID (or the specific subdevice that you would like to edit). The appropriate 
properties dialogue will open.  
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As we have mentioned, each type of device provides a different dialogue, with an appropriate range 
of options. For an explanation of how to configure each type of device, select one of the topics below: 
  

• Configuring Load Interface Units 
• Configuring Panel Controllers 
• Configuring Sensor Modules 
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Configuring Load Interface Units 

 

     
The device properties dialogue for Load Interface Units provides access to detailed settings. 
Several of these settings can also be configured by using the Device Tree, but they are 
duplicated here to provide a single point where all of the lamps' functions can be quickly set. 

To open the LIU configuration dialogue : 

1. In the device tree, select the LIU that you want to configure. 
2. Right-click on the device, and select "Properties" from the drop down menu. 
3. The device's general properties dialogue will open: 

 
Configuration Dialogue Settings 
As you can see, the dialogue contains a number of settings that, in combination, provide control of 
almost every aspect of the LIUs operation. Here's a complete listing of the settings as they appear: 
  
Random Address 

This text box displays the device's Random Address (Long Address), which serves as a unique 
identifier for the device on the system. This is not editable, and is provided for information purposes 
only. The Random Address is generated automatically when DIGIDIM Toolbox detects the device 
when it is Online for the very first time. The Random Address is entered here by the application when a 
Physical device is matched to an actual device in Online mode. It is not required for use with Virtual 
devices. 

 
Fade Time 

The Fade Time setting determines the amount of time that a LIU will take to move from one light 
output level to another when the command that it receives sets a specific level (i.e. Recall Scene). 
However, the fade time is a dynamic setting, and it can be changed by a system command from a 
controller. In fact, many controllers (such as sliders and the bar graph displays in DIGIDIM Toolbox) 
modify the fade time as an inherent part of their operation. In most case, this means that, whatever 
value is set here will be overridden as soon as a controller is operated. The setting is provide to allow a 
default fade time to set on LIU only systems, and we recommend that, for normal installations, you 
ignore this setting and allow the controllers to determine the Fade time. 
 
If you do decide to set it here, the Fade Time list box provides a range of preset times ranging from 0 
Seconds (instantaneous response) through to 1.5 minutes. 
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Fade Rate 

The Fade Rate setting adjusts the rate that light levels will change in response to Up, Down, Step up, 
and Step Down commands. The units used are steps-per-second, and the list box provides a range of 
settings from 3 steps-per-second through to 360 steps-per-second. The fade rate is a static setting and, 
once set, cannot be adjusted by a command from a DIGIDIM controller. 

 

 
 
Exists in Groups 

This part of the dialogue has similar appearance to the "Responds to Groups" setting in the Controller 
configuration dialogue , but has a different function. It purpose is to provide you with a fast way of 
setting up the group memberships of the LIU. Checking a box for a particular group has exactly the 
same effect as copying the device to a group in the device tree view. In the example shown below, the 
LIU is a member of groups 1, 3, and 4. 

 

 
 
Status 

These checkboxes allow you to modify the status of the device within DIGIDIM Toolbox. Changing 
the setting will toggle the status between Virtual and Physical. See "Virtual, Physical and UID 
Devices" if you are unsure about what this means. 

 
Levels 

The Levels section of the dialogue allows you to set up a number of important presets levels that may 
be required for the correct operation of the Lamp. 
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• Min. Sets the minimum level that the lamp will operate at. This setting can be important for 
some types of fluorescent lamp ballast, and can have an effect on the longevity of the lamp. 
See the manufacturer's literature for more details. 

• Max. This sets the maximum level that the lamp will be operated at. 
• System Failure. This sets the level that the lamp will operate if the DIGIDIM system fails. 
• Power On. Sets the default level that the lamp will go to when power is restored after an 

interruption. 

Using the Scene Control Dialogue 
The Scene control dialogue can be opened by first expanding an LIU in the device tree, so that you 
can see the Scenes associated with it. 
 

 
  
If the general properties dialogue is open, simply click on a Scene, otherwise select a scene and 
select "Properties" from the right mouse button context menu. 
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Scene Control Dialogue 

DIGIDIM Toolbox provides a number of different methods of setting the levels associated with 
particular scenes (see "Working with Scenes" for examples of alternatives to those described here). 
The Scene control dialogue is the only method that allows you to set Scenes using direct numeric 
values. To activate a Scene, simply uncheck the "Ignore" check box and the adjust the value to the 
level required. 
  
Note that human perception of relative light levels is very subjective, and can depend on a 
number of factors including the decor and furnishing in a particular room. This means that 
Scenes set using purely numeric values may not provide the required effect. Numeric setting 
can be a fast way of setting initial working levels, but you may need to fine-tune them using 
some of the visual methods described in the Virtual Scene Setting section. 

 
Related Topics: 

• Configuring DIGIDIM Converters 
• Configuring DIGIDIM Dimmers 
• Configuring DIGIDIM Multisensors 
• Configuring DIGIDIM Panel Controllers 
• Configuring DIGIDIM Relay Units 
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Configuring DIGIDIM Special Purpose LIUs 

  

Configuring DIGIDIM Special Purpose LIUs 

 

     
The DALI specification was originally conceived as a control system for electronic ballasts 
controlling fluorescent lamps. However, DALI can be used to control many different types of 
load, and is not limited to lighting only applications. The DIGIDIM range includes a number of 
Load Interface Units designed as controllers for a variety of different devices. This section of 
Help provides a brief description of these devices, and explains any differences in their 
configuration procedures. 
  

• 1-10V Converters 
• DIGIDIM Dimmers 
• DIGIDIM Relay Unit 
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Configuring DIGIDIM Converters 

 

     
In almost all respects, the process of configuration for a 1-10V (or other) converter is identical to the 
configuration of a standard LIU. The one exception to this is that the general properties dialogue 
contains an additional Output section. 
  

 
  
This allows you to control the polarity of the 1-10V (or other) signals emitted by the device. You can 
choose between "Sink" or "Source", and the correct setting will depend on the type of 1-10V device 
that you are trying to interface with. The default setting is "Sink", and that is appropriate for most 
Helvar manufactured devices. 
  

Related Topics: 

• DIGIDIM Converters 
• Configuring Load Interface Units 
• DIGIDIM Dimmers 
• DIGIDIM Relay Unit 
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Configuring DIGIDIM Dimmers 

 

     
The configuration process for DIGIDIM dimmers is identical to that for a standard LIU. The devices 
are represented in the Device tree with individual icon, but otherwise are provided with standard LIU 
property dialogues. See "Configuring Load Interface Units" for more details of the options available. 

Related Topics: 

• DIGIDIM Dimmers 
• DIGIDIM 1-10V converters 
• DIGIDIM Relay Units 
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Configuring DIGIDIM Relay Units 

 

     
The configuration process for relay units is similar to that of other DIGIDIM Load Interface Units. 
However there are some important differences that you should take note of: 

• A single relay unit is divided in to individual channels in Toolbox. Each channel corresponds 
to a single relay contact within the particular device. Each of these devices can be configured 
individually. 

• Each relay is capable of only two states: Closed or Open, or (if you think in terms of the 
operation of the device they control) On or Off. This means that the percentage levels 
generated by some DIGIDIM controllers have no relevance for a relay unit. The relay contact 
will close for any value greater than zero (0%). It will open again when the value returns to 
zero. See image below: 

  

 
  

Related Topics: 

• DIGIDIM Relay Units 
• Configuring Load Interface Units 
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Configuring Panel Controllers 

 

     
The device properties dialogues for panel controllers provide access to detailed settings, 
some of which are not available from elsewhere in DIGIDIM Toolbox. Each controller is 
provided with a general properties dialogue that provides access to settings that apply to the 
entire device, and an individual dialogue for each subdevice that it contains. The contents of 
these dialogues can vary, depending on the particular capabilities of the device concerned. 
The General Properties Dialogue 
The general properties dialogue contains a number of settings that are independent of individual 
subdevices. They mainly relate to the response of the controller to user inputs, either from the 
controller's subdevices, or from the IR remote control. 

To open the controller general properties dialogue : 

1. In the device tree, select the device that you want to configure. 
2. Right-click on the device, and select "Properties" from the drop down menu. 
3. The controller general properties dialogue will open: 

 
 
Here's a complete listing of the settings as they appear: 
 
Serial Number 

This text box displays the Serial Number (Long Address), which serves as a unique identifier for the 
device. This is not directly editable, and is provided for information purposes only. The serial number 
is updated when a Physical device is matched to an actual device in Online mode. It is not required for 
use with Virtual devices, but the application inserts a temporary number when the device is created. 

 
Scene Store Display 

This defines the amount of time that a button must be held down for before the second part of Scene 
Recall/Store command is activated and the current level is stored as a Scene. It can be set to from 2 to 
25 seconds and has a default setting of 10 seconds. It is not available for slide controllers. 

 
IR Address Group 

The IR address group should not be confused with DIGIDIM device groups. The IR remote is provided 
with a selector switch, which allows the signals it sends to be encoded in different ways. Fifteen 
variations are available, from 0 (off) to 9 and A to F. 
 
The IR Address Group in the configuration dialogue determines which IR encodings the controller will 
respond to. IR Address groups are used to limit the effect of an IR remote if it is used in an area where 
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a number of devices with IR sensors are located in close proximity. The default setting for IR Address 
Group is "0=OFF". 

 
Lock 

If checked this will lock the device's configuration, preventing the user from making configuration 
changes with an IR remote or panel controller. This box is checked by default, and we recommend that 
it be unchecked only if you only intend to use DIGIDIM Toolbox for the system's initial configuration. 
User configuration inputs can create configurations that are incompatible with DIGIDIM Toolbox 
operation. 

 
Disable IR 

When this box is checked, the MultiSensor will ignore any signals that it receives from an IR Remote 
control unit. 

 
IR First Modifier Destination 

This setting controls the destination of messages generated when the IR remote control unit is used for 
Scene Modification. This is a secondary mode of operation for the IR Remote, where the Up/Down 
keys are pressed in combination with a number key to modify the light level in one of four consecutive 
groups (or short addresses). 
 
The number set as the IR First Modifier Destination is the first of a set of four consecutive groups or 
short addresses that will be controlled in this mode. The default setting for this is group 1. This means 
that holding down the 1 button whilst using the up/down modifier keys will adjust the level of lamps in 
group 1, holding down the 2 key will adjust the lamps in group 2, and so on up to group 4. Setting the 
IR First Modifier Destination to Group 2 will cause these keys to control groups 2 to 5. Setting it to 6 
will control groups 6 to 9. 
 
You can also specify a short address as the IR First Modifier Destination. This will cause the level 
commands to be sent to four consecutive short addresses, starting with the number specified. 

 
Note that the IR First Modifier Destination is a global setting for the entire device, and is not 
influenced by individual destination settings for standard IR subdevices (see below for details 
of how to change these). 
 
Status 

These checkboxes allows you to modify the status of the device within DIGIDIM Toolbox. Changing 
the setting will toggle the status between Virtual and Physical. See "Virtual, Physical and UID 
Devices" if you are unsure about what this means. 

The Subdevice Properties Dialogues 
The Subdevice settings are applied to the particular subdevice that is selected in the Device Tree. 
These settings are used to define exactly what happens when the user operates the subdevice, 
including the command that it sends and the destination of that command. 

To open a subdevice's properties dialogue : 
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1. Expand the device in the tree by clicking on the + symbol. 
 

 
2. Select the subdevice that you want to configure. 
3. Right click and select "Properties" from the drop down menu. 
4. The controller configuration dialogue will open: 

 
  
Here's a complete listing of the settings and some of the variations you might encounter: 

  
Destination 

The Destination setting determines the addressing that is applied to messages sent by the subdevice. 
This can be either a specific short Address (1 - 63), a Group (1 - 16), or the message can be Broadcast 
to the entire system. See "How system Messages are Addressed" for a more detailed explanation of 
these settings. 

 
Note that selecting a group address for a subdevice has the same effect as moving the 
subdevice to the group in the Group Layout tree view, and the Tree will be updated 
accordingly when you exit the dialogue . Similarly, choosing either a short address or 
broadcasting will move the subdevice to the "Ungrouped Devices" section of the tree view. 
 
Command 

The command list box appears when the subdevice selected can be used to send a DIGIDIM command. 
It is used to specify the command that will be sent when the subdevice is activated. In Advanced mode, 
the list box opens to provide access to 49 different commands that can be applied. A more limited 
selection is provided in User mode. 
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For a detailed explanation of the function of each command, refer to the "Advanced Mode Command 
List" 

 
Rotary Control (Rotary Control Only) 

The Rotary Control selection box appears in place of the command list when the "Rotary" subdevice is 
selected. It can be used to manually disable or enable the rotary control. The setting here cannot be 
overridden by the use of a "Enable" or "Disable" commands sent from another controller. 

 
 
Slider Minimum Position (Slider Control Only) 

The Slider Minimum Position selection box appears in place of the command list when a "Slider" 
subdevice is selected. In addition to providing the option of manually disabling the slider control, it 
allows you to determine the function of the slider when it is moved to its minimum position. This can 
be either the minimum level set for the LIU or Off. The disable setting here cannot be overridden by 
the use of a "Enable" or "Disable" commands sent from another controller. 

 
 
Responds to Groups (in Advanced Mode only) 

This section of the dialogue (available in Advanced Mode only) determines how the subdevice will 
respond to messages received from controllers in groups that it is not a member of. Its main use is in 
installations where a LIU is able to respond to control messages from more than one group. If these 
groups are selected in the dialogue , the subdevice will follow the operation of these control messages. 
For standard control command ("Go to Scene", "Up", "Down", etc.) this means that the indicator lamps 
will remain in sync with the operation of the LIU. However, the "Responds to Groups" setting will also 
allow the controller to respond to controller-related control messages such as "Enable Panel" or 
"Disable Infra Red". 

 

 
 
In the example above, the subdevice indicator lamp will be synchronized with the operation of similar 
lamps for subdevices in groups 1, 3, and 6. 
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Note that it is important not to confuse these settings with the "Exists in Groups" settings in 
the LIU configuration dialogue . Although they look and are named similarly, they perform a 
completely different function. 
 
Fade Time 

The Fade Time is an internal function of a Load Interface Unit. The setting determines the amount of 
time that a LIU will take to move from one light output level to another when the command that it 
receives sets a specific level (i.e. Recall Scene). This can be set within the LIU's configuration 
dialogue. However, the fade time is a dynamic setting and can also be changed by a system command 
from a controller. In fact, many controllers (such as sliders and the bar graph displays in DIGIDIM 
Toolbox Software) modify the fade time as an inherent part of their operation. 
 
Applying a Fade Time setting to a subdevice will cause the subdevice to transmit a new fade time 
setting before it it sends its command. This ensures that the destination device will be set correctly 
when it applies the command. The Fade Time list box provides a range of preset times ranging from 0 
Seconds (instantaneous response) through to 1.5 minutes. An additional setting, "Ignore" will cause the 
controller not to send a Fade Time command at all. 

 

 
 
Tooltip Subdevice Description 

This text box allows you to enter a short description of the subdevice that will appear as a tooltip if the 
mouse pointer hovers over the subdevice in the UID (shown here used with a button controller). 

 

 

See Also: 

• Configuring Load Interface Units 
• Configuring Sensor Modules 
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Configuring Multisensors 

  

Configuring Multisensors 

 

     
The 312 Multisensor and 315 iDim Sense provide a combination of four different functions in a single 
package.  
Three of these functions are configured using standard configuration dialogues that are similar to the 
dialogue used for LIUs and control panels. However the fourth function, Constant Light Control, 
requires the interaction of other devices located in two distinct groups that have been reserved for the 
purpose. 

1. About DIGIDIM Multisensors 
2. Configuring the Multisensor's PIR, Touch Switch, and IR Functions. 
3. Configuring the Multisensor's Constant Light Control Functions. 
4. Setting Up Constant Light Operation - an Example 
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Configuring the Multisensor's PIR, Touch Switch, and IR Functions 

 

     
The iDim Sense and MultiSensor's device properties dialogues provide access to detailed 
settings that will allow PIR Presence Detector, Touch Switch, and IR Functions to be 
individually configured. The dialogues are similar to those provided for LIUs and Controllers, 
but contain a number of settings that are specific to the iDim Sense and MultiSensor. 

The General Properties Dialogue 

The general properties dialogue contains a number of settings that are independent of the individual 
iDim Sense and MultiSensor subdevices. They mainly relate to the response of the device to user 
inputs, either from the controller's subdevices, or from the IR remote control. They also contain a 
software override control for the iDim Sense and MultiSensor's DIL switches 

To open the controller configuration dialogue : 

1. In the device tree, select the device that you want to configure. 
2. Right-click on the device, and select "Properties " from the drop down menu. 
3. The controller general properties dialogue will open: 

 
  

Note: The 441 Occupancy Interface Detector properties  ( ) allow for configuration of device 
status, reduced DIP switch settings and Presence Detector configuration. See below: 
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Here's a complete listing of the Multisensor properties as they appear: 
  
Serial Number 

This text box displays the Serial Number (Long Address), which serves as a unique identifier for the 
device. This is not editable, and is provided for information purposes only. The serial number is 
completed here when a Physical device is matched to an actual device in Online mode. It is not 
required for use with Virtual devices. 

 
Scene Store Display 

This defines the amount of time that a IR Remote button must be held down before the current level is 
stored as a Scene. It can be set from 2 to 25 seconds and has a default setting of 10 seconds. 

 
IR Address Group 

The IR address group is a setting that relates to the operation of the IR Remote and should not be 
confused with the DIGIDIM system's device groups. The IR remote is provided with a selector switch, 
which allows the signals it sends to be encoded in different ways. Fifteen variations are available, from 
0 (off) to 9 and A to E. 
 
The IR Address Group in the configuration dialogue determines which IR encodings the controller will 
respond to. IR Address groups are used to limit the effect of an IR remote if it is used in an area where 
a number of devices with IR sensors are located in close proximity. The default setting for IR Address 
Group is "0=OFF". 

Lock 
If checked this will lock the device's configuration, preventing the user from making configuration 
changes with an IR remote or panel controller. 

 
Disable IR 

When this box is checked, the iDim Sense and MultiSensor will ignore any signals that it receives from 
an IR Remote control unit. 

 
IR First Modifier Destination 

This setting controls the destination of messages generated when the IR remote control unit is used for 
Scene Modification. This is a secondary mode of operation for the IR Remote, where the Up/Down 
keys are pressed in combination with a number key to modify the light level in one of four consecutive 
groups (or short addresses). 
 
The number set as the IR First Modifier Destination is the first of a set of four consecutive groups or 
short addresses that will be controlled in this mode. The default setting for this is group 1. This means 
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that holding down the 1 button whilst using the up/down modifier keys will adjust the level of lamps in 
group 1, holding down the 2 key will adjust the lamps in group 2, and so on up to group 4. Setting the 
IR First Modifier Destination to Group 2 will cause these keys to control groups 2 to 5. Setting it to 6 
will control groups 6 to 9. 
 
You can also specify a short address as the IR First Modifier Destination. This will cause the level 
commands to be sent to four consecutive short addresses, starting with the number specified. 

 
Note that the IR First Modifier Destination is a global setting for the entire device, and is not 
influenced by individual destination settings for standard IR subdevices (see below for details 
of how to change these). 
  

Presence Detector Settings (PIR Settings) 

This section of the dialogue allows you to set up the time settings for the PIR sensor. See 
"How the PIR Sensor Works" if you need a more detailed explanation. 
  

 
 
On Time (min) 
The On Time time determines the delay period before a PIR OFF event is triggered after a PIR ON 
event. Essentially, this is how long the lamp will stay on for after the room has been vacated, but it can 
also be used to reduce the risk that lamps will be turned off in an occupied room when there are very 
low levels of activity. 
 
Transition 
The Transition time is used to define a period in which the Transition Command will remain active 
after a PIR OFF event. At the end of the Transition Time an Off command will be sent. Transition time 
is often used in corridor applications where it improves the lifespan of fluorescent tubes which may 
otherwise cycle on and off frequently. It also ensures that the lamp will respond quickly to a new PIR 
ON event if one occurs before the Transition time ends. 
 
Exit Delay 
The Exit Delay is a time period during which PIR ON events are suppressed after an OFF command 
has been generated. Its usual use is to prevent the presence detector from switching on the lamps 
immediately after the user has switched the lamps off. This can happen if the switch is located within 
the room and the presence detector is triggered by the user as they leave the room. 

DIP Switch Settings 

The DIP switch settings are used to provide a software override of the hardware DIP switches that are 
fitted to the MultiSensor. These are usually set up during installation by physically adjusting the 
switches, but DIGIDIM Toolbox allows you to change their settings without having to remove the unit 
from the ceiling. There are four switches that can be adjusted in this way. 
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Constant Light 

When this box is checked, the constant light sensor is activated. Note: Unused with 441 Module 
Interface Detector 

 
Remote Control 

When this box is checked, the IR remote sensor is activated. Note: Unused with 441 Module 
Interface Detector 

 
Presence Sensor 

When this box is checked, the Presence Sensor (PIR sensor) is activated. 
 
Presence Test Mode 

When checked, this reduces the Exit Delay (see above) to approximately 20 seconds. This reduced time 
allows the operation of the PIR detector to be tested. 

 
Status 

These checkboxes allows you to modify the status of the device within DIGIDIM Toolbox. Changing 
the setting will toggle the status between Virtual and Physical. See "Virtual, Physical and UID 
Devices" if you are unsure about what this means. 

 

 

The Subdevice Properties Dialogues 

The Subdevice settings are applied to the particular subdevice that is selected in the Device Tree. 
These settings are used to define exactly what happens when the user operates the subdevice, 
including the command that it sends and the destination of that command. 
  
The 312 MultiSensor and iDim Sense contain 13 subdevices, including the 9 subdevices that 
correspond to the buttons on an IR remote control unit. The additional subdevices include one that 
controls the Touch Switch Input and two that correspond to On and Off events from the PIR detector. 

To open a subdevice's properties dialogue : 
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1. Expand the device in the tree by clicking on the + symbol. 
 

 
2. Select the subdevice that you want to configure. 
3. Right click and select "Properties" from the drop down menu. 
4. The controller configuration dialogue will open: 

 
  
Here's a complete listing of the settings as they may appear: 
  
Destination 

The Destination setting determines the addressing that is applied to messages sent by the subdevice. 
This can be either a specific short address (1 - 63), a Group (1 - 16), or the message can be Broadcast to 
the entire system. See "How system Messages are Addressed" for a more detailed explanation of 
these settings. 

  

 
  
Note that selecting a group address for a subdevice has the same effect as moving the 
subdevice to the group in the Group Layout tree view, and the view will be updated 
accordingly when you exit the dialogue . Similarly, choosing a short address or broadcasting 
for a grouped subdevice will move it to the "Ungrouped Devices" section of the tree view. 
  
Command 
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This setting is used to specify the command that will be sent when the subdevice is activated. In 
Advanced mode, the list box opens to provide access to up to about 50 different commands that can be 
applied. A more limited selection is provided in User mode. 

 

 
For a detailed explanation of the function of each command in the list, refer to the "Advanced Mode 
Command List" 

 
Responds to Groups 

This section of the dialogue (not available in User mode) determines how the subdevice will respond to 
messages received from controllers in groups that it is not a member of. Its main use is in installations 
where a LIU is able to respond to control messages from more than one group. If these groups are 
selected in the dialogue , the subdevice will follow the operation of these control messages. For 
standard control command ("Go to Scene", "Up", "Down", etc.) this simply means that the indicator 
lamps will remain in step with the operation of the LIU. However, the "Responds to Groups" setting 
will also allow the controller to respond to controller related control messages such as "Enable Panel" 
or "Disable Infra Red". 

 

 
  

In the example above, the subdevice indicator lamp will be synchronized with the operation of similar 
lamps for subdevices in groups 1, 3, and 6. 

Note that it is important not to confuse these settings with the "Exists in Groups" settings in 
the LIU configuration dialogue . Although they look and are named similarly, they perform a 
completely different function. 
 
Fade Time 

The Fade Time is an internal function of a Load Interface Unit. The setting determines the amount of 
time that a LIU will take to move from one light output level to another when the command that it 
receives sets a specific level (i.e. Recall Scene). 
 
Applying a Fade Time setting to a subdevice will cause the subdevice to transmit a new fade time 
setting before it sends a command. This ensures that the destination device will be set correctly when it 
applies the command. The Fade Time list box provides a range of preset times ranging from 0 Seconds 
(instantaneous response) through to 1.5 minutes. An additional setting, "Ignore" will cause the 
MultiSensor not to send a Fade Time command at all. 
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Tooltip Subdevice Description 

This text box allows you to enter a short description of the subdevice that will appear as a tooltip if the 
mouse pointer hovers over the subdevice in the UID (shown here used with a button controller). 

 

 

See Also: 

• Configuring the MultiSensor's Constant Light Control Functions 
• Configuring Load Interface Units 
• Configuring Panel Controllers 
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Configuring the Multisensor's Constant light Control Functions 

 

     
The use of the 315 iDim Sense and 312 Multisensor Constant Light Control function is 
potentially where the DIGIDIM system can provide the most energy savings. This topic 
contains an explanation of how to set up Constant Light operation within the application. 

Setting Up Constant Light Operation 

Constant light operation in DIGIDIM systems requires the use of two groups. The first of these, the 
Input Group, should contain the controllers subdevices that are to be used to set up and control 
constant light operation. The second, the Output Group, should contain the LIUs for the lamps that 
are to be subject to constant light control. 
  
The LIUs in the Output group can, of course, also exist in other groups (or be directly addressed) 
should you want to provide them with a manual override from another source. It is also possible to 
add controllers to the output group. In all three cases, the effect will be that a user input will override 
constant light operation until a new constant light level is selected by the use of a controller in the 
input group. 
  

 
  
The Multisensor is provided with a dedicated subdevice for Constant Light (OUT) , but does not have 
a corresponding Constant Light (IN) subdevice. Instead, the Constant Light (IN) function is tied to 
the PIR Off subdevice, and this determines the location of the Input Group. 
  
Setting up constant light operation is simply a matter of linking these two groups by dragging the 
Multisensor to the Input Group, and then dragging the device's Constant Light (OUT) subdevice to 
the Output Group. 
  
Note that the Multisensor's constant light function must be switched on for the Constant Light 
(OUT) subdevice to appear in the tree. This can be done either with the Multisensor's hardware 
DIP switch, or by using the Multisensor configuration dialogue . 

Setting Up Constant Light Operation - an Example 

In the following example, we will set up a simple constant light system. If you want to try it out, 
you should be able to re-create each of the steps involved using DIGIDIM Toolbox Software in 
Offline mode. Refer to "Configuring the Multisensor's Constant Light Control Functions" for a 
full explanation of Constant Light operation. 
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Note: The following instructions are also applicable to other sensor units including the 
Multisensor 312 and iDim Sense 315 models. 
  

1. Begin by starting DIGIDIM Toolbox Software, and select Use Offline from the start-up 
dialogue . The application will open with an empty system. 

2. If Groups Layout is not shown in the tree view, select the Groups Layout tab at the top of the 
tree view window. The DIGIDIM Toolbox work area should look like this:  

 

 

3. Add a 7 button controller, a ballast, and a Multisensor to the system. If no group is selected, 
the devices will be added to the Ungrouped section of the tree. 
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4. We are going to use Group 1 as our Input Group and Group 2 as our Output Group. Drag 
the button controller and the Multisensor to Group 1. Then move the ballast to Group 2.  

 

 

5. Click on the + sign next to the Multisensor entry to expand the details of the device. Notice 
that the Multisensor contains the seven standard IR subdevices, plus one for the touch switch 
input and two (on and off) for the PIR sensor. To reveal the Constant Light (OUT) subdevice, 
we need to switch on Constant Light operation using the Multisensor's configuration dialogue 
.  

 

 

6. Right-click on the Multisensor, and select Properties from the drop down menu. The general 
Configuration dialogue will open. 

7. In the section of the dialogue labelled "Dip Switch Settings", locate the Constant Light 
checkbox and switch it on. Click on OK.  

 

 

8. Note that a new reference to the Multisensor will appear in the Ungrouped section of the 
tree.  



Working with DIGIDIM Devices 

131 

 

 

9. Expanding the device will reveal that this contains the Constant Light (OUT) subdevice. 
Drag the subdevice to the Output Group (Group 2).  

 

 

10. Constant Light Operation is now configured for Groups 1 and 2. 

Note that Constant Light can also be enabled and disabled by setting a DIL switch on the 
Multisensor itself. If this switch is on at the time the device is first powered up, constant light 
operation will be enabled. The Constant Light check box in the Multisensor's configuration 
dialogue will reflect this when the device is discovered in Online mode, but can then be used 
as an override. 

Constant Light Scenes 

The concept behind Constant Light Scenes is similar to the idea of the standard Scenes that can be 
set up for individual Load Interface Units. A Constant Light Scene is a pre-set value for the iDim 
Sense or Multisensor's target level, which can be recalled by the user using a single button press. 
Once recalled, the iDim Sense or Multisensor will then adjust the lamps in the Output Group to try and 
match the new target level. It is important to realise that, since the iDim Sense or Multisensor controls 
the lamps, all of the LIUs in the group will have the same level. It is not possible to set up individual 
levels for individual lamps within the Output Group. 

The CL Scene Setting Procedure 

The procedure for setting scenes visually is very simple, but must be carried out in Online mode. For 
best results we recommend that it is carried out when levels of daylight are low or with the blinds 
drawn: 
  

1. Ensure that the "Constant Light" item in the Dip Switch settings (Configuration Dialogue) is 
checked. 

2. Adjust the light levels of each lamp in the Output Group to achieve the light level required. 
3. In the tree view, Right-click on the Multisensor, or a subdevice within the expanded 

Multisensor device. 
4. Select "Store as Scene" from the drop down menu. 
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Constant Light in Operation 

Once the procedure is completed, any user actions on the subdevices in the Input Group, will result 
in their commands being sent to the Multisensor, where they will be interpreted as modifications to the 
Constant light target level. For instance, Raise or Lower commands will raise or lower the target level, 
Recall Scene commands will set the target level to the level stored for the corresponding Constant 
Light Scene. The Multisensor will then compare the new target level with the level received by the 
constant light sensor. It will then issue the appropriate commands to the LIUs in the Output Group, 
adjusting the light level to match the target level. 

 See Also: 

• Configuring the Multisensor's PIR, Touch Switch, and IR Functions 
• Configuring Load Interface Units 
• Configuring Panel Controllers 
• Setting Up Constant Light Operation - an Example 
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Difference between 302 Multisensor, 312 Multisensor & 315 iDim Sense 

 

     
The DIGIDIM range of controllers include three different types of sensor, models 302, 312 and 
315, and one Occupancy Detector Interface (model 441) that allows the connection of third 
party customised occupancy sensors.  
Note that the 302 Multisensor is no longer manufactured. 
Although they are physically and functionally similar, they are designed for different 
applications and there are a number of important differences in the way that they operate. 
These have an impact on the way that they are represented and used in the DIGIDIM Toolbox. 

Similarities 

All of the DIGIDIM MultiSensor modules are compact, ceiling or wall mounted units that can provide a 
fully automated constant light control system. 
 

 
 
The MultiSensors are fitted with an infrared receiver for use with the IR Remote, an ambient light level 
sensor and a PIR (Passive Infrared) occupancy detector. They are also provided with screw terminals 
for a local wall switch which can provide manual dimming if required. 
 
The MultiSensor is designed to provide two modes of automation, which can be used in combination: 
 
Occupancy Detection 

This mode will simply switch the lamps on and off in response to triggers from the PIR sensor. The 
lamps will switch on when the room becomes occupied, but will switch off again (after a delay period) 
when the room becomes unoccupied. 

 
Constant Light Control 

A constant light sensing system’s main purpose is to save energy by providing only the amount of light 
that is required at a particular time. This means that it will vary the light output as the amount of 
ambient light varies. 

Differences 

The two variants of the MultiSensor can be identified by the colour of their indicator LEDs (302 = 

Green, 312 = Red). The iDim Sense 315 can be identified by the icon . 
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There are a number of differences in the way that they operate: 
  

• The 302 is designed to use its PIR for standalone occupancy detection. 
• The 312 and 315 is designed for use in applications where occupancy detection is required in 

large areas covered by several MultiSensors. The operation of its PIR is linked to the 
operation of the PIR sensors of other 312 MultiSensors in the area. 

• The 312 and 315 can be used in conjunction with a Philips IRT 8050 IR wall panel. 
• The 312 and 315 supports optical identification of LIUs during configuration with an IR 

Remote. 
• The 312 does not provide full “out of the box” operation, and must be initialised using the 

"Store Scene Presets" command or an IR Remote configuration command. 

PIR Linking 

From a system configuration perspective, perhaps the most significant of these differences is the 
linking of the 312, 315 and 441 Occupancy Detector Interface PIR sensors. This simply means that, if 
a PIR is triggered, all other PIRs in the same address space will be triggered. Subsequent triggers to 
any of the PIRs will reset the PIR Delay Timer for all PIRs. The effect of this is that the PIR Off event 
will only occur after the last PIR trigger has timed out. 
 
The main application of PIR linking is where the system is controlling a large area with a number of 
entry points. Triggering a PIR located at any entry point will trigger all of the PIRs in the area. 
 
There are a number of options as to how this is set up in DIGIDIM Toolbox. PIR triggering is tied to 
the the PIR ON, PIR Min and PIR Off subdevices in the device tree. These subdevices can be moved 
collectively to a group where the linking effect will be limited to other MultiSensors that exist in that 
group. 
 

 
  
Alternatively, you can leave the subdevices ungrouped, in which case PIR triggers will be broadcast 
and linked to all other 312 PIRs in the system, including those that are members of groups. However, 
if there are subsequent triggers to the PIRs in the groups, these will not be linked to ungrouped PIRs, 
or those that are members of other groups. 
  
It is not possible to link a PIR to a specific MultiSensor using its short address only. 

Using the 312 Multisensor and 315 iDim Sense UIDs 

In DIGIDIM Toolbox, the 312 and 315 are provided with different UIDs (User Interface Devices) to the 
302. The 312 UIDs include simulations of both the PIR sensor and the Touch Switch. These are 
provided to help you test the operation of your PIR Linking setup, and you will see icons for them at 
the lower edge of the UID. 
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To simulate the triggering of a PIR, simply click on the PIR icon. A red timer symbol appears, 
indicating that the PIR Delay timer is running: 
 

or  
 
If there are any other sensors in the same address space, their PIRs will be triggered simultaneously. 
Link triggering is indicated by a grey timer symbol: 
 

or  
 
The touch switch icon is operated in a similar way. If there is no PIR activation it functions as a 
standard touch switch. Clicking on it will toggle between On or Off, and clicking and holding will 
simulate the Raise/Lower operation of a touch switch. If the PIR is activated, clicking the touch switch 
will start the Exit timer. This is indicated with a green "Exit" symbol, and the PIR symbol is crossed 
out: 
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See "How the PIR Sensor Works" and "Configuring the MultiSensor's PIR, Touch Switch, and IR 
Functions" for a more information on PIR operation. 
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How the PIR Sensor Works 

 

     
The principles of operation for the Multisensor and iDim Sense PIR sensor are similar to those 
of a standard PIR sensor that would usually be used in an intruder alarm system. However, the 
design requirements for lighting control are very different from those of an intruder alarm and, 
as a consequence, there are important differences in both the physical design and software 
control of the Multisensor PIR. You may find it useful to know about these differences when 
you set up Multisensor PIR operation. 

Physical Design 

An intruder alarm system PIR is designed with the need to avoid the generation of false alarms as a 
primary requirement. This is because a false alarm can cause a considerable nuisance to the 
system's users, and repeated false alarms cause a general lack of confidence in the system as a 
whole. For this reason, these types of PIR tend to have limited sensitivity, reduced range, and operate 
with a narrow angle of view. They also usually require several trigger events before they will operate. 
  
The requirements for lighting control are almost the exact opposite. Although false triggering can be a 
nuisance, it is much less of a nuisance than not having the lights coming on at all or, perhaps worse, 
having the lights switch off whilst the room is still occupied. Consequently, the iDim Sense and 
Multisensor's PIR are both highly sensitive and omidirectional. They are designed to detect the 
smallest movement possible to reduce the possibility that the lamps will be turned off while the room 
still has occupants. The PIR has angle of view of between 60° and 85°, which provides it with a 
coverage of an area approximately 4.5 Metres diameter when mounted at standard ceiling height. 
  

 

Two Stage Off Procedure 

Despite its increased sensitivity, there is still a possibility that a person could remain still enough to 
fool the PIR into thinking that the room is unoccupied. As an additional precaution, the iDim Sense 
and Multisensor's software provide a two-stage "Off" procedure with a programmable Transition time 
(see below). This allows the lights to be dimmed for a period before they are finally switched off, 
providing some warning to the room's occupants and, usually, generating some movement that will re-
trigger the PIR. 

Dual Sensitivity 

The use of a highly sensitive PIR obviously increases the risk of false triggering. For instance, a PIR 
located opposite an open doorway could be triggered simply by people walking past, even when the 
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room is unused. This could lead to the lamps switching on and off, apparently at random times. 
  
To avoid this, the DIGIDIM Multisensor and iDim Sense use a unique dual-sensitivity system. When 
the lamps are off, the PIR operates at greatly reduced sensitivity. It requires a large movement (such 
as a person walking into the device's field of view) to trigger a PIR ON event. Once on, and during the 
transition time, the PIR operates at maximum sensitivity. This ensures that even the small movements 
made by someone sitting at a desk are sufficient to maintain the PIR in an "On" state. 

PIR Software Control 

  
The Multisensor PIR is intended to be used in a wide range of applications, and its control software is 
designed to provide a great deal of flexibility in configuration. This is achieved by presenting what are 
known as PIR events as if they were physical buttons controlled by the user. PIR events are initially 
triggered by the occupant walking into the PIR's field of view, but are then subsequently controlled by 
two timers which can be adjusted using the Multisensor's properties dialogue. 
  

 
  
In DIGIDIM Toolbox the Multisensor PIR events are presented as separate subdevices (ON and OFF 
for the 302 and ON, MIN and OFF for the 312 and 315). This allows the PIR events to be treated 
exactly as if they were buttons that the user had operated, and for the most part the PIR events can 
be configured in the same way as any other subdevice. The single exception to this is that they must 
share the same destination address, and this means that they will move together when moved 
between groups. 
  
The ability to configure the events as subdevices includes the ability to associate them with any of the 
DIGIDIM commands in the Advanced Mode command list. The default settings for both devices 
provide standard On/Minimum/Off PIR operation but these can be manipulated in to provide a number 
of nonstandard operating modes. For example, the ability to configure ON and OFF separately allows 
the PIR to be set up to provide "Off Only" operation where the lamp must be switched on by the user, 
but it will be switched off automatically after the room is vacated. 

PIR Events 

The key to effective PIR configuration is to understand the operation of the PIR events and how they 
are controlled by the PIR timer settings. The following will make this clear: 
PIR ON 
The PIR ON event is activated whenever the PIR is in the "Off" state and a person walks into the 
PIR's field of view to trigger it. The duration of the PIR ON event and the timing of the subsequent PIR 
MIN and PIR OFF events are controlled by three timers: PIR Delay, PIR Exit and PIR Transition. All of 
these can be set using the Multisensor configuration dialogue. 
  
After being triggered, the PIR will immediately send a command to the system and the PIR Delay 
timer will begi to operate. If the time set for the PIR Delay (0-85 minutes) expires without any further 
triggers, the PIR will generate a PIR MIN event. However, if the PIR is triggered again during the ON 
period, the PIR Delay timer is reset and begins counting again from 0. This ensures that the PIR ON 
event will only end if there are no subsequent triggers during a period equal to the PIR Delay time. 
  
In most cases, the command sent when the PIR ON event occurs will simply be a Scene Recall 
command (the default is Recall Scene 16), but it could be any of the commands available in the 
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Command List, including those that enable or disable aspects of other controller's operation. The 
specific command required must be configured by choosing it from the command list. 
PIR MIN  - Transition Time 
When PIR Delay time expires, a PIR MIN event is triggered. The PIR sends a Transition Command, 
and will then wait for a predefined period (20 seconds - 85 Minutes), known as the "PIR Transition 
Time", before finally generating an an Off event. 
  
One of the principle differences between the 312, 315 and 302 Multisensors is the availability of the 
PIR MIN subdevice for the 312 and 315. This allows the Transition and Off commands to be set up 
separately. In the 302 Multisensor the MIN and OFF events are combined in a single subdevice (PIR 
OFF). The Transition Command is set from the PIR Off subdevice ("Min with Store Last Level" by 
default). The 302's Off event command is set permanently to "Off" and cannot be changed with the 
Toolbox software. 
  
The length of the Transition Time can be set over a very wide range, and this reflects the range of 
applications that it can be used for. In addition to its use in general lighting situations, the Transition 
time is often used in corridor applications with fluorescent tubes. In these cases, a short PIR delay is 
used in conjunction with a long transition time, where the lamp will operate at its minimum level. Since 
the lamp is not turned off during the Transition time it will respond very quickly to a new PIR ON 
event. This will also improve the lifespan of fluorescent tubes that may otherwise be cycling on and off 
frequently. 
PIR OFF 
The PIR Off event is triggered when the transition time expires. In response, the 302 PIR simply 
sends an "Off" command. However, the 312 and 315 will send whatever command has been set for 
the PIR Off subdevice ("Go to Scene 15" by default). 

PIR OFF - Exit Time 

The Exit Time is a configurable time delay period during which PIR ON events are suppressed after a 
manually generated Off command has been received. Its purpose is to prevent the PIR from switching 
on the lamps if it detects movement immediately after the user has switched the lamps off. The use of 
the exit time can be helpful if the switch is located within the field of view of the PIR and there is a 
danger that the PIR will be triggered by the user as they leave the room. 

See Also: 

• Configuring the Multisensor's PIR, Touch Switch, and IR Functions. 
• Configuring the Multisensor's Constant Light Control Functions. 
• Setting Up Constant Light Operation - an Example 

dtb5348) 
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How Constant Light Control Works 

 

     
The use of the iDim Sense and MultiSensor's Constant Light Control function is potentially 
where the DIGIDIM system can provide the most energy savings. However, to gain these 
savings, it must be set up with care, and to do this, it is important to understand both its 
operation and its limitations. This topic contains important background information which you 
may find helpful when you set up a iDim Sense and MultiSensor for Constant Light operation. 

How Constant Light Works 

The principle behind DIGIDIM constant light control is simple, and is shown in the diagram below. 
  

 
  

1. The available light in a room is a mixture of ambient (daylight) and artificial light. 
2. The iDim Sense and MultiSensor contain a light level sensor, which measures the amount of 

light that is reflected from the surface directly below. 
3. The iDim Sense and MultiSensor are provided with a target level for the amount of light that 

the light sensor should receive. 
4. The target level can either be selected from a Constant Light scene (CL scene) that can be 

fixed, or be directly set by the user using a Up/Down modifier control. 
5. After comparing the light sensor’s level with the target level, the iDim Sense and MultiSensor 

send commands that raise or lower the output level of the lamps in an attempt to match the 
two levels. This process operates continuously, as the system attempts to maintain the light 
level close to the target level. 

The effect of this is that the lamps should only output sufficient light to maintain the desired level of 
light in the room. This means that the lamps will be operating at minimum level when the room is filled 
with sunlight. The lamp’s output will gradually increase as night falls, or the sky becomes overcast. 
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Since the lamps will only provide the amount of light that is necessary, they will use the absolute 
minimum amount of energy. 

Constant Light in Operation 

The art of designing a successful constant light control system is to position the sensor carefully and 
to set the target level within the capabilities of the lighting system. It is possible that you will have 
some control over the first of these, but if you provide the user with Up/Down modifier controls, they 
will have control over the second. 
  
Although in many cases this is desirable, it does require the user to have some awareness of how the 
system operates. As an alternative, you may choose not to provide the user with modifier controls, 
and simply allow them to choose from pre-set, constant light scenes that can be assigned to the 
scene selection buttons on a controller. In either case, you may find that you need to answer user's 
questions on the operation of the system, and it may help you if you know about its limitations. 

The Effect of Room Decor 

The amount of light that the sensor receives is highly dependent on the reflective qualities and colour 
of the surfaces in its viewing area. The sensor is very sensitive and if the qualities of the surface it is 
viewing change, the iDim Sense and MultiSensor will respond by adjusting the light output 
accordingly. 
  
For instance, if the sensor is set up over a desk made of a dark material, placing white paper 
documents on the desk top will increase the reflected light by a considerable amount. The sensor will 
"see" this as evidence of a brighter room, and will dim the lamps accordingly. If the paper is removed, 
the sensor will receive less light, and the lamps will brighten. A similar effect can occur if furnishings 
of the room are rearranged after the constant light sensor has been set up. 
  
The design of the iDim Sense and MultiSensor provide a partial answer to this in that its response to 
changes in light level is very slow. This means that the room's occupants won't see an annoying 
fluctuation of light as the reflectivity of the sensing area changes. You can also minimise the effect by 
ensuring that the iDim Sense and MultiSensor are installed in a location that is not going to be subject 
to routine changes of reflectivity in its viewing area. 
  
The use of the constant light sensor's viewing angle restrictor may help in this. 

Setting the Target Level 

The iDim Sense and MultiSensor function on a simple feedback principle, and has no means of 
knowing the capabilities of the lamps that it is controlling. This means that it is possible to set the 
target level so that the iDim Sense and MultiSensor will attempt to make the lamps produce more light 
than they are capable of. 
  
If the target level is set on a bright day, the level recorded by the light sensor may be many times the 
level that the lamps are capable of producing. Under these circumstances the iDim Sense and 
MultiSensor will simply increase the lamps output to 100% and will remain operating at that level. 
  
The solution to this is to set up the target levels with the blinds drawn, on a dull day, or at dusk. The 
aim is to ensure that the majority of light that the sensor is receiving is produced by the lamps under 
the iDim Sense and MultiSensor's control. If the system's users are to have control of the target level, 
it is important to make them aware of this. 

Setting Specific Levels 

The light level measured by the constant light sensor is relative, and can not be calibrated to 
correspond to a specific LUX level produced by the lighting system. However, if attaining specific LUX 
levels is a requirement of your installation, you can obtain an approximate setting as follows: 
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1. Place a LUX meter in the working plane within the iDim Sense and MultiSensor viewing area. 
2. Adjust the lamps until the LUX meter shows the desired value. 
3. Store the current level as a constant light scene. 

Note that, although this method will provide a good approximation of the desired level, it is 
dependent on the reflectivity of the sensor's viewing area. You may not be able to repeat the 
measurement unless you are able to exactly reproduce the conditions that existed at the time 
the setting was made. 

 See Also: 

• Configuring the MultiSensor's PIR, Touch Switch, and IR Functions 
• Configuring Load Interface Units 
• Configuring Panel Controllers 
• Setting Up Constant Light Operation - an Example 
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Setting Up Constant Light Operation - an Example 

 

     
In the following example, we will set up a simple constant light system. If you want to try it out, 
you should be able to re-create each of the steps involved using DIGIDIM Toolbox in Offline 
mode. Refer to "Configuring the Multisensor's Constant Light Control Functions" for a full 
explanation of Constant Light operation. 
  
Note: Multisensor can refer to the 302, 312 and 315 models in the following example. 
  

1. Begin by starting DIGIDIM Toolbox, and select Use Offline from the start-up dialogue . The 
application will open with an empty system. 

2. If Groups Layout is not shown in the tree view, select the Groups Layout tab at the top of the 
tree view window. The DIGIDIM Toolbox work area should look like this:  

 

 

3. Add a 7 button controller, a ballast, and a Multisensor to the system. If no group is selected, 
the devices will be added to the Ungrouped section of the tree.  
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4. We are going to use Group 1 as our Input Group and Group 2 as our Output Group. Drag 
the button controller and the Multisensor to Group 1. Then move the ballast to Group 2.  

 

 

5. Click on the + sign next to the Multisensor entry to expand the details of the device. Notice 
that the Multisensor contains the seven standard IR subdevices, plus one for the touch switch 
input and two (on and off) for the PIR sensor. To reveal the Constant Light (OUT) subdevice, 
we need to switch on Constant Light operation using the Multisensor's configuration dialogue 
.  

 

 

6. Right-click on the Multisensor, and select Properties from the drop down menu. The general 
Configuration dialogue will open. 
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7. In the section of the dialogue labelled "Dip Switch Settings", locate the Constant Light 
checkbox and switch it on. Click on OK.  

 

 

8. Note that a new reference to the Multisensor will appear in the Ungrouped section of the 
tree.  

 

 

9. Expanding the device will reveal that this contains the Constant Light (OUT) subdevice. 
Drag the subdevice to the Output Group (Group 2).  

 

 

10. Constant Light Operation is now configured for Groups 1 and 2. 

Note that Constant Light can also be enabled and disabled by setting a DIL switch on the 
Multisensor itself. If this switch is on at the time the device is first powered up, constant light 
operation will be enabled. The Constant Light check box in the Multisensor's configuration 
dialogue will reflect this when the device is discovered in Online mode, but can then be used 
as an override. 

Constant Light Scenes 

The concept behind Constant Light Scenes is similar to the idea of the standard Scenes that can be 
set up for individual Load Interface Units. A Constant Light Scene is a pre-set value for the 
Multisensor's target level, which can be recalled by the user using a single button press. Once 
recalled, the Multisensor will then adjust the lamps in the Output Group to try and match the new 
target level. It is important to realise that, since the Multisensor controls the lamps, all of the LIUs in 
the group will have the same level. It is not possible to set up individual levels for individual lamps 
within the Output Group. 



Toolbox Help 

146 

The CL Scene Setting Procedure 

The procedure for setting scenes visually is very simple, but must be carried out in Online mode. For 
best results we recommend that it is carried out when levels of daylight are low or with the blinds 
drawn: 

1. Ensure that the "Constant Light" item in the Dip Switch settings (Configuration Dialogue) is 
checked. 

2. Adjust the light levels of the lamps in the Output Group to achieve the light level required. 
3. In the tree view, Right-click on the Constant Light Input Group. 
4. Select "Store as Scene" from the drop down menu. 

 

 
5. Confirm that the scene has been stored by checking the CL Scene subdevice in the Input 

Group multisensor. The entry should simply say "=Set", with no percentage value shown 

 

 See Also: 

• Configuring the Multisensor's PIR, Touch Switch, and IR Functions 
• Configuring Load Interface Units 
• Configuring the Multisensor's Constant Light Control Functions 
• Configuring Panel Controllers 
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Configuring DIGIDIM Input Units 

 

     
440 and 444 Properties 
The 440 and 444 Input Units function by simulating the operation of a DIGIDIM panel controllers. 
Consequently, many of the configuration options shown in their property dialogue are identical to 
those of a panel controller. For most of the time you can treat the Input Units as if they were simply 
button panels, and all of the configuration procedures described elsewhere can be applied to the Input 
Units. See "Configuring Panel Controllers" for more details. 
  
However, there are two additional items that appear in the general properties dialogue for the devices 
that are specific to Input Units. These are the Product Mode and the Input Mode settings. The 440 
units make use of both settings, but the 444 only makes use of the Input Mode settings. We will cover 
both of these here: 
  

 

The Product Mode Setting (440 Only) 

In common with all DIGIDIM controllers, the 440 is supplied with a default configuration that ensures 
that it provides "out of the box" operation. However, it is also provided with two other basic 
configurations (Product Modes). These can be selected either manually, using the switch fitted to its 
front panel, or in Toolbox from the "Set Product Mode" section of its properties dialogue. 
  

 
  
The main purpose of this is to provide a simple way of setting up a basic configuration for the three 
main applications of an Input Unit. 
  
Mode 1 is a simulation of the operation of a standard 125 panel. The inputs are set up to 
behave as follows: 
  

Inputs 1-4 = Recall/Store Scene (1-4) 

Input 5 = Raise 

Input 6 = Lower 

Input 7 = Maximum 
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Input 8 = Off 

Selecting Mode 2 will reconfigure the device to provide a simulation of a 126 panel: 

Inputs 1-7 = Recall/Store Scene (1-7) 

Input 8 = Off 

 
These first two modes are intended for use when the Input unit is connected to manually operated 
push buttons. The Recall/Store Scene command will store the current level as a Scene if the input 
switch is held closed for more than the time set as the Scene Store Delay. This is not suitable for use 
with automatic devices, where latching contacts may remain closed for long period of time. 
 
For these applications Mode 3 is provided. Again, this is a simulation of a 126 panel, but this 
time with the Store Scene function removed: 
  

Inputs 1-4 = Recall Scene (1-4) 

Input 5 = Raise 

Input 6 = Lower 

Input 7 = Maximum 

Input 8 = Off 

 
The diagram below shows how the Input Unit might be wired in a simple example of the use of Mode 
3. 
  

 
  
The timer is connected so that in the Off position (NC) Input 8 is activated. When the timer switches 
On, Input 1 is activated (NO), and this will cause the Input unit to generate a single "Recall Scene 1" 
command. No further command will be generated until the timer switches Off. At that time a single 
"Off" command is generated. 

Notes 

• Mode 3 is the default setting for the Input Device when it is first powered up. 
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• Changing mode using the Product Mode selection buttons will remove any existing 
custom settings and ungroup the device. 

  

Input Mode Settings (440 & 444) 

The Input Mode settings are common to both the 444 and 440 Input Units. They are used to control 
how each input will behave when it is activated. The Input Mode section of the general Properties 
dialogue provides a setting for each input that will allow you to choose between Edge Detection or 
Button operation: 

 
 
Edge Detection 

When set for Edge Detection, each input is provided with two subdevices. The first of these, the Rising 
Edge subdevice, will generate a single command when the input is first activated. The second, the 
Falling Edge subdevice, generates a single command when the input is deactivated. Both Rising and 
Falling Edge subdevices have the effect of making whatever command is assigned to them a single-
shot command. 

 
Button Operation 

When set for button operation each input is provided with a single subdevice. This subdevice operates 
continuously whenever the input is activated. This makes it suitable for use with dual commands such 
as Scene Recall/Store or Up/Step Up. In both cases the first command is issued when the input is 
activated momentarily, and the second command after the input is activated and held for a period. 

 
To provide an example of how Input Mode is used, compare the subdevice settings for the 440 in 
Product Mode 1... 
  

 
 
with those for Product Mode 3... 
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In mode 1 all of the inputs are set to Button operation. This is a suitable setting for use when the 
inputs are connected to momentary contact switches. The commands assigned to each input 
subdevice operate continuously when the switch is closed. This setting allows the Scene Recall/Store 
commands assigned to inputs 1 to 4 to operate correctly. 
 
In Mode 3, inputs 1 to 4, 7 and 8 have been set to Edge detection. On these inputs, the same dual 
commands used in Mode 1 are applied to the Rising Edge subdevice. However, since the subdevice 
sends only one command when it is activated, the second part of the command is effectively disabled. 
For instance inputs 1-4 will send the appropriate Recall Scene command when activated, but they will 
never send a Store Scene command. This is exactly the behaviour that is required from an input 
connected to a latching switch. 
  

Using the Falling Edge Subdevices 

A second point to note about the use of edge detection is that it transforms the activation and 
deactivation of the input into two separate events. In Product Mode 3 the Falling Edge subdevices are 
not used, but they could just as easily be reconfigured to Recall a second scene, or to send an Off 
command. In the later case, a series wired, latching switch could be used to provide a simple On/Off 
function. 
  
In the example here, the first four inputs are connected to four latching switches. 
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 If each input is assigned to a group they will simulate the operation of a standard lighting switch, 
providing On/Off control of all LIUs within each group. 
 

 
  
445 Properties 

 
  

Scene Store Delay 

The Recall/Store Scene command will store the current level as a Scene if the input switch is held 
closed for more than the time (in seconds) set as the Scene Store Delay. This is not suitable for use 
with automatic devices, where latching contacts may remain closed for long period of time. 
  

Input Mode Settings (445) 

The Input Mode settings for the 445 are used to control how each input will behave when it is 
activated.  Select Edge Detection or Button operation: 
 
Edge Detection 

When set for Edge Detection, each input is provided with two subdevices. The first of these, the Rising 
Edge subdevice, will generate a single command when the input is first activated. The second, the 
Falling Edge subdevice, generates a single command when the input is deactivated. Both Rising and 
Falling Edge subdevices have the effect of making whatever command is assigned to them a single-
shot command. 
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Button Operation 

When set for button operation each input is provided with a single subdevice. This subdevice operates 
continuously whenever the input is activated. This makes it suitable for use with dual commands such 
as Scene Recall/Store or Up/Step Up. In both cases the first command is issued when the input is 
activated momentarily, and the second command after the input is activated and held for a period. 

  

Physical / Virtual 

Select if the 445 is to be treated as a virtual or physical device.  
  

 Related Topic: 

• DIGIDIM Input Units 
• Virtual, Physical and User Interface Devices 
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Command List in Advanced Mode 

 

     
When DIGIDIM Toolbox is operating in Advanced Mode, the command list box in the controller 
configuration dialogue contains the full list of commands. Not all of these are available for all 
types of subdevice. This is a full list of commands, with explanations. Note that the Simple 
Mode Command List contains fewer commands than those listed here. 
  
Scene Recall/Store (1 - 15*):  
Configures the subdevice to set the ballast to the specified Scene. If the button is held for longer than 
the Scene Store Delay time, the current level will be stored as the new Scene level.  
* Note that Scene 16 is 'Last Level' 
Tip: Use the fade time setting to adjust the speed of transition from one scene to another. 
  
Touch - Last Level: 
Configures the subdevice as a Touch Controller. Momentary pressing toggles the lamp between the 
Last level and off. Pressing and holding will cause the lamp level to ramp up or down (the direction 
alternates with each press). 
  
Touch - Max Level: 
Configures the subdevice as a Touch Controller. Momentary pressing toggles the lamp between Max 
level and off. Pressing and holding will cause the lamp level to ramp up or down (the direction 
alternates with each press). 
  
Touch - Scene 1: 
Configures the subdevice as a Touch Controller. Momentary pressing toggles the lamp between 
Scene 1 and off. Pressing and holding will cause the lamp level to ramp up or down (the direction 
alternates with each press). 
  
Touch - Scene 2: 
Configures the subdevice as a Touch Controller. Momentary pressing toggles the lamp between 
Scene 2 and off. Pressing and holding will cause the lamp level to ramp up or down (the direction 
alternates with each press). 
  
Max Level/Off: 
Configures the subdevice to act as a simple on/off toggle switch. The "On" function recalls the 
device's Maximum Level (As set in the LIU configuration Dialogue). 
  
Last Level/Off: 
Configures the subdevice to act as a simple on/off toggle switch. The "On" function recalls the 
device's Last operating level (As set in the LIU configuration Dialogue). 
  
Up/Step Up: 
This command works only if the lamp is already on: Each button push will step up the light level until 
the maximum level set is reached. If the button is held down, the level will increase at the rate defined 
in the Fade Rate setting for the LIU. 
  
Down/Step Down: 
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This command works only if the lamp is already on: Each button press will step down the light level 
until the minimum level is reached. If the button is held down, the level will reduce at the rate defined 
in the Fade Rate setting for the LIU. 
  
Up/Step Up & On: 
If the lamp is off, the first press will switch it on. Each subsequent button push will step up light level 
until the maximum level set is reached. When the button is held down, the level will increase at the 
rate defined in the Fade Rate setting for the LIU to the maximum level set in the LIU configuration. 
  
Down/Step Down & Off: 
If the lamp is on, each button push will step down the light level until the minimum level set is 
reached. The next press will switch the lamp off. When the button is held down, the level will decrease 
at the rate defined in the Fade Rate setting for the LIU to the minimum level set in the LIU 
configuration. 
  
Max Level/Up: 
Configures the subdevice to act as an On and Up switch.  
The "On" function (short press of the button) recalls the device's Maximum Level (As set in the LIU 
configuration Dialogue). 
Press and hold the button (long press) for the "Up" function.  
  
Last Level/Up: 
Configures the subdevice to act as an On and Up switch. 
The "On" function (short press of the button) recalls the device's Last operating level (As set in the 
LIU configuration Dialogue). 
Press and hold the button (long press) for the "Up" function. 
  
Scene 1/Up: 
Configures the subdevice to act as an On and Up switch. 
The "On" function (short press of the button) recalls Scene 1. 
Press and hold the button (long press) for the "Up" function. 
  
Scene 2/Up: 
Configures the subdevice to act as an On and Up switch. 
The "On" function (short press of the button) recalls Scene 2. 
Press and hold the button (long press) for the "Up" function. 
  
Off/Down 
A short press of the button will switch the lamp off. When the button is held down, the level will 
decrease at the rate defined in the Fade Rate setting for the LIU to the minimum level set in the LIU 
configuration. 
  
Not Used 
No command is sent when the subdevice is operated. Use this command to disable the subdevice, for 
instance if your system includes buttons that are not used within your configuration. 
  
Off with Store Last Level 
This stores the current operating level as the Last Level and then switches the lamp off. 
  
Min with Store Last Level 
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This stores the current operating level as the Last Level and then switches the lamp to the minimum 
level. 
  
Direct Level: 
Set the lamp to a direct level as defined in value box (0-254*). Note that value 255 = 'stop dimming'. 
See these examples of using the History Window for diagnostics for details of the DALI value 
required. 
  
Off: 
Turns the lamp off immediately, without fading. 
  
Up: 
This command works only if the lamp is already on: when the button is held down, the level will 
increase at the rate defined in the Fade Rate setting for the LIU to the maximum level set in the LIU 
configuration. 
  
Down: 
This command works only if the lamp is already on: If the button is held down, the level will reduce at 
the rate defined in the Fade Rate setting for the LIU until the minimum level set in LIU configuration is 
reached. 
  
Step Up: 
This command works only if the lamp is already on:  
Each button push will increase the light level by a single step to allow the light level to be fine tuned, 
up until maximum level set is reached. 
  
Step Down: 
This command works only if the lamp is already on:  
Each button push will decrease the light level by a single step to allow the light level to be fine tuned, 
up until minimum level set is reached. 
  
Recall Max Level: 
Set lamp level to the maximum level set in the LIU configuration. 
  
Recall Min Level: 
Set lamp level to the minimum level set in the LIU configuration. 
  
Step Down & Off: 
This command works only if the lamp is already on: Step down the light level at each button-push until 
the minimum level set in the LIU configuration is reached. A subsequent press, switches the lamp off. 
  
On & Step Up: 
If the lamp is off, the first press will switch it on. Subsequent presses will step up the light level until 
the maximum level defined in the LIU configuration is reached. 
  
Go to Scene (1 - 15*): 
Configures the subdevice to set the ballast to the specified Scene. Note that this is a simplified form of 
the "Scene Recall/Store" command. Holding the button down will not store a new Scene. 
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* Note that Scene 16 is 'Last Level' 
  
Scene 1 - 12 and Off: 
This is a toggle action. 
If the lamp is off, the first press will switch it on and select the specified Scene. 
If the lamp is on, a press will switch it off. 
  
Disable PIR Off: 
Configures the device so that the PIR Sensor can not switch the lights off. 
  
Enable PIR Off: 
Configures the device so that the PIR Sensor can switch the lights off. 
  
Disable PIR On: 
Configures the device so that the PIR Sensor can not switch the lights on. 
  
Enable PIR On: 
Configures the device so that the PIR Sensor can switch the lights on. 
  
Disable Programming (Temporary): 
Configures the device so that device configuration is locked, preventing the user from making 
configuration changes with an IR remote or panel controller. 
  
Disable Manual Controls 
Will disable all Up/Down modifier buttons on controllers within the destination range. 
  
Enable Manual Controls 
Will enable all Up/Down modifier buttons on controllers within the destination range. This command 
will not override settings made in the configuration dialogue. 
  
Disable Infra Red (Temporary) 
Will temporarily disable the IR receiver on controllers within the destination range. This is a temporary 
command which will not survive a power loss. To permanently disable the IR sensor for a controller 
use the check box in the device's configuration dialogue. After using this command, use Enable Infra 
Red to restore normal IR operation. 
  
Unrecognized Command 
This will appear for two reasons: 
- if the subdevices command is not available within the current command list;  
If you are operating in Simple mode, this may mean that the command is only available in Advanced 
mode. If you are operating in Advanced mode, this indicates a special custom command. If this is the 
case, be cautious about changing the command, since DIGIDIM Toolbox will not be able to restore it. 
  
- if Toolbox is trying to communicate with devices which were previously connected to a router 
system. 
The devices will be need to be restored to their factory settings.  For the tool to perform this operation, 
contact your Helvar representative. 
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Working with Groups 

  Working with Groups 
 

     
The use of groups is a form of addressing which allows controller commands to be directed to 
number of Load Interface Units simultaneously. Up to 16 Groups can be defined and this 
provides a great deal of flexibility in the ways that DIGIDIM systems can be configured. 
DIGIDIM Toolbox provides a full range of tools for setting up and manipulating groups, and 
this section of DIGIDIM Toolbox help explains how to use them. 
  
The topics in this section include: 
  

• How Groups Work 
• Grouping Examples 
• Using the Groups Layout Window 
• Using Cut, Copy and Paste 
• Renaming Groups  
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  How Groups Work 
 

     
A DIGIDIM system spread out over a wide area may need to support complex interactions 
between the different components of the system. For instance, it may be necessary to limit the 
effect of one controller to the lamps in its immediate area, configure other controllers so that 
they control several groups of lamps, and provide direct control of specific lamps within those 
groups. All of these can be achieved by making use of the Group facility within the DIGIDIM 
system. 
  
If you have worked through the Tutorial in the "Getting Started" section you will already have seen 
that groups are easy to work with and to configure. However, there are some aspects of group 
operation that you may find confusing, particularly when you begin to assign controller subdevices to 
groups. 
  
The important points to remember are as follows: 
  

• Load Interface Units can be members of any or all of the 16 groups available. 
• Assigning a LIU to a group means that it will respond to messages addressed to that group, 

but it is still capable of receiving broadcast and short addressed messages. 
• Controller subdevices can be members of only one of the 16 groups available. However, 

subdevices from a single controller can be assigned to different groups, so, in this sense, a 
controller can be a member of several groups. 

• Assigning a controller subdevice to a group means that it will only send messages addressed 
to that group. 

See also: 

• Grouping Examples 
• Using the Groups Layout Window 
• Using Cut, Copy and Paste 
• Renaming Groups  
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  Grouping Examples 
 

     
The use of Broadcast, Short and Group addressing in combination can provide an almost 
unlimited range of configurations. The two examples below will provide a flavour for what can 
be achieved. 

Configuring Controller Subdevices 
Perhaps one of the simplest uses of Groups is to use them to direct the output of controller 
subdevices. In the following example a twin slider Controller has been set up so that each of its 
sliders will provide independent control of a group of two lamps. In DIGIDIM Toolbox a typical 
configuration may look like this: 
  

 
 
In this configuration, Slider 1 will control the lamps in Group 1 and Slider 2 will control the lamps in 
Group 2. Note that the IR selection subdevices have been left in Group 1, so input from an IR remote 
will only affect Group 1. To provide control of both groups with an IR control, a third group could be 
created containing the IR subdevices and copies of all of the ballasts. 

Using Multiple Groups 
This example shows how the use of groups allows complex interrelationships between controllers and 
LIUs to be created. Controller 4 in Group 4 is used to provide an override function. 
  



Toolbox Help 

160 

 
  
The diagram shows a simplified system containing four lamps and four controllers. The controllers 
and Load Interface Units are assigned to four groups, as follows: 
  

Group Controller Load Interface 

1 1 A 

2 2 B and C 

3 3 D 

4 4 A, B, C and D 

  
In DIGIDIM Toolbox this configuration would look like this: 
  

 
  

See also: 

• Online and Offline Modes 
• How DIGIDIM Devices Work 
• Virtual, Physical and User Interface Devices 
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  Using the Groups Layout Window 
 

     
Almost all the manipulation of groups that you will need to do can be carried out using drag 
and drop techniques in the Groups Layout Window. Most of the settings that can be applied 
here can also be made in the Device Configuration dialogues, but Groups Layout provides the 
most convenient and user friendly option, and so we will concentrate on this method of 
working here. We will also concentrate on using drag and drop techniques, but it is also 
possible to manipulate both groups and the devices within them using the Cut, Copy, Paste 
and Delete commands provided in both the Edit Menu and the Toolbar. 

The Groups Layout Window 
The Groups Layout window appears in the left-hand pane of the main application window when the 
Groups Layout tab has been selected. It shows a Windows Explorer style tree view of the system, 
divided into 16 groups, each represented by an icon, plus a single icon representing ungrouped 
devices - that is to say devices that are not assigned to any group. The Groups Layout window 
provides a simple graphical interface that allows groups to be set up and modified easily using drag 
and drop techniques. 
  

 

Expanding Groups 
When a group is populated, and contains one or more devices, a + symbol will appear next to the 
group icon. Clicking on this will expand the group and display a tree view showing icons representing 
the devices that are members of that group. 
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Expanding Devices 
Each device is also provided with a + symbol, and clicking on this will expand the device, providing 
details of it's current settings. Expanding the device reveals the basic difference between LIUs and 
controllers within DIGIDIM Toolbox. The settings listing for LIUs contains details of the levels 
associated with each Scene. See Working with Scenes for details of how to adjust the Scene 
settings. 
  

 
 
However, the controller listings contain details of each subdevice within a particular device, including 
those associated with IR Remote operation. Each of these subdevices can be assigned individually to 
a group, so it is possible for a single device to be a member of a number of groups. However, it is 
important to remember that controller subdevices, unlike LIUs, can only be a member of a single 
group. 
  

 

Moving Groups 
The contents of any particular group can be moved to another group simply by dragging the group's 
icon to its new location. 

Moving and Copying Devices 
Load Interface Units can be members of any or all of the 16 groups available, and because of this 
they can be both moved and copied between all of the groups shown in the Groups Layout window. 
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Controllers and controller subdevices, cannot be copied, but can be moved between groups. To do 
this, you can use either drag and drop techniques, or the traditional Cut, Copy and Paste commands 
that can be found in the Edit window, or the Toolbar. 
To move a device to a group: 

1. Select the device by clicking on it with the left mouse button. 
2. Click and hold down the mouse button and drag the device to its new group icon.  
3. Release the mouse and the device will move to its new group. 

To copy an LIU to a group: 

1. Select the device by clicking on it with the left mouse button. 
2. Hold down the Ctrl key, click and hold down the mouse button and drag the device to its new 

group (As you drag the device a + symbol will appear next to the device icon, indicating that a 
copy will be made). 

3. Release the mouse and a copy of the device will move to its new group. 

Note that if you try to Copy an entire group, only the LIUs that exist in the group will be copied. 
It is not possible for a controller subdevice to exist in more than one group at a time. 
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  Using Cut, Copy, Paste and Delete 
 

     
The Edit menu contains the standard windows editing commands Cut Copy and Paste. These 
are also duplicated in the Edit Toolbar, and can be applied to groups as well as individual 
devices. They have a similar function to those that they have in other Windows applications, 
but there are limitations imposed by the nature of the DIGIDIM System. 
  
The editing commands can be found both in the Edit menu and on the application's Toolbar. 

 
They are context-sensitive, and only become available if they are appropriate to the current selection. 
For instance, controller devices and subdevices can exist only in one group, so Copy is not available 
when these items are selected. However, the rules that govern the availability of a command have 
been implemented consistently, and after using them for a while you should find them intuitive. 
 
Cut 

Moves the selected Item to the clipboard, removing it from the current system. 
 
Copy 

Copies the selected Item to the clipboard, leaving the original item unaffected (not available when the 
selected item is a Controller or Group). 

 
Paste 

Copies the Item stored in the clipboard to the current location. 
 
Delete 

Removes the selected Item (when applied to a group or a device within a group this simply moves the 
appropriate devices to the Ungrouped section - to remove a device from the system you must be in 
Device Layout view). 

 
Note that actual physical devices cannot be deleted from system in Online mode. However, 
they can be deleted in Offline mode, but will simply reappear when they are rediscovered by 
the application in Online mode. 

Using the Right Mouse Button 
The right hand mouse button provides two methods that can be used to speed up editing when 
working in the device tree. The first of these is a shortcut menu, containing the edit commands, which 
appears when you right-click on a device in the tree: 
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The right mouse button can also be used to drag a device to another group. When the button is 
released a submenu is opened, providing the choice between moving or copying the device to the 
new location: 
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Renaming Groups 

 

     
The ability to name individual groups provides you with opportunity to provide them with meaningful 
descriptions that will help you to associate them with their counterparts on the actual system. It is 
possible to rename a group at any time using the following procedure. 

To rename a Group: 

1. Select the Group to be renamed in the Groups Layout pane. 
2. Either select Edit/Rename Group or click on the group name in the tree view a second time. 

The group name will be highlighted and a text cursor will appear within it. 

 

 

3. Type the new name for the Group and press Enter. 

Names are not stored on the DIGIDIM system, only as a part of the Project file on disk. To make them 
available when configuring a system Online, you must first restore or merge the system with the 
appropriate project file.420) 
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Working with Scenes 

  Working with Scenes 
 

     
A Scene is a predefined light level, stored within the memory of the Load Interface Unit, which 
can be recalled at any time with a single command. Up to 15 scene levels can be defined for 
each LIU and they can also be used in conjunction with a number of lamps within groups to 
provide a very wide range of lighting variations, all of which can be recalled at a touch of a 
button. This section of help provides details of how Scenes work, and of how they are 
configured in DIGIDIM Toolbox. 
  
The topics in this section include: 
  

• How Scenes Work 
• Scene Setting Methods 
• Visual Scene Setting 
• Organising Scenes 

  



Toolbox Help 

170 

  

  How Scenes Work 
 

     
A Scene is a collection of different lighting level settings for a number of lamps, which can be 
recalled by a single command. 

LIU Scenes Operation 
The DIGIDIM system allows levels for up to fifteen Scenes to be defined for each LIU that exists on 
the system. These levels are stored within the LIU and can be recalled by any controller that can 
address the device. 
  

 
  
When a controller sends a "Go to Scene" message this will include the scene number and the 
address assignments that apply (Broadcast, short address or Group). When a LIU receives this 
message it will first check the address to see if it must respond. If the message is addressed 
appropriately, the LIU will check to ensure that it has a level associated with that Scene stored in its 
memory. If it has, it will adjust the lamp's light output to the level stored. If the message is not 
addressed to the device (or the particular Scene is set to ignore), the message will be ignored and the 
lamp will remain at its current level. 
  
The level for an individual Scene can be set up using an IR remote or directly from the DIGIDIM 
Toolbox. In the DIGIDIM Toolbox, several methods of setting Scenes can be used. The values can 
be entered directly into the LIU device configuration dialogue, or the level can be set up by using bar 
graph or UID, and then saved using the "Store as Scene" menu item. 

Fade Time 
The transition from the current level to the one defined in the Scene does not have to occur 
instantaneously. The LIUs configuration includes a parameter called "Fade Time", which controls how 
quickly it will change. The Fade Time is usually set by the controller immediately before it issues a 
Recall Scene command, and can be set up individually for each Scene and each controller. See 
"Configuring Panel Controllers" for more details of how to set up the Fade Time for each command. 

An Example 
For a good example of the practical use of scenes, imagine a lecture theatre that requires the use of a 
number of Scenes for an audio-visual presentation. In reality, this type of application can become 
quite complex, and involve the use of a number of lamps arranged in several groups. For simplicity, 
we will restrict ourselves to the use of three Scenes, using only four groups of lamps. In the diagram 
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below, Groups 1 and 4 represent general purpose lamps arranged around the periphery of the room. 
Groups 2 and 3 represent focus spot lamps aimed at the speaker's podium. 
  

 
  
The lamps are configured to provide three Scenes. The lecturer can recall each Scene at any time 
using a button controller mounted on the podium. In this case, three buttons have been configured to 
broadcast scene commands, and will provide appropriate lighting for the following scenarios: 
  
Scene 1. For safety purposes, all lamps are at 100% to allow the audience to enter and find their 
seats. 
Scene 2. Dimmed lights and focus spot lamps on the speaker while the lecture is in progress. 
Scene 3. When the projector is used, the spot lamps are turned off and the room lights are dimmed 
further, leaving sufficient lighting around the periphery for safety reasons. 

Scenes vs. Presets 
The concept of Scenes may, at first glance, seem to be similar to the idea of a Pre-set. There is a 
similarity, but there is also an important difference. The difference between a Scene and a Pre-set is 
simply that a Scene allows individual light levels for lamps, whereas the word Pre-set assumes that 
the levels for each lamp will be identical. DIGIDIM does not directly support presets, but the use of 
Scenes will allow you to simulate presets by setting up Scenes with identical light levels for each 
lamp. 
  

 

See also: 

• Online and Offline Modes 
• How DIGIDIM Devices Work 
• Virtual, Physical and User Interface Devices 
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Scene Setting Methods 

 

     
DIGIDIM Toolbox provides a number of ways that can be used to set up scenes, and these 
support two basic methods. The first method is to enter the respective level of scenes 
numerically, that is to say as a percentage of the maximum light level available from the 
particular lamp. This provides a means of achieving a basic setup, and can be acheive by 
either entering values into the LIU configuration dialogue or by using the "Store Scene 
Presets" command. The final configuration is best carried out using the second method. That 
is, to set the output levels for each scene visually, whilst Online at the site where the scenes 
will be used. 
  
This section of DIGIDIM Toolbox Help is mainly concerned with explaining how to set up, edit and 
manage scenes using the bar graph and Tree Views. For details of how to enter scene levels directly 
in the LIU configuration dialogue , refer to the topic entitled "Configuring Load Interface Units". For 
an explanation of how to set up controllers to invoke scenes, see the topic entitled "Configuring 
Panel Controllers". Finally, for more general information on the use of Scenes, see "How Scenes 
Work". 

To find out more about creating and modifying scenes: 

1. Virtual Scene Setting 
2. Organising Scenes 
3. Tutorial - Setting Scene Levels 
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  Virtual Scene Setting 
 

     
Numeric Scene setting can be a fast way of setting initial working values for test purposes, but 
in most cases you will need to fine-tune them on-site using the visual methods described here. 
Visual Scene Setting must be carried out Online. 

The Scene Setting Procedure 
The basic procedure for setting scenes visually is very simple, and involves only two steps: 
  

1. Adjust the light levels of each lamp to achieve the effect required. 
2. Store the levels as one of the 15 Scenes provided within each LIU. 

The first part of this can be achieved by using either the system's controllers (including an IR 
Remote), or the DIGIDIM Toolbox's bar graph display and on-screen UIDs. Once the levels are 
adjusted correctly The second part is achieved by invoking the DIGIDIM Toolbox's "Store as Scene" 
command. 

The "Store as Scene" Command 
The "Store as Scene" command is available in three places within DIGIDIM Toolbox, and can also be 
invoked in three different ways . The command is available within the Edit menu, the Device Tree, 
and the bar graph. Using the command from the bar graph will allow you to store scenes within a 
specific Load Interface Unit. However, using the Edit menu or Device Tree also provides a fast 
method of setting scenes for groups, or for the entire system. The following explanation covers these 
three cases separately. 

Storing Scenes in Individual LIU Devices 
The most basic use of "Store as Scene" is to set up Scene levels for an individual LIU device. To do 
this, simply adjust the lamp until it is providing the appropriate level of light, and then invoke the 
command using any of the following three methods: 
 
In the bar graph. 

Adjust the lamp's level by dragging its bar graph to the correct level. Then, whilst still pointing at the 
lamp's bar graph, Right-click to open the shortcut menu. Select "Store as Scene", and then select the 
appropriate scene from the drop down list. 

 

                          

 
From the Device Entry in the Tree View. 

This works in both Groups Layout and Device Layout views. Select the LIU device. Right-click to 
open the shortcut menu, select "Store as Scene", and then select the appropriate scene from the drop 
down list. 
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In the Edit Menu. 

For the "Store as Scene" command to be available, the LIU that is to store the scene must be selected in 
the tree view. 

 

 
  

Storing Scenes for Groups 
In addition to storing a scene value for a single device, it is also possible to store the current values of 
all the LIU devices within a group. This method provides a very fast method of configuring multiple 
loads with a single click. 
To store scenes within a group: 
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1. Set up the light levels for all the lamps in the group using either the system's controllers or the 
bar graph in DIGIDIM Toolbox. 

2. Ensure that the Group is selected in the tree. 
3. Choose either of the following methods to invoke "Store as Scene": 

From the Edit Menu. 
For the "Store as Scene" command to be available, the group that is to store the scene must be selected 
in the tree view. 
 

 
  

 
From the Group Entry in the Groups Layout View. 

Select the group name in Group Layout View. Right-click to open the shortcut menu, select "Store as 
Scene", and then select the appropriate scene from the drop down list. 

 
 

 

Storing Scenes for the Entire system 
You can also use "Store as Scene" to store the current values of all the LIU devices within the system. 
This method is particularly useful in situations where the lamps for the entire system can be seen from 
your location. 
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As before, set up the light levels for the lamps, but this time ensure that you have included all of the 
lamps in the system. Then choose one of the following methods to invoke "Store as Scene": 
 
From the Edit Menu. 

For the system "Store as Scene" command to work from the Edit menu, the system name must be 
selected in the tree view. To do this, you can use either Device Layout or Group Layout view. 
 

 
  

 
From the system Entry in the Device Tree. 

Select the system name in either Group Layout or Device Layout view. Right-click to open the shortcut 
menu, select "Store as Scene", and then select the appropriate scene from the drop down list. 

 

 
See Also: 

• Organising Scenes 
• Configuring Load Interface Units   
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  Organising Scenes 
 

     
As you might expect, DIGIDIM Toolbox provides several methods of manipulating scenes once 
they have been created. These allow scenes to be duplicated, modified, or removed. The use 
of copy and paste techniques can considerably reduce the time needed to set up systems with 
a large number of lamps. Scene settings can be modified by repeating the "Store as Scene" 
process for a second time. If the scene is not required at all, it can be removed by making use 
of the "Ignore" command. 

Copying and Pasting 
The copy and paste commands are available in both the Edit menu and the shortcut menus that 
appear when the right mouse button is pressed in the tree view. The Copy command will make a 
clipboard copy of the level setting for the scene or scenes selected. These settings will then be 
available when the Paste command is invoked. 
  
If a single scene is Copied, it can be Pasted to any other scene, even within the same device. If 
multiple scenes are Copied (using the shift or Ctrl key), they can be Pasted as a group to a new 
device. 
To copy a scene's settings to another scene: 

1. Select the scene that is to be copied from the expanded LIU's tree display. 
2. Either from the Edit menu, or from the right mouse button shortcut menu, select Copy 

Scene. The setting will be transferred to the clipboard. 

 
  

1. Select the scene that is to receive the copied setting. 
2. Either from the Edit menu, or from the right mouse button shortcut menu, select Paste 

Scene. The setting will be transferred to the new scene. 
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To copy multiple scene's settings to a second device: 

1. Using the shift or Ctrl keys, select the scenes that are to be copied. 
 

 
2. Either from the Edit menu, or from the right mouse button shortcut menu, select Copy. 

The scenes' settings will be transferred to the clipboard. 
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3.  
  

4. Select the device that is to receive the copied scene settings. 
5. Either from the Edit menu, or from the right mouse button shortcut menu, select Paste. 

 

 
6. The setting will be transferred to the new scene. 
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Copying Here 
Making Use of the right mouse button "Copy Here" command will allow scenes to be copied as a 
single action, and is most useful when you need to copy scene settings between devices that are 
close to each other in the tree display. 
  

1. To use the "Copy Here" command: 
2. In the expanded LIU's tree display, Right-click on the scene that is to be copied. 
3. Holding the right mouse button down, drag the scene to the target scene that is to receive the 

copied setting. 
4. Release the mouse button. 
5. Select "Copy Here" from the menu that appears. 

 

Modifying Scenes 
If a scene is configured incorrectly and you want to change its level, there are two methods that you 
can use: 
  

1. Set a new level using the bar graph or system controllers and then invoke the "Store as 
Scene" command for a second time. 

2. Open the LIU's Device Properties Dialogue and enter a new percentage value for the scene. 
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Removing Scenes 
If the scene is not required at all, it can be removed by making use of the "Ignore Scene" command. 
This is available in both the Edit menu and the shortcut menu that appears when the scene is 
selected with the right mouse button. As the name implies, the command will remove the scene 
setting and cause the LIU to revert to its default behaviour, which is to ignore any recall scene 
commands for that scene. 
  

1. To remove a scene: 
2. Select the scene in the tree view. 
3. From either the edit menu, or the right mouse button shortcut menu, select "Ignore Scene" (or 

press the DEL key). 
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DIGIDIM Devices 

  DIGIDIM Devices 
 

     
For details of the devices which can be used with DIGIDIM Toolbox, see these sections: 
  
Ballasts 
Ballast Controllers 
Blinds Controller 
Button Panels 
Converters 
Dimmers 
Input Units 
IR Receiver Panel 
LED Drivers 
Relay Units 
Remote Control Handset 
Rotary Controller 
Sensors (including Multisensors) 
Sliders 
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Ballasts 

  DIGIDIM DALI Ballasts 
 

     

 
Please check the Helvar website for the many different types of Helvar DALI ballast. 

Click the  icon in the Device Palette Toolbar to add a ballast to a Toolbox system. 
For configuration instructions, see Configuring Load Interface Units. 
  
Related Topics: 

• Configuring Load Interface Units 
• Device Palette Toolbar 

  
  

http://www.helvar.com/products
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Ballast Controllers 

  DIGIDIM Ballast Controllers 
 

     
The DIGIDIM Range includes two DALI ballast controllers: 
  
458/CTR8 8-Channel Ballast Controller Module  
The 458/CTR8 is an 8-channel digital ballast controller module, capable of controlling either 0-10V, 1-
10V, DSI, DALI broadcast or PWM loads. It has both a DALI and an S-DIM/DMX interface, and 
therefore can be fully integrated into a Digidim or an Imagine router system. 
  
474 4-Channel Ballast Controller 
The 474 is a DIN rail-mounted 4-channel ballast controller fitted with high inrush relays rated at 16 A 
per channel, which handle short-lived high peak currents during switch-on of loads. 
The outputs can be configured to match common ballast control loads including 0/1-10 V, DSI, DALI 
broadcast and PWM. The outputs can be configured independent of, or paired with relay channels; 
meaning 4 additional outputs can be utilized if required. 
  
Related Topics: 

• Configuring Load Interface Units 
• DIGIDIM Dimmers 
• DIGIDIM Relay Unit 
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8-Channel Ballast Controller Module (458/CTR8) 

 

     
The 458/CTR8 is an 8-channel digital ballast controller module, capable of controlling either 0-10V, 1-
10V, DSI, DALI broadcast or PWM loads. It has both a DALI and an S-DIM/DMX interface, and 
therefore can be fully integrated into a Digidim or an Imagine router system. It can also be used on 
the TouchPanel, or used on standalone DALI or Digidim systems. 
The module has 8 high inrush relays, rated at 16 A per channel. 
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  4-Channel Ballast Controller (474) 
 

     
The Digidim 474 is a 4-channel ballast controller fitted with high inrush relays rated at 16 A per 
channel, which handle short-lived high peak currents during switch-on of loads. 
The outputs can be configured to match common ballast control loads including 0/1-10 V, DSI, DALI 
broadcast and PWM. The outputs can be configured independent of, or paired with relay channels; 
meaning 4 additional outputs can be utilized if required. 
The 474 ballast controller can operate with either a Helvar Digidim or Imagine lighting control system. 
It is a DIN-rail mounted device for ease of installation. 

 
Related Topics: 

o DALI Ballasts 
o 410 DALI 1 - 10 V Converters 
o Configuring DIGIDIM Converters 
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Blinds Controller 

  

Blinds Controller (490) 

 

     
The DIGIDIM Blinds Controller is a fully DALI-compatible interface unit, which allows blinds and 
curtains to be incorporated into a DIGIDIM lighting control system. The blinds controller is a DIN-rail 
mounted unit that provides two independent control channels each with two single pole, volt-free 
contacts for switching up to 550W up/down or power direction motors from a DIGIDIM system. 
Note: This unit does not contain a DALI power supply and therefore one must be incorporated 
elsewhere in the system. 
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Button Panels 

  DIGIDIM Button Panels 
 

     
The DIGIDIM Range includes these button panel controllers: 

 

 

121 Two-Button On/Off + IR Controller 

 

122 Two-Button Up/Down + IR Controller 

 

124 Five-Button + IR Controller 

 

125 Seven-Button Up/Down + IR Controller 

 

126 Eight-Button + IR Controller 

 

131 2-Button On/Off + IR Controller 

 

132 2-Button Up/Down + IR Controller 

 

134 5-Button + IR Controller 

 

135 7-Button Up/Down + IR Controller  

 

136 8-Button +IR Controller 

 

137 4-Button +IR Controller 

  
Related Topics: 

• Configuring Panel Controllers 
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Button Panel (121): Two-Button On/Off 
with IR Receiver  

     
The 121 Button panel has two buttons (on and off) with LED indicators. The panel also features an 
infrared remote control receiver, and can receive several different selections (input signals), made via 
the Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
• Configuring Panel Controllers 
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Button Panel (122): Two-Button 
Up/Down with IR Receiver  

     
The 122 Button panel has two buttons (face up and fade down) with LED indicators. The panel also 
features an infrared remote control receiver, and can receive several different selections (input 
signals), made via the Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
• Configuring Panel Controllers 
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Button Panel (124): Five-Button (4 
Scenes + Off) with IR Receiver  

     
The 124 Button panel has five buttons (four scene-selection buttons and an off button) with LED 
indicators. The panel also features an infrared remote control receiver, and can receive several 
different selections (input signals), made via the Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
• Configuring Panel Controllers 
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Button Panel (125): Seven-Button (4 
Scenes + Fade Up/Down + Off) with IR 
Receiver 

 

     
The 125 Button panel has seven buttons (four scene-selection buttons; fade up and fade down; and 
an off button) with LED indicators. The panel also features an infrared remote control receiver, and 
can receive several different selections (input signals), made via the Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
• Configuring Panel Controllers 
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Button Panel (126): Eight-Button (7 
Scenes + Off) with IR Receiver  

     
The 126 Button panel has eight buttons (seven scene-selection buttons and an off button) with LED 
indicators. The panel also features an infrared remote control receiver, and can receive several 
different selections (input signals), made via the Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
• Configuring Panel Controllers 
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Button Panel (131): Two-Button On/Off 
with IR Receiver  

     
The 131 Button panel has two buttons (on and off) with LED indicators. The panel also features an 
infrared remote control receiver, and can receive several different selections (input signals), made via 
the Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
• Configuring Panel Controllers 
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Button Panel (132): Two-Button 
Up/Down with IR Receiver  

     
The 132 Button panel has two buttons (face up and fade down) with LED indicators. The panel also 
features an infrared remote control receiver, and can receive several different selections (input 
signals), made via the Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
• Configuring Panel Controllers 

  



DIGIDIM Devices 

197 

  

  

Button Panel (134): Five-Button (4 
Scenes + Off) with IR Receiver  

     
The 137 Button panel has four scene-selection buttons with LED indicators. The panel also features 
an infrared remote control receiver, and can receive several different selections (input signals), made 
via the Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
• Configuring Panel Controllers 
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Button Panel (135): Seven-Button (4 
Scenes + Fade Up/Down + Off) with IR 
Receiver 

 

     
The 135 Button panel has seven buttons (four scene-selection buttons; fade up and fade down; and 
an off button) with LED indicators. The panel also features an infrared remote control receiver, and 
can receive several different selections (input signals), made via the Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
• Configuring Panel Controllers 
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Button Panel (136): Eight-Button (7 
Scenes + Off) with IR Receiver  

     
The 136 Button panel has eight buttons (seven scene-selection buttons and an off button) with LED 
indicators. The panel also features an infrared remote control receiver, and can receive several 
different selections (input signals), made via the Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
• Configuring Panel Controllers 
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Button Panel (137): Four-Button (4 
Scenes) with IR Receiver  

     
The 134 Button panel has five buttons (four scene-selection buttons and an off button) with LED 
indicators. The panel also features an infrared remote control receiver, and can receive several 
different selections (input signals), made via the Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
• Configuring Panel Controllers 
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Converters 

  

DIGIDIM Converters 

 

     
The DIGIDIM Range includes a number of converters: 
  
DALI to 1-10V converters (410, 472, 474) 
These allow DIGIDIM systems to be integrated into existing systems fitted with ballasts that require 1-
10V analogue control inputs. 
All units are functionally similar, and the main difference between them is in the way that they are 
physically installed. 
  
410 DALI 1 - 10 V Converter  
The 410 is encased in a ballast-type housing and is designed for use within a luminaire.  Note that the 
410 is no longer manufactured. 
  
472 DALI 1 - 10 V and DSI Converter 
The 472 has a DALI system connection, a 1-10 V control output, DSI output and a switched mains 
voltage output. It operates by converting light-level commands received from the DALI system to the 
appropriate 1-10V control voltage. The control voltage is combined with mains switching to provide a 
simulation of the control signals provided by a conventional 1-10V control system.  The 472 is a DIN 
rail-mounted unit, for use in a control cabinet or other enclosure. 
  
474 4-Channel Ballast Controller 
The 474 is a DALI compatible 4-channel ballast controller. The 474 outputs can be configured to 
match common ballast control loads including 0/1-10 V, DSI, DALI-broadcast and PWM. 
The 474 is also fitted with high inrush relays (normally open) rated at 16 A per channel, which handle 
short-lived high peak currents during switch on of loads. For further information see DIGIDIM Relay 
Units. The 474 is a DIN rail-mounted units, for use in a control cabinet or other enclosure. 
Note: DIGIDIM Toolbox does not support SDIM configuration.  Therefore please ensure that the 474 
is connected using DALI connections. 
  
DALI to SDIM converter 
460 DALI-to-SDIM Converter  
The 460 is a DIN rail-mounted unit and allows DIGIDIM control of the full range of Ambience and 
Imagine dimmers (SDIM devices). 
  
DALI to DSI converter 
472 DALI 1 - 10 V and DSI Converter 
The 472 has a DALI system connection, a 1-10 V control output, DSI output and a switched mains 
voltage output. It operates by converting light-level commands received from the DALI system to the 
appropriate 1-10V control voltage. The control voltage is combined with mains switching to provide a 
simulation of the control signals provided by a conventional 1-10V control system.  The 472 is a DIN 
rail-mounted unit, for use in a control cabinet or other enclosure. 
  

Related Topics: 

• Configuring DIGIDIM Converters 
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• DIGIDIM Dimmers 
• DIGIDIM Relay Unit 
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  DALI 1 - 10 V Converter (410) 
 

     
The DALI 1-10 V Converter converts DALI signals to 1-10V / 0-10V signals, including on / off 
switching. 
  
Note: The 410 Converter is no longer manufactured. It remains in DIGIDIM Toolbox to allow 
backwards compatibility. 

 
Related Topics: 

• DALI Converters 
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  DALI-to-SDIM Converter (460) 
 

     
The DIGIDIM SDIM Converter has been designed to allow DIGIDIM control of the full range of 
Ambience and Imagine dimmers (SDIM devices). 
All load interfaces in an SDIM system are converted into DIGIDIM addresses. One SDIM Converter 
cam support up to 16 SDIM addresses, and thus for higher numbers of SDIM addresses, multiple 
converters must be used. 
The converter is also provided with a selectable, integral, 250mA DALI power supply. 

 
Related Topics: 

o DALI Dimmers 
o 410 DALI 1 - 10 V Converters 
o Configuring DIGIDIM Converters 
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  DALI 1 - 10 V and DSI Converter (472) 
 

     
The DIGIDIM 1 - 10 V Converter is for controlling electronic ballasts which comply with EN 60929 and 
ballasts which comply with the DSI standards.  
This ensures that DIGIDIM systems are compatible with and easily integrated into existing systems. 
The converter can switch a maximum of 15 Helvar electronic ballasts HFC/CHFC/sc. 
The analogue 1 - 10 V signal and the digital DSI signal can control 50 electronic ballasts. 
The unit is DIN Rail mounted. 
  

 
  
Related Topics: 

• DALI ballasts 
• 410 DALI 1 - 10 V Converters 
• Configuring DIGIDIM Converters 
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Dimmers 

  

DIGIDIM Dimmers 

 

     
Helvar's DIGIDIM range of dimmers provide dimming capabilities to a number of different types of 
lamp, in a range of applications. 
DIGIDIM Solo 16A (416S) and 25A (425S) Dimming Modules 
The 416S and 425S are DALI-compatible Load Interface Units. They are capable of dimming a single 
channel with total loads of up to 16 A and 25 A respectively. Solo dimmers are suitable for controlling 
a variety of light sources, including Incandescent Lamps, Halogen Lamps, and Cold Cathode Tubes. 

 
DIGIDIM 800 W Dimmer (450) 
Note: The DIGIDIM 800 W Dimmer product is obsolete as of 2010. However it is still included in 
DIGIDIM Toolbox to enable backward compatibility where necessary. 
  
The 800 Watt Dimmer is a transistor-based DALI compatible Load Interface Unit, designed to allow 
incandescent lamps to be incorporated into a DALI controlled lighting system. The dimmer can control 
a maximum load of up to 800 W, and can be connected to mains voltage lamps directly, or to low 
voltage lamps via an electronic transformer. The dimmer is provided with local control switch terminals 
that provide a touch dimming facility and a built-in DALI power supply. 
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The 800 Watt dimmer is DIN-rail mounted and suitable for use with electronic transformers for both 
capacitive and resistive loads. This dimmer is not suitable for conventional transformers with inductive 
loads. 
  
DIGIDIM 1000 W Universal Dimmer (452) 
The DIGIDIM 1000 Watt Universal Dimmer is a fully DALI Compatible Lamp Interface Unit for use in a 
DIGIDIM lighting control system. The dimmer is a DIN-rail mounted unit that can control a maximum 
load of 1000 W. 
  

 
 
The 452 can be used in two operating modes; either mode can be used with mains voltage lamps. 
Trailing edge mode is for use with Low voltage lamps with electronic transformers, and leading edge 
mode is for lamps with magnetic transformers, provided that the transformers are approved for 
dimming use by their manufacturers. 
  
4-Channel 2.2 A (500 W) DIN Rail Dimmer (454) 
The DIN rail-mounted DIGIDIM 454 is a 4-channel Trailing Edge Dimmer with each channel capable 
of controlling 2.2 A. It supports capacitive and resistive loads and can be connected directly to mains 
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voltage lamps, and low voltage lamps with electronic transformers. Each channel of the dimmer has 
both current and thermal protection. 
  
DIGIDIM 500 W Thyristor Dimmer (455) 
The 455 is a thyristor-based DALI compatible Load Interface Unit, designed to control both standard 
incandescent lamps and low voltage halogen lamps connected to a conventional, wire wound 
transformer. The dimmer can control a maximum load of up to 500 W but, unlike the 450, is not fitted 
with local control switch terminals. 

 
DIGIDIM 4 and 8 Channel Thyristor Dimmer Modules (458/DIM4 & 458/DIM8) 
The 458/DIM4 is a DALI compatible 4-channel digital thyristor dimmer module, capable of leading-
edge dimming of resistive and inductive loads. The module has 4 channels rated at 10 A, with a total 
current capacity of 40 A. 
  
The 458/DIM8 is a DALI compatible 8-channel digital thyristor dimmer module, capable of leading-
edge dimming of resistive and inductive loads. The module has 8 channels rated at 10 A, with a total 
current capacity of 40A. 
  
Note: DIGIDIM Toolbox does not support SDIM or DMX configuration therefore please ensure 
that the  458/DIM4 and 458/DIM8 are connected using DALI connections. 
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Related Topics: 

• Configuring DIGIDIM Dimmers 
• DIGIDIM 1-10V converters 
• DIGIDIM Relay Units 
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Solo Dimming Modules (416S and 425S) 

 

     
DIGIDIM Solo 16A (416S) and 25A (425S) Dimming Modules 
The 416S and 425S are DALI-compatible Load Interface Units. They are capable of dimming a single 
channel with total loads of up to 16 A and 25 A respectively. Solo dimmers are suitable for controlling 
a variety of light sources, including Incandescent Lamps, Halogen Lamps, and Cold Cathode Tubes. 

 
  

Related Topics: 

• DIGIDIM Input Units 
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  DIGIDIM 800 W Dimmer (450) 
 

     
The dimmer is for use with incandescent lamps and low voltage electronic transformers. It is not 
suitable for use with fluorescent ballasts or conventional transformers. The dimmer is a DIN-rail 
mounted unit that can control a maximum load of 800 Watts 
Note that the 450 Transistor Dimmer is no longer manufactured. 

 
See also: 

• DIGIDIM Dimmers 
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DIGIDIM 1000 W Universal Dimmer 
(452)  

     
The 452 DIGIDIM 1000 W Universal Dimmer is a DALI compatible Load Interface Unit for use in a 
DIGIDIM lighting control system. The dimmer is a DIN-rail mounted unit that can control a maximum 
load of 1000 Watts. It can be connected to any type of load by selecting the appropriate operating 
mode (Leading edge or Trailing edge). Either mode can be used with mains voltage lamps.  Low 
voltage lamps with electronic transformers must be used in trailing edge mode, and lamps with 
magnetic transformers must be used in leading edge mode, provided that the transformers are 
approved for dimming use by their manufacturers. 
  

 
See also: 

• DIGIDIM Dimmers 
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  Trailing Edge Dimmer (454) 
 

     
The DIN rail-mounted DIGIDIM 454 is a 4-channel Trailing Edge Dimmer with each channel capable 
of controlling 2.2 A. It supports capacitive and resistive loads and can be connected directly to mains 
voltage lamps, and low voltage lamps with electronic transformers. Each channel of the dimmer has 
both current and thermal protection. 

 
See also: 

• DIGIDIM Dimmers 
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  DIGIDIM 500 W Thyristor Dimmer (455) 
 

     
The DIGIDIM 500 Watt Thyristor Dimmer (leading edge) is a DALI compatible Load Interface Unit for 
use in a DIGIDIM lighting control system. 
The dimmer is a DIN-rail mounted unit that can control a maximum load of 500 Watts. It can be 
connected to mains voltage lamps directly, or to low voltage lamps via a wire-wound transformer. 
The dimmer has a status LED and a physical selection switch. The LED provides status and fault 
indications, and the physical selection switch is used to identify the device during system 
configuration. 

 
See also: 

• DIGIDIM Dimmers 
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  4-Channel Dimmer Module (458/DIM4) 
 

     
The 458/DIM4 is an 4-channel digital thyristor dimmer module, capable of leading-edge dimming of 
resistive and inductive loads. 
It has both a DALI and an S-DIM/DMX interface, and therefore can be fully integrated into a Digidim 
or an Imagine router system. It can also be used on the TouchPanel, or used on standalone DALI or 
Digidim systems. 

 
See also: 

• DIGIDIM Dimmers 
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  8-Channel Dimmer Module (458/DIM8) 
 

     
The 458/DIM8 is an 8-channel digital thyristor dimmer module, capable of leading-edge dimming of 
resistive and inductive loads. 
It has both a DALI and an S-DIM/DMX interface, and therefore can be fully integrated into a Digidim 
or an Imagine router system. It can also be used on the TouchPanel, or used on standalone DALI or 
Digidim systems. 

 
See also: 

• DIGIDIM Dimmers 
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Options Module (4-Channel Output Unit 
458/OPT4)  

     
The options module is a 4-channel output unit for use with the 458/DIM8 Dimmer Module and 
458/SW8 Switching Module. 

 
See also: 

• DIGIDIM Dimmers 
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  4-Channel Dimmer (804) 
 

     
The DIGIDIM 804 4-Channel Dimmer is a complete packaged dimming system ready for installation. It 
consists of a four-circuit thyristor dimmer, a seven-button pre-programmed control panel and a hand 
held remote control unit. 
The dimmer is a wall-mounted unit and has four independent circuits with a total load capacity of 10 
Amps. It is suitable for use with tungsten lamps, mains voltage tungsten halogen and transformer* fed 
low voltage tungsten halogen lamps. 
The seven-button panel has four pre-programmed scenes and off, complete with separate scene 
raise and lower buttons. The control panel comes in a range of finishes and is designed to fit a 
standard UK back box. 
The remote control is a hand held seven-button unit that can be used to control basic system 
functions such as on/off, scene selection and raising/lowering the general light level. 
Note that the 804 is no longer manufactured.  

 
See also: 

• DIGIDIM Dimmers 
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Input Units 

  

DIGIDIM Input Units 

 

     
The 440 and 444 DIGIDIM Input Units allow custom input devices to be added to a DIGIDIM 
system. They will allow any device containing volt-free contacts to be used as a control input device. 
Input units can be used to add third party switch panels to a system, to provide a DALI interface for 
custom built control panels, or to connect the system to automated switching devices such as timers 
and fire alarm system panels.  
The Digidim 445 is a very compact interface unit suitable for the conversion of 3rd party 
switches or button panels, to be compatible with a Helvar lighting control system. 
 
This section of Help provides a brief technical description of the units, and explains the configuration 
options available from Toolbox 
The 440 Input Unit 
Although they both perform a similar basic function, the 440 and 444 are designed for different 
applications, and there are a number of important differences between them. These 
differences affect both the way that the units are used, and the configuration options they 
provide. 
The 440 Input Unit provides eight control inputs to the DALI system. It is mounted in a DIN rail 
mounted casing, designed for use in a control cabinet or other type of enclosure. Its main purpose is 
to allow the DIGIDIM system to be interfaced with an automatic device such as a timer, but it can be 
used to interface the system with any equipment that is capable of providing a volt free switch contact. 
  

 
  
The 440 features double isolated inputs, which are provided with up to 3.2 kV isolation between the 
inputs and the DALI circuits within the device. It is fitted with an IR receiver for use with the DIGIDIM 
IR Remote control, an LED status indicator, and a push button switch that is used for manual 
configuration. 
  
The Input unit is provided with three pre-set configurations (Mode 1, Mode 2 and Mode 3) These 
presets can be selected manually (using a button on the device's front panel) or within Toolbox, by 
adjusting a setting in the general device properties dialogue. 
The 444 Mini Input Unit 
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The 444 Mini Input Unit provides four input and is supplied as a miniature encapsulated circuit board, 
with flying leads for the interconnections. Its small size (30 x 20 x 10 mm) makes it a simple matter to 
install the device within a standard electrical backbox. 
  

 
  
The main application for the Mini Input Unit is to provide a means of using third party switch panels in 
conjunction with a DIGIDIM system. This might be necessary, for instance, if the installation requires 
the use of lighting switches that match a specific architectural style. 
  
The 444 is designed to be as mechanically simple as possible and does not contain the IR receiver, 
LED indicator and configuration switch provided with the 440 Input Unit. Also (unlike the 440), the 
444’s inputs are not electrically isolated, and any connected switching device must be mains rated for 
safety. See the device's installation instructions for more on this. 
The 445 Switch Interface Unit with LED Tellback 
The 445 Switch Interface Unit with LED Tellback provides four switch inputs for use with volt free 
contacts, and four LED output drivers for indicator LEDs. 
Power for the unit is derived from the DALI network, so no external power supply is required. 
Connections to the unit are via screw terminals.  
The compact design means that the unit can be mounted within a 3rd party switch/button module or 
back box. 
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See also: 

• Configuring DIGIDIM Input Units 
• Configuring Panel Controllers 
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  Input Unit (440) 
 

     
The 440 Input Unit provides eight control inputs to the DALI system. It is mounted in a DIN rail 
mounted casing, designed for use in a control cabinet or other type of enclosure. Its main purpose is 
to allow the DIGIDIM system to be interfaced with an automatic device such as a timer, but it can be 
used to interface the system with any equipment that is capable of providing a volt free switch contact. 
  

 
  
The 440 features double isolated inputs, which are provided with up to 3.2 kV isolation between the 
inputs and the DALI circuits within the device. It is fitted with an IR receiver for use with the DIGIDIM 
IR Remote control, an LED status indicator, and a push button switch that is used for manual 
configuration. 
  
The Input unit is provided with three pre-set configurations (Mode 1, Mode 2 and Mode 3) These 
presets can be selected manually (using a button on the device's front panel) or within Toolbox, by 
adjusting a setting in the general device properties dialogue. 
  
Although they both perform a similar basic function, the 440 and 444 are designed for different 
applications, and there are a number of important differences between them. These 
differences affect both the way that the units are used, and the configuration options they 
provide. 
  
Related Topics: 

• About DIGIDIM Input Units 
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  Mini Input Unit (444) 
 

     
This 444 is a DALI-compatible interface, designed to allow customer-specified switches, sensors, time 
clocks or other on/off control devices to be incorporated into a DIGIDIM lighting control system. The 
mini input unit is a small, pre-wired, encapsulated printed circuit board and is suitable for inclusion into 
all standard size back boxes, together with a suitable mains-rated switch. 
  

 
  
Related Topics: 

• About DIGIDIM Input Units 
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  Switch Interface Unit (445) 
 

     
The 445 Switch Interface Unit with LED Tellback provides four switch inputs for use with volt free 
contacts, and four LED output drivers for indicator LEDs. 
Power for the unit is derived from the DALI network, so no external power supply is required. 
Connections to the unit are via screw terminals.  
The compact design means that the unit can be mounted within a 3rd party switch/button module or 
back box. 

  
Related Topics: 

• About DIGIDIM Input Units 
• 440 Input Unit 
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IR Receiver 

  Infrared Receiver Panel (170) 
 

     
The Infrared Receiver Panel (170) is part of the Digidim Modular Panel range. It features an infrared 
remote control receiver, and can receive several different selections (input signals), made via the 
Remote Control Handset (303). 

 
Modular control panels are a DALI-compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
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LED Drivers 

  DIGIDIM LED Drivers 
 

     

 
All DALI LED Drivers are supported in Toolbox. 

Click the  icon in the Device Palette Toolbar to add an LED Driver to a Toolbox system. 
For configuration instructions, see Configuring Load Interface Units. 
Ideal for meeting the stringent demands for indoor LED applications, the Helvar range of LED drivers 
is designed for quick installation and long life. The applications range from downlight, track lights and 
linear lights in office, schools, hospitals and retail environments. 
For details of Helvar's DALI LED drivers, see the Helvar website. 
  
Related Topics: 

• Configuring Load Interface Units 

  

http://www.helvar.com/products/led-drivers
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DIGIDIM Relay Units 

 

     
DIGIDIM Relay Unit (494) 
The DIGIDIM Relay Unit (494) is a DALI compatible Load Interface Unit fitted with four normally-open 
10 A volt-free relay contacts. The device can be used for a number of purposes, and can be used to 
switch both incandescent and fluorescent lamps. However, it is not limited to lighting applications and 
could be used to control an automatic blind, or be connected to the coil of a contactor and used to 
control electric motors or other high current devices. 
  

 
DIGIDIM 4 Channel Ballast Controller (474) 
The Digidim 474 is a DALI compatible 4-channel ballast controller fitted with high inrush 
relays (normally open) rated at 16 A per channel, which handle short-lived high peak currents during 
switch on of loads. 
  
The outputs can be configured to match common ballast control loads including 0/1-10 V, DSI, DALI-
broadcast and PWM. 
  
Note: DIGIDIM Toolbox does not support SDIM or DMX configuration therefore please ensure 
that the 474 is connected using DALI connections. 
458/SW8 Switching Module (458/SW8) 
The 458/SW8 is an 8-channel switching module. The module contains 8 relay channels fitted with 
high inrush relays (normally open) rated at 16 A per channel, which handle short-lived high peak 
current inrush when switching on loads. 
  
Note: DIGIDIM Toolbox does not support SDIM or DMX configuration therefore please ensure 
that the 458/SW8 is connected using DALI connections 
8 Channel Relay Unit (498) 
The Digidim 498 8-channel relay unit is fitted with high inrush specification (normally open) relays 
rated at 10 A per channel, which handle short-lived high peak inrush currents during switch on of 
loads. 
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Note: DIGIDIM Toolbox does not support SDIM or DMX configuration therefore please ensure 
that the 498 is connected using DALI connections. 
  

Related Topics: 

• Configuring DIGIDIM Relay Units 
• DIGIDIM 1-10V converters 
• DIGIDIM Dimmers 
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8-Channel Switching Module (458/SW8) 

 

     
The 458/SW8 8-channel switching module contains 8 relay channels (normally open), capable of 
switching 16A per channel. 
It uses high inrush relays to withstand short-lived high peak current inrush when switching on loads. 
It has both a DALI and an S-DIM/DMX interface, and therefore can be fully integrated into a Digidim 
or an Imagine router system. 
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  16 A Power Relay Unit (492) 
 

     
The 492 is a single channel relay unit, designed to allow control of non-DALI, non-dimmable loads. 
The 492 relay unit is packaged within a plastic enclosure that can be installed within a luminaire, 
electrical cabinet, or used as an in-line unit. 
The relay is a latching, volt-free contact, high inrush type, with a contact rating of 16 A. 

 
See also: 

• DIGIDIM Relay Units 
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  0.5 A Single Channel Relay Unit (493 
 

     
The 493 is a single channel relay unit, designed to allow interfacing with other building control and 
management systems. 
The 493 signal relay unit is in a plastic enclosure, so it can be installed within a 3rd party equipment 
enclosure, electrical cabinet, or used as an in line unit. 
The relay is a solid-state, normally open signal relay, with a contact rating of 60 VAC or VDC, at a 
maximum of 0.5 A. 
This unit must not be used to switch mains voltages. 

 
See also: 

• DIGIDIM Relay Units 
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  4-Channel Relay Unit (494) 
 

     
The DIGIDIM 494 Relay Unit is a DALI compatible interface unit, and allows non-dimmable loads to 
be incorporated into a DIGIDIM lighting control system. 
The relay unit is DIN rail mounted and can control four individually programmable relays. The relays 
are 'normally open', volt free and can switch up to 10A resistive loads. 
The relay unit is provided with a status LED, a physical selection switch and four relay state 
indicators. The status LED provides status and a fault indication, and the physical selection switch is 
used to identify the device during system configuration and also acts as a manual override. The four 
relay state indicator LEDs are illuminated when the respective relay is closed. 

 
See also: 

• DIGIDIM Dimmers 
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  8-Channel Relay Unit (498) 
 

     
The DIGIDIM 498 is an 8-channel relay unit fitted with high inrush specification 
relays. This means that the short-lived, high peak current inrush caused when switching on loads, 
such as electronic ballasts, is handled by a set of pre-make contacts which close before the main 
contacts of the relay. This allows more high inrush loads to be switched from one relay, where the 
limiting factor with standard relays was inrush current. 
The unit allows wired override input and allows relays to operate either individually (8x1), or as four 
sets of two (4x2), or as two sets of four (2x4). Relays have normally open contacts (SPST) only. 

 
See also: 

• DIGIDIM Dimmers 
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Remote Control Handset 

  Remote Control Handset (303) 
 

     
The battery-operated hand-held remote control device is used to control or programme any Digidim 
device that has an enabled infrared receiver. 
The Digidim Remote Control (303) has seven buttons which can be used to directly control basic 
device functions, such as on/off, raising and lowering of light level, and selecting from four pre-
programmed scenes. 
 

 
Contact your Helvar representative for further information. 
  
Related Topics: 

• Infrared Remote Control Receiver 

• About DIGIDIM Multisensors 
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Rotary 

  Rotary Panel Controller (100) 
 

     
The 100 Rotary Panel Controller is part of the Digidim Modular Panel range.  
It features a combined rotary fade up/down knob and push switch, and an infrared remote control 
receiver. 

 
Modular control panels are a DALI compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• DIGIDIM Button Panels 
• DIGIDIM Sliders 
• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
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DIGIDIM Sensors 

 

     
The DIGIDIM Range of Sensors includes a number of PIR and Microwave Detectors. There are also 
multisensors.  
  
PIR Detectors 
311 Ceiling PIR Detector  
The 311 is a compact, flush-mounted ceiling unit which provides energy-saving functions when used 
in a DALI system. 
  
317 High Bay PIR Absence / Presence Detector 
The 317, as part of a Helvar lighting control system, provides automatic control of lighting loads in 
buildings and interior spaces with high ceilings. 
  
318 Wall-Mounted PIR Detector (with control button) 
The 318, used in conjunction with a Helvar lighting control system, provides automatic control of 
lighting loads in individual room spaces.  As well as the PIR sensor, the 318 has a touch control 
button which allows manual override of the lighting on/off, and light level adjustment if dimmable 
lighting is being controlled. 
  
441 High Bay PIR Detector 
The 441 Occupancy Detector Interface allows connection of a customer specified occupancy sensor 
to a DIGIDIM-DALI system. The input accepts a volt free normally closed contact. The pre-wired. 
  
Configuring Sensors 
The 311, 313, 314, 317 and 318 sensors are configured using standard configuration dialogues that 
are similar to the dialogue used for LIUs and control panels. 
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Serial No 
The serial number of the unit (read-only) 
Dip Switch Settings 
Select if the unit is to be used as a sensor or in test mode. 
On Time 
Set the On Time (minutes). If the load comes on, by default it will take 20 minutes (of no movement 
detected) for the load to switch off. 
Transition Time 
Set the Transition Time (seconds). The Transition Time is the time to remain in the Transition Scene 
after timeout of the On Scene and before the PIR (Scene 13) is triggered. 
Exit Delay 
Set the Exit Delay (minutes). The Exit State is entered if either Scenes 15 or 16 are manually 
triggered i.e. a button is pressed to turn the lights off (recall Scene 15 or 16). The Exit Delay is the 
time to remain in the Exit State before motion detection resumes, therefore movement during this 
period will not turn the lights on. This allows time for a person to manually turn the lights off, then to 
leave the area without causing an immediate re-trigger of the On Scene. Note that the Exit Timeout is 
restarted automatically if motion is detected before the countdown ends. 
Status 
Make the sensor a virtual or physical device. 
  
Multisensors 
Information on DIGIDIM Multisensors is listed in a separate section. 

Related Topics: 

• Configuring Load Interface Units 
• DIGIDIM Dimmers 
• DIGIDIM Relay Units 
• Virtual, Physical and User Interface Devices 
• DIGIDIM Multisensors 
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  Ceiling PIR Detector (311) 
 

     
The 311 Ceiling PIR Detector is a compact, flush-mounted ceiling unit which provides energy-saving 
functions when used in a DALI system. 
The unit contains these sensors: 
- Passive infrared detector (PIR) 
- Infrared receiver (for 307 IR remote control handset). 
  

 
  
Related Topics: 

• DIGIDIM Multisensors 
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  Low-Profile Microwave Detector (313) 
 

     
The 313 Low Profile Microwave Detector provides occupancy detection for the automatic control of 
DALI lighting loads. 
The unit can also be controlled using the 307 IR (infrared) remote control handset. 
The 313 detects movement using its highly sensitive microwave detector. 
It works by emitting low-power microwave signals and measuring the reflections as the signals 
bounce off moving objects. 
  

 
  
Related Topics: 

• DIGIDIM Multisensors 
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  Tilting Microwave Detector (314) 
 

     
The 314 Tilting Microwave Detector provides occupancy detection for the automatic control of DALI 
lighting loads. 
The 314 detects movement using its highly sensitive microwave detector. It works by emitting low-
power microwave signals and measuring the reflections as the signals bounce off moving objects.  
The 314 has an adjustable sensor head that allows the area of detection to be optimized for each 
particular purpose. 
  

 
  
Related Topics: 

• DIGIDIM Multisensors 
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  High-Bay PIR Detector (317) 
 

     
The 317 High Bay PIR Presence / Absence Detector, as part of a Helvar lighting control system, 
provides automatic control of lighting loads in buildings and interior spaces with high ceilings. The 317 
is typically installed in warehouses and factories, and is used in other applications where mounting 
heights are too high for standard sensors. 
The detector uses a high sensitivity PIR (passive infrared) sensor in a precision dome lens, which 
enable the 317 to reliably detect movement over large areas. Vertical mounting heights up to 15 m 
can be accommodated. 
  

 
  
Related Topics: 

• DIGIDIM Multisensors 
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Wall-Mounted PIR Detector with Button 
(318)  

     
The 318 Wall Mounted PIR Presence / Absence Detector, used in conjunction with a Helvar lighting 
control system, provides automatic control of lighting loads in individual room spaces. 
Typically used in spaces such as cellular offices or small meeting rooms, the 318 is also suitable for 
other applications where a wall mounted sensor is preferred, or where the use of traditional ceiling 
mounted sensors is not possible. 
A high-quality PIR (passive infrared) sensor enables the 318 to reliably detect movement in the 
space. The detector can switch on lights when a space is occupied, and dim (if controllable lighting 
loads are installed) and switch off when the space is vacated. 
As well as the PIR sensor, the 318 has a touch control button which allows manual override of the 
lighting on/off, and light level adjustment if dimmable lighting is being controlled. 
  

 
  
Related Topics: 

• DIGIDIM Multisensors 
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Occupancy Detector Interface (441) as 
PIR Sensor  

     
The 441 Occupancy Detector Interface allows connection of a customer specified occupancy sensor 
to a DIGIDIM-DALI system. The input accepts a volt free normally closed contact. The pre-wired 
encapsulated circuit board is intended for mounting inside the wiring space of the sensor. The 441 
also includes a 12 Volt DC supply (15 mA max) to power the sensor. 
  

 
  

 
The 441 is designed to be as mechanically simple as possible and does not contain the IR receiver, 
LED indicator and configuration switch provided with the 440 Input Unit. Also (unlike the 440), the 
441’s inputs are not electrically isolated, and any connected switching device must be mains rated for 
safety. See the device's installation instructions for more on this. 
  
Related Topics: 

• About DIGIDIM Multisensors 
• About DIGIDIM Input Units 
• 440 Input Unit 
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DIGIDIM Multisensors 

 

     
These Helvar multisensors are compatible with DIGIDIM Toolbox. 
See the DIGIDIM Sensors section for details of PIR and Microwave Detectors. 
  

312 Multisensor 

The DIGIDIM 312 Multisensor is a compact unit containing the necessary sensors to provide energy 
saving functions when used in a DALI system. It contains a light sensor, a passive infrared detector 
(PIR) and an infrared receiver that allows the Multisensor to be operated by the hand held DIGIDIM 
remote controller. The PIR enables the system to detect when a room is occupied and the light sensor 
measures the level of ambient light available. The infrared receiver and DIGIDIM remote controller 
allow the room occupants to set the required light levels and to carry out basic system programming. 
The Multisensor is designed to push fit into a ceiling or luminaire housing. 
  

 

315 iDim Sense 

The iDim Sense is a luminaire-based DALI multisensor. It combines a movement detector (PIR), 
remote control receiver (IR) and photocell (CL) in one enclosure and a manual mode selector which 
allows the user to easily select one of the 6 out-of-box application modes. 

441 Occupancy Detector Interface (as PIR Sensor) 

The 441 Occupancy Detector Interface allows connection of a customer specified occupancy sensor 
to a DIGIDIM-DALI system. The input accepts a volt free normally closed contact. The pre-wired 
encapsulated circuit board is intended for mounting inside the wiring space of the sensor. The 441 
also includes a 12 Volt DC supply (15 mA max) to power the sensor. 
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The 441 is designed to be as mechanically simple as possible and does not contain the IR receiver, 
LED indicator and configuration switch provided with the 440 Input Unit. Also (unlike the 440), the 
441’s inputs are not electrically isolated, and any connected switching device must be mains rated for 
safety. See the device's installation instructions for more on this. 

Sensors 

Information on DIGIDIM Sensors (PIR and Microwave detectors) is in a separate section. 
  

Related Topics: 

• Differences between 302 Multisensor, 312 MultiSensor and 315 iDim Sense 
• How the PIR Sensor Works 
• How Constant Light Control Works 
• Configuring DIGIDIM Multisensors 
• DIGIDIM Sensors (PIR and Microwave Detectors) 
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Multisensor (312) 

 

     
The DIGIDIM 312 Multisensor is a compact unit containing the necessary sensors to provide energy 
saving functions when used in a DALI system. It contains a light sensor, a passive infrared detector 
(PIR) and an infrared receiver that allows the Multisensor to be operated by the hand held DIGIDIM 
remote controller. The PIR enables the system to detect when a room is occupied and the light sensor 
measures the level of ambient light available. The infrared receiver and DIGIDIM remote controller 
allow the room occupants to set the required light levels and to carry out basic system programming. 
The Multisensor is designed to push fit into a ceiling or luminaire housing. 
  

 
  

Related Topics: 

• DIGIDIM Multisensors 
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iDim Sense Multisensor (315) 

 

     
The iDim Sense is a luminaire-based DALI multisensor. It combines a movement detector 
(PIR), remote control receiver (IR) and photocell (CL) in one enclosure and a manual mode 
selector which allows the user to easily select one of the 6 out-of-box application modes. 
  

Related Topics: 

• About DIGIDIM Multisensors 
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Configuring Multisensors 

  

Configuring Multisensors 

 

     
The 312 Multisensor and 315 iDim Sense provide a combination of four different functions in a single 
package.  
Three of these functions are configured using standard configuration dialogues that are similar to the 
dialogue used for LIUs and control panels. However the fourth function, Constant Light Control, 
requires the interaction of other devices located in two distinct groups that have been reserved for the 
purpose. 

1. About DIGIDIM Multisensors 
2. Configuring the Multisensor's PIR, Touch Switch, and IR Functions. 
3. Configuring the Multisensor's Constant Light Control Functions. 
4. Setting Up Constant Light Operation - an Example 
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Configuring the Multisensor's Constant light Control Functions 

 

     
The use of the 315 iDim Sense and 312 Multisensor Constant Light Control function is 
potentially where the DIGIDIM system can provide the most energy savings. This topic 
contains an explanation of how to set up Constant Light operation within the application. 

Setting Up Constant Light Operation 

Constant light operation in DIGIDIM systems requires the use of two groups. The first of these, the 
Input Group, should contain the controllers subdevices that are to be used to set up and control 
constant light operation. The second, the Output Group, should contain the LIUs for the lamps that 
are to be subject to constant light control. 
  
The LIUs in the Output group can, of course, also exist in other groups (or be directly addressed) 
should you want to provide them with a manual override from another source. It is also possible to 
add controllers to the output group. In all three cases, the effect will be that a user input will override 
constant light operation until a new constant light level is selected by the use of a controller in the 
input group. 
  

 
  
The Multisensor is provided with a dedicated subdevice for Constant Light (OUT) , but does not have 
a corresponding Constant Light (IN) subdevice. Instead, the Constant Light (IN) function is tied to 
the PIR Off subdevice, and this determines the location of the Input Group. 
  
Setting up constant light operation is simply a matter of linking these two groups by dragging the 
Multisensor to the Input Group, and then dragging the device's Constant Light (OUT) subdevice to 
the Output Group. 
  
Note that the Multisensor's constant light function must be switched on for the Constant Light 
(OUT) subdevice to appear in the tree. This can be done either with the Multisensor's hardware 
DIP switch, or by using the Multisensor configuration dialogue . 

Setting Up Constant Light Operation - an Example 

In the following example, we will set up a simple constant light system. If you want to try it out, 
you should be able to re-create each of the steps involved using DIGIDIM Toolbox Software in 
Offline mode. Refer to "Configuring the Multisensor's Constant Light Control Functions" for a 
full explanation of Constant Light operation. 
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Note: The following instructions are also applicable to other sensor units including the 
Multisensor 312 and iDim Sense 315 models. 
  

1. Begin by starting DIGIDIM Toolbox Software, and select Use Offline from the start-up 
dialogue . The application will open with an empty system. 

2. If Groups Layout is not shown in the tree view, select the Groups Layout tab at the top of the 
tree view window. The DIGIDIM Toolbox work area should look like this:  

 

 

3. Add a 7 button controller, a ballast, and a Multisensor to the system. If no group is selected, 
the devices will be added to the Ungrouped section of the tree. 
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4. We are going to use Group 1 as our Input Group and Group 2 as our Output Group. Drag 
the button controller and the Multisensor to Group 1. Then move the ballast to Group 2.  

 

 

5. Click on the + sign next to the Multisensor entry to expand the details of the device. Notice 
that the Multisensor contains the seven standard IR subdevices, plus one for the touch switch 
input and two (on and off) for the PIR sensor. To reveal the Constant Light (OUT) subdevice, 
we need to switch on Constant Light operation using the Multisensor's configuration dialogue 
.  

 

 

6. Right-click on the Multisensor, and select Properties from the drop down menu. The general 
Configuration dialogue will open. 

7. In the section of the dialogue labelled "Dip Switch Settings", locate the Constant Light 
checkbox and switch it on. Click on OK.  

 

 

8. Note that a new reference to the Multisensor will appear in the Ungrouped section of the 
tree.  
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9. Expanding the device will reveal that this contains the Constant Light (OUT) subdevice. 
Drag the subdevice to the Output Group (Group 2).  

 

 

10. Constant Light Operation is now configured for Groups 1 and 2. 

Note that Constant Light can also be enabled and disabled by setting a DIL switch on the 
Multisensor itself. If this switch is on at the time the device is first powered up, constant light 
operation will be enabled. The Constant Light check box in the Multisensor's configuration 
dialogue will reflect this when the device is discovered in Online mode, but can then be used 
as an override. 

Constant Light Scenes 

The concept behind Constant Light Scenes is similar to the idea of the standard Scenes that can be 
set up for individual Load Interface Units. A Constant Light Scene is a pre-set value for the iDim 
Sense or Multisensor's target level, which can be recalled by the user using a single button press. 
Once recalled, the iDim Sense or Multisensor will then adjust the lamps in the Output Group to try and 
match the new target level. It is important to realise that, since the iDim Sense or Multisensor controls 
the lamps, all of the LIUs in the group will have the same level. It is not possible to set up individual 
levels for individual lamps within the Output Group. 

The CL Scene Setting Procedure 

The procedure for setting scenes visually is very simple, but must be carried out in Online mode. For 
best results we recommend that it is carried out when levels of daylight are low or with the blinds 
drawn: 
  

1. Ensure that the "Constant Light" item in the Dip Switch settings (Configuration Dialogue) is 
checked. 

2. Adjust the light levels of each lamp in the Output Group to achieve the light level required. 
3. In the tree view, Right-click on the Multisensor, or a subdevice within the expanded 

Multisensor device. 
4. Select "Store as Scene" from the drop down menu. 
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Constant Light in Operation 

Once the procedure is completed, any user actions on the subdevices in the Input Group, will result 
in their commands being sent to the Multisensor, where they will be interpreted as modifications to the 
Constant light target level. For instance, Raise or Lower commands will raise or lower the target level, 
Recall Scene commands will set the target level to the level stored for the corresponding Constant 
Light Scene. The Multisensor will then compare the new target level with the level received by the 
constant light sensor. It will then issue the appropriate commands to the LIUs in the Output Group, 
adjusting the light level to match the target level. 

 See Also: 
• Configuring the Multisensor's PIR, Touch Switch, and IR Functions 
• Configuring Load Interface Units 
• Configuring Panel Controllers 
• Setting Up Constant Light Operation - an Example 
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Configuring the Multisensor's PIR, Touch Switch, and IR Functions 

 

     
The iDim Sense and MultiSensor's device properties dialogues provide access to detailed 
settings that will allow PIR Presence Detector, Touch Switch, and IR Functions to be 
individually configured. The dialogues are similar to those provided for LIUs and Controllers, 
but contain a number of settings that are specific to the iDim Sense and MultiSensor. 

The General Properties Dialogue 

The general properties dialogue contains a number of settings that are independent of the individual 
iDim Sense and MultiSensor subdevices. They mainly relate to the response of the device to user 
inputs, either from the controller's subdevices, or from the IR remote control. They also contain a 
software override control for the iDim Sense and MultiSensor's DIL switches 

To open the controller configuration dialogue : 
1. In the device tree, select the device that you want to configure. 
2. Right-click on the device, and select "Properties " from the drop down menu. 
3. The controller general properties dialogue will open: 

 
  

Note: The 441 Occupancy Interface Detector properties  ( ) allow for configuration of device 
status, reduced DIP switch settings and Presence Detector configuration. See below: 
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Here's a complete listing of the Multisensor properties as they appear: 
  
Serial Number 

This text box displays the Serial Number (Long Address), which serves as a unique identifier for the 
device. This is not editable, and is provided for information purposes only. The serial number is 
completed here when a Physical device is matched to an actual device in Online mode. It is not 
required for use with Virtual devices. 

 
Scene Store Display 

This defines the amount of time that a IR Remote button must be held down before the current level is 
stored as a Scene. It can be set from 2 to 25 seconds and has a default setting of 10 seconds. 

 
IR Address Group 

The IR address group is a setting that relates to the operation of the IR Remote and should not be 
confused with the DIGIDIM system's device groups. The IR remote is provided with a selector switch, 
which allows the signals it sends to be encoded in different ways. Fifteen variations are available, from 
0 (off) to 9 and A to E. 
 
The IR Address Group in the configuration dialogue determines which IR encodings the controller will 
respond to. IR Address groups are used to limit the effect of an IR remote if it is used in an area where 
a number of devices with IR sensors are located in close proximity. The default setting for IR Address 
Group is "0=OFF". 

Lock 
If checked this will lock the device's configuration, preventing the user from making configuration 
changes with an IR remote or panel controller. 

 
Disable IR 

When this box is checked, the iDim Sense and MultiSensor will ignore any signals that it receives from 
an IR Remote control unit. 

 
IR First Modifier Destination 

This setting controls the destination of messages generated when the IR remote control unit is used for 
Scene Modification. This is a secondary mode of operation for the IR Remote, where the Up/Down 
keys are pressed in combination with a number key to modify the light level in one of four consecutive 
groups (or short addresses). 
 
The number set as the IR First Modifier Destination is the first of a set of four consecutive groups or 
short addresses that will be controlled in this mode. The default setting for this is group 1. This means 
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that holding down the 1 button whilst using the up/down modifier keys will adjust the level of lamps in 
group 1, holding down the 2 key will adjust the lamps in group 2, and so on up to group 4. Setting the 
IR First Modifier Destination to Group 2 will cause these keys to control groups 2 to 5. Setting it to 6 
will control groups 6 to 9. 
 
You can also specify a short address as the IR First Modifier Destination. This will cause the level 
commands to be sent to four consecutive short addresses, starting with the number specified. 

 
Note that the IR First Modifier Destination is a global setting for the entire device, and is not 
influenced by individual destination settings for standard IR subdevices (see below for details 
of how to change these). 
  

Presence Detector Settings (PIR Settings) 
This section of the dialogue allows you to set up the time settings for the PIR sensor. See 
"How the PIR Sensor Works" if you need a more detailed explanation. 
  

 
 
On Time (min) 
The On Time time determines the delay period before a PIR OFF event is triggered after a PIR ON 
event. Essentially, this is how long the lamp will stay on for after the room has been vacated, but it can 
also be used to reduce the risk that lamps will be turned off in an occupied room when there are very 
low levels of activity. 
 
Transition 
The Transition time is used to define a period in which the Transition Command will remain active 
after a PIR OFF event. At the end of the Transition Time an Off command will be sent. Transition time 
is often used in corridor applications where it improves the lifespan of fluorescent tubes which may 
otherwise cycle on and off frequently. It also ensures that the lamp will respond quickly to a new PIR 
ON event if one occurs before the Transition time ends. 
 
Exit Delay 
The Exit Delay is a time period during which PIR ON events are suppressed after an OFF command 
has been generated. Its usual use is to prevent the presence detector from switching on the lamps 
immediately after the user has switched the lamps off. This can happen if the switch is located within 
the room and the presence detector is triggered by the user as they leave the room. 

DIP Switch Settings 
The DIP switch settings are used to provide a software override of the hardware DIP switches that are 
fitted to the MultiSensor. These are usually set up during installation by physically adjusting the 
switches, but DIGIDIM Toolbox allows you to change their settings without having to remove the unit 
from the ceiling. There are four switches that can be adjusted in this way. 
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Constant Light 

When this box is checked, the constant light sensor is activated. Note: Unused with 441 Module 
Interface Detector 

 
Remote Control 

When this box is checked, the IR remote sensor is activated. Note: Unused with 441 Module 
Interface Detector 

 
Presence Sensor 

When this box is checked, the Presence Sensor (PIR sensor) is activated. 
 
Presence Test Mode 

When checked, this reduces the Exit Delay (see above) to approximately 20 seconds. This reduced time 
allows the operation of the PIR detector to be tested. 

 
Status 

These checkboxes allows you to modify the status of the device within DIGIDIM Toolbox. Changing 
the setting will toggle the status between Virtual and Physical. See "Virtual, Physical and UID 
Devices" if you are unsure about what this means. 

 

 

The Subdevice Properties Dialogues 

The Subdevice settings are applied to the particular subdevice that is selected in the Device Tree. 
These settings are used to define exactly what happens when the user operates the subdevice, 
including the command that it sends and the destination of that command. 
  
The 312 MultiSensor and iDim Sense contain 13 subdevices, including the 9 subdevices that 
correspond to the buttons on an IR remote control unit. The additional subdevices include one that 
controls the Touch Switch Input and two that correspond to On and Off events from the PIR detector. 

To open a subdevice's properties dialogue : 
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1. Expand the device in the tree by clicking on the + symbol. 
 

 
2. Select the subdevice that you want to configure. 
3. Right click and select "Properties" from the drop down menu. 
4. The controller configuration dialogue will open: 

 
  
Here's a complete listing of the settings as they may appear: 
  
Destination 

The Destination setting determines the addressing that is applied to messages sent by the subdevice. 
This can be either a specific short address (1 - 63), a Group (1 - 16), or the message can be Broadcast to 
the entire system. See "How system Messages are Addressed" for a more detailed explanation of 
these settings. 

  

 
  
Note that selecting a group address for a subdevice has the same effect as moving the 
subdevice to the group in the Group Layout tree view, and the view will be updated 
accordingly when you exit the dialogue . Similarly, choosing a short address or broadcasting 
for a grouped subdevice will move it to the "Ungrouped Devices" section of the tree view. 
  
Command 
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This setting is used to specify the command that will be sent when the subdevice is activated. In 
Advanced mode, the list box opens to provide access to up to about 50 different commands that can be 
applied. A more limited selection is provided in User mode. 

 

 
For a detailed explanation of the function of each command in the list, refer to the "Advanced Mode 
Command List" 

 
Responds to Groups 

This section of the dialogue (not available in User mode) determines how the subdevice will respond to 
messages received from controllers in groups that it is not a member of. Its main use is in installations 
where a LIU is able to respond to control messages from more than one group. If these groups are 
selected in the dialogue , the subdevice will follow the operation of these control messages. For 
standard control command ("Go to Scene", "Up", "Down", etc.) this simply means that the indicator 
lamps will remain in step with the operation of the LIU. However, the "Responds to Groups" setting 
will also allow the controller to respond to controller related control messages such as "Enable Panel" 
or "Disable Infra Red". 

 

 
  

In the example above, the subdevice indicator lamp will be synchronized with the operation of similar 
lamps for subdevices in groups 1, 3, and 6. 

Note that it is important not to confuse these settings with the "Exists in Groups" settings in 
the LIU configuration dialogue . Although they look and are named similarly, they perform a 
completely different function. 
 
Fade Time 

The Fade Time is an internal function of a Load Interface Unit. The setting determines the amount of 
time that a LIU will take to move from one light output level to another when the command that it 
receives sets a specific level (i.e. Recall Scene). 
 
Applying a Fade Time setting to a subdevice will cause the subdevice to transmit a new fade time 
setting before it sends a command. This ensures that the destination device will be set correctly when it 
applies the command. The Fade Time list box provides a range of preset times ranging from 0 Seconds 
(instantaneous response) through to 1.5 minutes. An additional setting, "Ignore" will cause the 
MultiSensor not to send a Fade Time command at all. 
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Tooltip Subdevice Description 

This text box allows you to enter a short description of the subdevice that will appear as a tooltip if the 
mouse pointer hovers over the subdevice in the UID (shown here used with a button controller). 

 

 
See Also: 

• Configuring the MultiSensor's Constant Light Control Functions 
• Configuring Load Interface Units 
• Configuring Panel Controllers 
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Setting Up Constant Light Operation - an Example 

 

     
In the following example, we will set up a simple constant light system. If you want to try it out, 
you should be able to re-create each of the steps involved using DIGIDIM Toolbox in Offline 
mode. Refer to "Configuring the Multisensor's Constant Light Control Functions" for a full 
explanation of Constant Light operation. 
  
Note: Multisensor can refer to the 302, 312 and 315 models in the following example. 
  

1. Begin by starting DIGIDIM Toolbox, and select Use Offline from the start-up dialogue . The 
application will open with an empty system. 

2. If Groups Layout is not shown in the tree view, select the Groups Layout tab at the top of the 
tree view window. The DIGIDIM Toolbox work area should look like this:  

 

 

3. Add a 7 button controller, a ballast, and a Multisensor to the system. If no group is selected, 
the devices will be added to the Ungrouped section of the tree.  
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4. We are going to use Group 1 as our Input Group and Group 2 as our Output Group. Drag 
the button controller and the Multisensor to Group 1. Then move the ballast to Group 2.  

 

 

5. Click on the + sign next to the Multisensor entry to expand the details of the device. Notice 
that the Multisensor contains the seven standard IR subdevices, plus one for the touch switch 
input and two (on and off) for the PIR sensor. To reveal the Constant Light (OUT) subdevice, 
we need to switch on Constant Light operation using the Multisensor's configuration dialogue 
.  

 

 

6. Right-click on the Multisensor, and select Properties from the drop down menu. The general 
Configuration dialogue will open. 
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7. In the section of the dialogue labelled "Dip Switch Settings", locate the Constant Light 
checkbox and switch it on. Click on OK.  

 

 

8. Note that a new reference to the Multisensor will appear in the Ungrouped section of the 
tree.  

 

 

9. Expanding the device will reveal that this contains the Constant Light (OUT) subdevice. 
Drag the subdevice to the Output Group (Group 2).  

 

 

10. Constant Light Operation is now configured for Groups 1 and 2. 

Note that Constant Light can also be enabled and disabled by setting a DIL switch on the 
Multisensor itself. If this switch is on at the time the device is first powered up, constant light 
operation will be enabled. The Constant Light check box in the Multisensor's configuration 
dialogue will reflect this when the device is discovered in Online mode, but can then be used 
as an override. 

Constant Light Scenes 

The concept behind Constant Light Scenes is similar to the idea of the standard Scenes that can be 
set up for individual Load Interface Units. A Constant Light Scene is a pre-set value for the 
Multisensor's target level, which can be recalled by the user using a single button press. Once 
recalled, the Multisensor will then adjust the lamps in the Output Group to try and match the new 
target level. It is important to realise that, since the Multisensor controls the lamps, all of the LIUs in 
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the group will have the same level. It is not possible to set up individual levels for individual lamps 
within the Output Group. 

The CL Scene Setting Procedure 

The procedure for setting scenes visually is very simple, but must be carried out in Online mode. For 
best results we recommend that it is carried out when levels of daylight are low or with the blinds 
drawn: 

1. Ensure that the "Constant Light" item in the Dip Switch settings (Configuration Dialogue) is 
checked. 

2. Adjust the light levels of the lamps in the Output Group to achieve the light level required. 
3. In the tree view, Right-click on the Constant Light Input Group. 
4. Select "Store as Scene" from the drop down menu. 

 

 
5. Confirm that the scene has been stored by checking the CL Scene subdevice in the Input 

Group multisensor. The entry should simply say "=Set", with no percentage value shown 

 

 See Also: 
• Configuring the Multisensor's PIR, Touch Switch, and IR Functions 
• Configuring Load Interface Units 
• Configuring the Multisensor's Constant Light Control Functions 
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• Configuring Panel Controllers 
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Sliders 

  DIGIDIM Sliders 
 

     
The DIGIDIM Range includes two slider panels: 
  
110 Single Slider  
The 110 has a fade up/down slider (with indicator LED) and an infrared remote control receiver. 
  
111 Double Slider  
The 111 has two fade up/down sliders (with indicator LEDs) and an infrared remote control receiver. 
  
Related Topics: 

• Configuring Panel Controllers 
• 303 Remote Control Handset 
• Infrared Remote Control Receiver  

  
  

  



DIGIDIM Devices 

267 

  

  Single Slider (110) 
 

     
The 110 Single Slider features a fade up/down slider (with indicator LED) and an infrared remote 
control receiver. 

 
Modular control panels are a DALI compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
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  Dual Slider (111) 
 

     
The 111 Dual Slider features two fade up/down sliders (each with indicator LED) and an infrared 
remote control receiver. 

 
Modular control panels are a DALI compatible range of user interfaces that allow adjustment of light 
levels within the lighting system . The range includes push-button, rotary and slider controls in several 
panel finishes. Each button is fitted with an indicator LED and an infrared receiver that gives the 
option of remote operation using the Digidim Remote Control Handset. The hand-held remote control 
also allows additional control of the system's functions. 
  
Related Topics: 

• Infrared_Remote_Control_Receiver 
• 303 Remote Control Handset 
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